TUTORIAL GUIDE: COMPUTER AIDED STRUCTURAL MODELING (CASM)

Version 1.01
Release Date - February 1990

by
David Wickersheimer, Gene McDermott
Ken Taylor, Carl Roth
Wickersheimer Engineers, Inc.
821 South Neil Street
Champaign, Illinois 61820

September 1990
Final Report
Approved For Public Release. Distribution Unlimited

Prepared for: DEPARTMENT OF THE ARMY
US Army Corps of Engineers
Washington, DC 20314-1500

Under Contract No. DACA39-86-C-0024
(RDT&E Program, Work Unit No. AT40-CA-001)

Monitored by Information Technology Laboratory
US Army Engineer Waterways Experiment Station
3909 Halls Ferry Road, Vicksburg, Mississippi 39180-6199
Destroy this report when no longer needed. Do not return it to the originator.

The findings in this report are not to be construed as an official Department of the Army position unless so designated by other authorized documents.

This program is furnished by the Government and is accepted and used by the recipient with the express understanding that the United States Government makes no warranties, expressed or implied, concerning the accuracy, completeness, reliability, usability, or suitability for any particular purpose of the information and data contained in this program or furnished in connection therewith, and the United States shall be under no liability whatsoever to any person by reason of any use made thereof. The program belongs to the Government. Therefore, the recipient further agrees not to assert any proprietary rights therein or to represent this program to anyone as other than a Government program.

The contents of this report are not to be used for advertising, publication, or promotional purposes. Citation of trade names does not constitute an official endorsement or approval of the use of such commercial products.
System Menu
- Restore (Alt+F5)
- Move (Alt+F7)
- Size (Alt+F8)
- Minimize (Alt+F9)
- Maximize (Alt+F10)
- Close (Alt+F4)

File Menu
- New
- Open
- Save
- Save As
- Print Data
- Print Screen
- Import
- Export
- Exit
- About CASM

Criteria Menu
- Project
- Regional
- Site

Draw Model Tool Palette

Shapes Menu
- Cube
- Prism
- Barrel Vault
- Open Barrel Vault
- Cylinder
- Half Cylinder

Edit Menu
- Undo (NI)
- Drag Vertex
- Drag Edge
- Drag Plane
- Delete Object
- Move Object
- Rotate
- Slice Object
- Duplicate
- Tape Measure

Layout Menu
- Show Ground Plane
- Define Ground Plane
- Define Units
- Snap to Units
- Initial Object Size
- Stack on Ground
- Stack on Last Shape
- Stack on Plane
QUICK REFERENCE

Stack Underground
NS  Lock N-S
EW  Lock E-W
VERT  Lock Vertical

Reference Menu (NI)
View Reference (NI)
Move Reference (NI)
Rotate Reference (NI)
Delete Reference (NI)

Draw Structure Tool Palette

Edit Menu
COPY  Copy Structure (NI)
PASTE  Paste Structure (NI)
DELETE  Delete Structure
MODIFY  Modify Structure (NI)
DELETE  Delete Grid Line
MOVE  Move Grid Line
DELETE  Delete Opening
MODIFY  Modify Opening

Grid/Open Menu
DEFINE  Define Grid
ADD  Add Main Grid Line
ADD  Add Sub Grid Line
ADD  Add Opening

Floor/Roof Menu
SURFACE  Surface
ONE-WAY  One-Way
TWO-WAY  Two-Way

Col/Wall Menu
COLUMNS  Column
ALL  All Grid Intersections
ONE  One Grid Intersection
DRAGGED  Dragged (NI)
WALL  Wall
2 GRID POINTS  2 Grid Points
DRAGGED  Dragged (NI)
PILASTER  Pilaster (NI)
FOOTING  Footing (NI)

Bracing Menu (NI)
X-Brace (NI)
K-Brace (NI)
SPREAD K  Spread K (NI)
SINGLE DIAGONAL  Single Diagonal (NI)
OFFSET DIAGONAL  Offset Diagonal (NI)
KNEE BRACE  Knee Brace (NI)

Frame Menu (NI)
ALL CONNECTIONS  All Connections (NI)
ONE CONNECTION  One Connection (NI)
**Quick Reference**

**Loads and Design Tool Palette**

**Loads Menu**
- **Load Combinations**
- **Floor (DL)**
- **Roof (DL)**
- **Ceiling (DL)**
- **Occupancy (LL)**
- **Point (DL)**
- **Point (LL)**
- **Wall (DL)**
- **Moment (DL)**
- **Moment (LL)**
- **Min. Roof (LL)**
- **Snow**
- **Wind**
- **Seismic (NI)**
- **Earth (NI)**
- **Temperature (NI)**
- **Delete Load**
- **Modify Load**

**Col/Wall Menu**
- **Floor (DL)**
- **Ceiling (DL)**
- **Occupancy (LL)**
- **Point (DL)**
- **Point (LL)**
- **Wall (DL)**

**Design Menu**
- **Preliminary**
- **Final (NI)**

**Viewpoint Tool Palette**

**Options Menu**
- **Display Information**
- **Show Loads**
- **Show Structure**
- **Perspective (3D)**
- **Plan**
- **Elevation**
- **Section**
- **Horizontal Plane**
- **Inclined Plane**
- **Vertical Plane**
- **Plane Name**
- **Wireframe Object**
- **Transparent Object**
- **Solid Object**
- **Hide Object**
- **Show Object**

**Mat'l Menu**
- **Concrete**
- **Masonry**
- **Steel**
- **Wood**

**Floor/Roof Menu**
- **Surface 1-way**
QUICK REFERENCE

Full Screen

Store View

Recall View
This tutorial describes the use of the computer program CASM, which is designed to aid the structural engineer in the preliminary design and evaluation of structural building systems by the use of three-dimensional interactive graphics. Funds for the development of this program and publication of this report were provided to the Information Technology Laboratory (ITL), US Army Engineer Waterways Experiment Station (WES), Vicksburg, MS, by the Directorate of Military Programs, Headquarters, US Army Corps of Engineers (HQUSACE), under the Research, Development, Test, and Evaluation (RDT&E) program. The work was accomplished under Work Unit No. AT40-CA-001 entitled "CASE (Computer Aided Structural Engineering) Building Systems." The work was performed by members of Wickersheimer Engineers, Inc., of Champaign, IL, under Contract No. DACA39-86-C-0024.

Specifications for the program were provided by members of the Building Systems Task Group of the CASE Project. The following were members of the task group during program development:

- Mr. Dan Reynolds, US Army Engineer (USAE) District, Sacramento (Chairman)
- Ms. Anjana Chudgar, USAE Division, Ohio River
- Mr. Joseph Hartman, USAE Division, Southwestern
- Mr. George Henson, USAE District, Tulsa
- Mr. Dave Illias, USAE District, Portland
- Mr. Sefton Lucas, USAE District, Memphis
- Mr. David Raisanen, USAE Division, North Pacific
- Mr. Pete Rossbach, USAE District, Baltimore
- Mr. Daniel Sommer, USAE District, Omaha
- Mr. Larry Seals, USAE District, Savannah
- Mr. Dave Smith, USAE District, Omaha
- Mr. Mark Burkholder, USAE District, Tulsa
- Mr. Jerry Maurseth, USAE District, Portland
- Mr. Young Shu, USAE District, Memphis
- Mr. Chris Merrill, WES
- Mr. Paul Senter, WES
- Mr. Michael Pace, WES

The computer program and tutorial were written by Messrs. David Wickersheimer, Gene McDermott, Ken Taylor, and Carl Roth of Wickersheimer Engineers, Inc.

The work was monitored at WES by Mr. Michael E. Pace, Computer Aided Engineering Division (CAED), under the general supervision of Mr. H. Wayne Jones, Chief, Scientific and Engineering Applications Center; Dr. Edward E. Middleton, Chief, CAED; Mr. Paul K. Senter, Assistant Chief, ITL; and Dr. N. Radhakrishnan, Chief, ITL. Mr. Donald Dressier was the original HQUSACE point of contact, and Mr. Charlie Gutberlet is the present technical monitor.

COL Larry B. Fulton, EN, is Commander and Director of WES. Dr. Robert W. Whalin is Technical Director.
# CONTENTS

## PREFACE

| i |

## INTRODUCTION

| v |

## CASM PHILOSOPHY

| 1 - 1 |

## DESIGN CRITERIA

<table>
<thead>
<tr>
<th>2 - 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROJECT DATA DIALOG WINDOW</td>
</tr>
<tr>
<td>REGIONAL DATA DIALOG WINDOW</td>
</tr>
<tr>
<td>SITE-SPECIFIC DATA DIALOG WINDOW</td>
</tr>
<tr>
<td>SAVING PROJECT DATA</td>
</tr>
<tr>
<td>PRINTING PROJECT CRITERIA DATA</td>
</tr>
</tbody>
</table>

## MODELING

| 3 - 1 |

## LOADS

<table>
<thead>
<tr>
<th>4 - 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNOW LOADS</td>
</tr>
<tr>
<td>EXAMPLE ONE: Gable roof</td>
</tr>
<tr>
<td>EXAMPLE TWO: Arched roof crown height of 15'-0&quot;</td>
</tr>
<tr>
<td>EXAMPLE THREE: Arched roof crown height of 5'-0&quot;</td>
</tr>
<tr>
<td>EXAMPLE FOUR: Arched roof crown height of 10'-0&quot;</td>
</tr>
<tr>
<td>EXAMPLE FIVE: Arched roof crown height of 40'-0&quot;</td>
</tr>
<tr>
<td>EXAMPLE SIX: Arched roof crown height of 15'-0&quot;</td>
</tr>
<tr>
<td>DRIFTED AND SLIDING SNOW</td>
</tr>
<tr>
<td>EXAMPLE SEVEN: Lean-to roof adjacent to taller roof</td>
</tr>
<tr>
<td>EXAMPLE EIGHT: Multiple-gable roof</td>
</tr>
<tr>
<td>WIND LOADS</td>
</tr>
<tr>
<td>MAIN WIND-FORCE RESISTING SYSTEMS</td>
</tr>
<tr>
<td>EXAMPLE ONE: One story - Gable roof</td>
</tr>
<tr>
<td>EXAMPLE TWO: Three story - Flat roof</td>
</tr>
<tr>
<td>EXAMPLE THREE: One story - Arched roof</td>
</tr>
<tr>
<td>COMPONENTS AND CLADDING</td>
</tr>
<tr>
<td>EXAMPLE ONE: Building height less than 60 feet</td>
</tr>
<tr>
<td>UNENCLOSED BUILDINGS</td>
</tr>
<tr>
<td>EXAMPLE ONE: One story - Monoslope roof</td>
</tr>
<tr>
<td>EXAMPLE TWO: One story - Open gable roof</td>
</tr>
<tr>
<td>EXAMPLE THREE: One story - Open arched roof</td>
</tr>
</tbody>
</table>
CONTENTS

DEAD LOADS ........................................... 4-93
FLOOR ASSEMBLIES ..................................... 4-93
    EXAMPLE ONE: Open web steel joist framing .......... 4-93
    EXAMPLE TWO: Cast-in-place concrete pan joist ...... 4-96
ROOF ASSEMBLIES ..................................... 4-98
    EXAMPLE ONE: Wood rafter framing ..................... 4-98
    EXAMPLE TWO: Open web steel joist framing .......... 4-99
CEILING ASSEMBLIES ............................... 4-101
    EXAMPLE ONE: Wood roof truss system .................. 4-101
WALL ASSEMBLIES ..................................... 4-103
    EXAMPLE ONE: Exterior wood stud wall brick veneer ..... 4-103
MINIMUM ROOF LIVE LOAD ............................ 4-107
    EXAMPLE ONE: Minimum roof live load ................. 4-107
LIVE LOADS: OCCUPANCY ............................. 4-111
    EXAMPLE ONE: Multiuse facility ......................... 4-113

STRUCTURAL ANALYSIS AND DESIGN ........................ 5-1
EXAMPLE ONE: Alternative structural schemes for a repetitive floor framing system ............ 5-1
    SOLUTION: Scheme 1a ................................ 5-7
    SOLUTION: Scheme 1b ................................ 5-37
    SOLUTION: Scheme 2a ................................ 5-42
    SOLUTION: Scheme 2b ................................ 5-46
    SOLUTION: Scheme 3 ................................ 5-50
EXAMPLE TWO: Irregular Framed Building .......... 5-56
EXAMPLE DRAWINGS .................................... 5-57
This tutorial guide will take you through a series of example design problems step by step to acquaint you with all applications of the program. The basic reference for the example problems is found in the Appendices of *Load Assumptions for Buildings*, TM 5-809-1/ AFM 88-3, Chapter 1 - Technical Manual, 1986 edition. This document in general adopts the A.N.S.I. A58.1-1982, *Minimum Design Loads for Buildings and Other Structures*, which has been nationally adopted in various forms by the model building codes, such as BOCA.

It is assumed that you have completed the INSTALLATION and PROGRAM OVERVIEW chapters in the CASM Guide and have the CASM program window displayed on the monitor. Refer also to the REFERENCE chapter in the CASM User's Guide, which contains detailed steps and illustrations for all the CASM commands. You are encouraged to begin each application of CASM by inputting design criteria that are consistently needed by the program to calculate load data.
CASM is a preliminary structural design program that incorporates a Structural Planning philosophy.

Structural Planning is the study of structural system alternatives within the context of each project's unique set of program criteria. The goal of structural planning, and thus CASM, is to select the most appropriate, efficient, and economical structural system which satisfies established program criteria while integrating the mechanical requirements and complementing the intended aesthetics. The structural planning process must begin during the preliminary design phase, when major decisions regarding form, function, and aesthetics are being firmly established. CASM provides fast, interactive "brainstorming," a catalyst for the creative exchange of ideas by the exploration of options that fulfill a desired result. CASM enables the engineer to rapidly answer the question What if?

The structural engineer needs to develop alternatives, approximate proportions, ramifications on the architectural criteria, and implications on cost. Usually, several structural framing schemes are feasible for any given building program. CASM, through the structural planning process, produces an approximate analysis of each solution, to permit the engineer to compare and test each scheme's appropriateness.

CASM is a constantly expanding system that hopes to encompass the myriad of available structural systems, and expound on their attributes as well as their liabilities. CASM is intended to help the engineer in his structural decision-making process. The following flowchart outlines the many facets of CASM and the relationship of its parts.
DESIGN CRITERIA

This is a good time to acquaint you with the CRITERIA pull-down menu and dialog boxes. The Criteria information which you enter will be used for headings and reference on the variety of output files that you will create with CASM for your justification documentation. Information from your design criteria is also used for initial design load values such as wind and snow loads. For each new project, you should start by entering project criteria. This chapter describes the sequence of using the three menu selections on the Criteria pull-down menu—Project, Regional, and Site. For this example you will enter the project criteria data for a new Auditorium at Fort Huachuca, AZ.

Note: For all Criteria dialog window entries you will move the mouse cursor with the mouse and press the left mouse key to select a data box (you may also use the tab key to select data boxes). Once you have selected a box a flashing vertical cursor will appear. Any information that you type from the keyboard will be inserted at the location of the vertical cursor. You may use the backspace and delete keys to edit your input.

Note: For the single-monitor system, you may need to use the height, distance, or rotate tools to redraw the ground plane.

PROJECT DATA DIALOG WINDOW

You should always start new projects with the Project dialog window. The Project Name and City/Installation data are used as a heading for all your output files. One feature that you may find useful is the City/Installation database which you can create using the Microsoft Windows Cardfile program. A sample City/Installation cardfile is provided with CASM. To minimize repetitious input, you may create a city/installation database for those cities and/or installations in which the majority of your projects will be located. When you select the City/Installation data box, you will have the option of selecting a city or installation from your City/Installation database. All the design data which you have recorded for the selected location will be automatically inserted in your CASM project file. Please refer to page 4-24 in the CASM User's Guide for a description of the Cardfile database.

A. Entering Project Criteria data

1. Select CRITERIA from the CASM menu bar, and from the pull-down menu choose PROJECT. The Project Data dialog window will appear.
2. Insert project name: Auditorium

NOTE: Avoid pressing the ENTER key after typing the project name. Pressing the ENTER key will automatically close the dialog window and you will have to reopen it. Use the mouse pointer or the TAB key to select input data boxes.

3. Select the City/Installation data box.
a. Select Ft. Huachuca from the pop-up dialog window.

b. Select OK to close the pop-up window and return to the Project dialog window.

c. Note that stored information from the database is automatically inserted. Verify entries.

Note: If the desired City/Installation name does not appear on the list, you may select CANCEL to close the pop-up Cities/Installations dialog window. You may then type in your selected city or installation.

4. Select other data boxes to correct or enter data.

Note: These data are currently not used by the program for the design and analysis of structural members. However, you may want to insert this information so that it will be included in your hardcopy output.

a. Select the Building Code data box.
   (1) Select UBC from the pop-up window list and click on OK.

b. Select the Seismic Code data box.
   (1) Select Tri-Services from the pop-up window list and click on OK.

c. Select the No. of Stories data box.
   (1) Delete the current value of 1. Type in the number of stories, 2

d. Select the Floor Area data box.
   (1) Type in the floor area, 60000

e. Select the Occupancy data box.
   (1) Type in the building occupancy type, A2.1

f. Select the Type Const data box.
   (1) Type in the type of construction, II-FR

5. Select OK to save your Project Data entries. The Project Data dialog window will disappear.
Note: Selecting CANCEL returns you to the main CASM screen without saving changes.

REGIONAL DATA DIALOG WINDOW

The Regional Data dialog window contains regional meteorological information. Regional information is used for applied loads and design influences on the structural model. Data may be preselected by the Project Data dialog window or overwritten by direct input. The Basic Wind Speed and Ground Snow Load values are the initial values selected for the Wind and Snow Load generation based on the model geometry.

A. Entering Regional Criteria data

1. Select CRITERIA from the CASM menu bar, and from the pull-down menu choose REGIONAL. The Regional Data dialog window will appear.

<table>
<thead>
<tr>
<th>Wind</th>
<th>Rain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Wind Speed: 70.0 mph</td>
<td>Annual Average: 12.0 in</td>
</tr>
<tr>
<td>Coastal</td>
<td>Max. Storm: 7.93 in</td>
</tr>
<tr>
<td>Max. Wind Speed: 71.0 mph</td>
<td>Temperature</td>
</tr>
<tr>
<td>Direction</td>
<td>Maximum: 98.3 °F</td>
</tr>
<tr>
<td>Snow</td>
<td>Minimum: 38.2 °F</td>
</tr>
<tr>
<td>Ground Snow Load: 5.0 psf</td>
<td>Frost Depth: 0 in</td>
</tr>
<tr>
<td>Maximum Depth: 6.8 in</td>
<td>Snow Density: 10.0 pcf</td>
</tr>
<tr>
<td>Seismic Zone: 2</td>
<td></td>
</tr>
</tbody>
</table>

a. Note that stored information from the database has been automatically inserted. Verify entries.

2. Select other data boxes to correct or enter data.

Note: Data other than Basic Wind Speed, Coastal, Snow Density, and Ground Snow Load are currently not used by the program for the design and analysis of structural members. However, you may want to insert this information so that it will be included in your hardcopy output.

a. Select the Seismic Zone data box.
   (1) Type in the seismic zone, 2.

3. Select OK to save your Regional Data entries. The Regional Data dialog window will disappear.

Note: Selecting CANCEL returns you to the main CASM screen without saving changes.
SITE-SPECIFIC DATA DIALOG WINDOW

Data here relate to specific design parameters based on building type and location. Only the wind and snow data are referenced when you specify a wind or snow load on your model. Currently the soil data are not required for structural design, but will be used later for foundation design.

A. Entering Site-Specific Criteria data

1. Select CRITERIA from the CASM menu bar, and from the pull-down menu choose SITE. The Site-Specific Data dialog window will appear.

2. Select the Wind Importance data box.

   a. Select the High Risk Importance Factor for the assembly of 300 or more people from the pop-up window.

---

Basic Design Criteria: Site Specific Data

<table>
<thead>
<tr>
<th>Wind</th>
<th>Snow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importance: II</td>
<td>: 1.07</td>
</tr>
<tr>
<td>Exposure</td>
<td>: C</td>
</tr>
<tr>
<td>Distance to oceanline</td>
<td>: 100 mi</td>
</tr>
<tr>
<td>Roof Slippery</td>
<td>: -</td>
</tr>
<tr>
<td>Roof Heated</td>
<td>: -</td>
</tr>
</tbody>
</table>

Soil Name: Boring #1

<table>
<thead>
<tr>
<th>Allow. Bearing Pressure: 3500 psf</th>
<th>Gravels with Fines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equiv. Fluid Pressure</td>
<td>30 pcf</td>
</tr>
<tr>
<td>Water Table</td>
<td>6 ft</td>
</tr>
<tr>
<td>Slope</td>
<td>0.5 °</td>
</tr>
</tbody>
</table>

---

Importance Factor

- **I** All Buildings except those listed below.
- **II** High Risk
  - Buildings where primary occupancy is for assembly of 300 or more people in one area; i.e., auditoriums,
  - Buildings having high value equipment.
  - Facilities involving missile operations.
  - Facilities involving sensitive munitions, fuels, chemical and biological contaminants.

- **III** Essential Facilities
  - Buildings housing critical facilities which are necessary for post-disaster recovery and require continuous operation; i.e., hospitals, power stations, fire stations, communications buildings, and other structures housing mission essential operations.
b. Select OK.
c. The Wind Importance Factor changes to 1.07 in the Site-Specific Data
dialog window.
d. The Snow Importance Factor changes to 1.1 in the Site-Specific Data
dialog window.

3. Select other data boxes to correct or enter data.

Note: The soil data are currently not used by the program for the
design and analysis of structural members. However, you may want to
insert this information so that it will be included in your hardcopy
output.

Note: You may find it easier to: (1) place the mouse pointer in the data
box before the current value; (2) press and hold the left mouse key;
(3) drag the cursor over the current value to highlight it; and (4) type
in the new value.

a. Select the Soil Name data box.
   (1) Type in the soil sample name, Boring # 1
b. Select the Allow. Bearing Pressure data box.
   (1) Type in the allowable bearing pressure, 3500
c. Select the Equiv. Fluid Pressure data box.
   (1) Type in the equivalent fluid pressure, 30
d. Select the Water Table data box.
   (1) Type in the water table level, 6
e. Select the Slope data box.
   (1) Type in the existing site slope, 0.5
f. Select the one of the three blank data boxes.
   (1) Type in the type of soils present at the site, Gravels with fines
g. Select SAVE to save the soil name data. You may save data from several
different soil samples. To view the data for each of the samples, use the
NEXT command.

You must use the SAVE option in the Soil Name data section in order
to save the soil data in the project file.

4. Select OK to save your Site-Specific Data entries. The Site-Specific Data
dialog window will disappear.

Note: Selecting CANCEL returns you to the main CASM screen
without saving changes.

Note: If the ground plane does not completely reappear, move the
mouse pointer to one of the Distance arrows in the Viewpoint Toolbox
window and press the left mouse key. The modeling screen will be
redrawn.
SAVING PROJECT DATA

Up to now you have been saving your criteria entries in CASM; however, you will need to save all your project data in a project file on the hard disk or on a floppy disk. You should get into the habit of saving your work in the project file on the hard disk frequently as you input data. For example, you have spent several hours working on a project in CASM without saving data. Suddenly there is a momentary loss of electric power. All of your work will be lost and you will have to repeat all of your inputs. If you save your work frequently, a momentary power loss will not be catastrophic.

A. To save project data:

1. Select FILE from the CASM menu bar, and from the pull-down menu choose SAVE. If the project file is 'untitled,' the Save As File Name dialog window will appear, otherwise the saved project file will be updated.
   a. Type in a file name, fthuach1

   ![Save As File Name dialog](image)

   Note: The name is limited to eight characters or less. A .bid extension is automatically added to the name you choose. Later, when start CASM and you look for your project file, it will be listed as FTHUACH1.BLD.
   b. Select SAVE.
   c. An hourglass symbol will appear as your project file is saved.

   ![Hourglass symbol](image)

   Note: CASM automatically checks for other project files with the same name before it saves your project file. If there is another project file with the same name, you will be reminded so that you will not overwrite that project file.

PRINTING PROJECT CRITERIA DATA

At any time you may print out a copy of your design criteria data. You may also print the design criteria to a file where you can edit the criteria before printing it or transfer the file to another computer for printing. For training purposes we will assume that you do not have a printer connected to your computer, so we will describe how to save the criteria data to a file.

A. To print project data to a file:

1. Select FILE from the CASM menu bar, and from the pull-down menu choose PRINT DATA. The Print Data dialog window will appear.
   a. Initially the Basic Design Criteria selection box is selected (an X is in the selection box).
b. Deselect the **Loads** selection by placing the mouse pointer on the selection box and pressing the **left** mouse key. The X will disappear.

c. The **Print to file** selection box is already selected, and a default file name is in the File name box, CASM.TXT.

> **Note:** Because the output file can be easily created by CASM, we recommend that you use the default file name and overwrite existing output files rather than generate new output files every time you desire to print to a file.

d. Select **OK**.

e. Select **YES** to overwrite the existing CASM.TXT file.

2. You will automatically be placed in the **NOTEPAD** Application program window where you may edit the CRITERIA data before you print it. The NOTEPAD Application program window is shown on the following page.

a. Activate the side bar scroll bar to move up/down the entire page or use the [Page Down]/[Page Up] keys on the keyboard.

b. To edit text, place the mouse pointer at the location where you want to modify the text and press the left mouse key. A flashing vertical cursor will appear at that point, and you may type in your changes. Use the [Backspace] and [Delete] keys to eliminate characters.

c. To print text, select **FILE** from the **NOTEPAD** menu bar, and from the pull-down menu choose **PRINT**. The file will be printed.
An example of the output format is as follows:

**Basic Design Criteria**

**Project Data**
- **Project name**: Auditorium
- **City/Installation**: Ft. Huachuca
- **Country**: USA
- **State**: AZ
- **County**: Cochise
- **Design Load**: Tri-Services
- **Building Code**: UBC
- **Seismic Code**: Tri-Services
- **Elevation above sea level**: 2584 ft.
- **No. of Stories**: 2
- **Floor Area**: 60000 sqft.
- **Occupancy**: A2.1
- **Type of Construction**: I-I-PR

**Regional Data**

**Wind**
- **Basic Wind Speed**: 70.0 mph
- **Coastal**: No
- **Maximum Wind Speed**: 71.0 mph
- **Wind Direction**: SE

**Snow**
- **Ground Snow Load**: 5.0 psf
- **Maximum Snow Depth**: 6.8 in.
- **Snow Density**: 10.0 tcf

**Rain**
- **Average Annual Rainfall**: 12.0 in.
- **Maximum Rainfall**: 7.3 in.

**Temperature**
- **Maximum Temperature**: 98.3 F
- **Minimum Temperature**: 38.2 F
- **Frost Depth**: 0 in.
- **Seismic Zone**: 2
Site Specific Data

Wind
- Exposure : C
- Importance : II : 1.07

Snow
- Exposure : C
- Importance : II : 1.10
- Roof Smooth : No
- Roof Heated : Yes

Soil Name : Boring #1
- Allowable Bearing Pressure: 3500.0 psf
- Equivalent Fluid Pressure : 30.0 pcf
- Water Table : 6.0 ft.
- Slope : 0.5
- Gravels with fines

Notes
- Importance Factor:
  - II High Risk
  - Buildings where primary occupancy
    is for assembly of 300 or more people
    in one area; i.e., auditoriums,
    recreational facilities, dining
    hall, commissaries, etc.
  - Buildings having high value equipment.
  - Facilities involving missile operations.
  - Facilities involving sensitive munitions,
    fuels, chemical and biological contaminants.

Wind Exposure Category:
- Exposure C:
  - Open terrain with scattered obstacles
    having heights generally less than 30 ft.

Snow Exposure Category:
- Exposure C:
  - Snow removal by wind cannot be relied on
    to reduce roof loads because of terrain,
    higher structures, or several trees nearby.

End of example output format.

3. Return to the CASM program window by moving the mouse pointer to the
   SYSTEM box in the top left corner of the screen. Double click the left
   mouse key.
   a. If you have made any changes to the text file, you will be prompted to
      save them. For this example, select CANCEL.

   ![Notepad window](image)

   ![Save current changes: CASH.TXT](image)

   b. This returns you to the CASM program window screen.

You are now ready to begin your structural model and create specific load cases
based upon the three CRITERIA data sets.
This chapter describes some hints, options, and ramifications when drawing the building's geometric model. There are usually many ways to construct a correct building model. The use of commands such as STACK, SLICE, and TAPE MEASURE allows you to accurately draw the shapes. The shape, type, and position will influence the generation of loads.

A. Simplify the geometric model.

The fewer shapes used to model the building the better. The fewer the shapes, the faster the snow and wind calculations are performed as well as the overall performance of the program.

Note: For single-monitor users, a simplified model will increase the redraw speed of the screen.

For buildings with repetitive wings, only one wing needs to be drawn. The extra wings will not influence snow or wind load generation, and for preliminary design, the structure can be assumed the same.

Extra wings are not necessary

Simplified model

Insignificant portions of the building should not be modeled. If the portions do not significantly influence snow and wind load generation, they do not need to be drawn. Some examples of insignificant portions are chimneys, dormers, and small projections.

B. Make sure planes are in contact.

Adjoining planes of the shapes need to be in contact, or the gap between the shapes will make the surfaces exterior. Use the STACK options to accurately place adjoining shapes. Do not eye the locations of shapes.

C. Do not intersect shapes.

Intersecting shapes will confuse the snow and wind load generation algorithms. The interior portion of the intersected planes will become exterior
surfaces, and loads will be applied twice over the overlapped surfaces. When modeling parapet walls, make sure the corners do not intersect.

To correctly model the above building, follow one of these two procedures:

1. Use the SLICE command to create the three cubes.
   a. Draw the two cubes as incorrectly intersecting.
   b. Slice one of the cubes with an intersecting plane.
   c. Slice the sliced cube with the other intersecting plane.
   d. Delete the cube that is inside the full cube.

- OR -

2. Use the STACK ON PLANE and DRAG PLANE commands.
   a. Draw one cube.
   b. Turn on STACK ON PLANE.
   c. Stack a cube on the wall of the first cube.
   d. Drag the planes to the correct proportions.
   e. Stack another cube on the other wall of the first cube.
   f. Drag the planes to the correct proportions.

D. Use of the plane and column shapes vs. the cube shape.

Plane and column shapes are drawn as six-sided cube shapes, but are attributed as planes or columns. The proportions of the plane and column shapes can be edited just like the cube shape using DRAG PLANE. For the generation of snow loads, the use of these shapes does not matter since snow is applied to all roof surfaces. But, for the generation of wind loads, they do matter.

In the generation of wind main force-resisting loads, the cube shapes are included and the plane and column shapes are excluded. The plane and column shapes do not influence the B and L dimensions calculated. Use a
plane shape to model a parapet or overhang. If a cube is used, the computer will think that it is a main force resisting element.

Plane shapes are used to model open structures. Only the plane or open barrel vault shapes can be selected on which to apply open wind loads.

Column shapes are necessary only to visually show support. You can simplify the model by not drawing columns or by drawing only a few of the columns to show support.

E. Line up the edges of the shapes.

The more the edges of the shapes line up, the faster the generation of snow and wind loads. This becomes a factor mainly when modeling parapet walls so as not to intersect.

To correctly model the parapets shown above, use one of the two procedures.

1. Drag the planes on the ends of the parapets.
   a. Set the SNAP INCREMENT to the width of the parapets.
   b. Drag the end planes of the parapets making sure to drag both ends of the same plane.

   - OR -

2. Use the SLICE command.
   a. Slice the ends of the planes with the inner side of the parapet wall making sure to slice the same plane at both ends.
   b. Delete the unwanted parts of the parapets.

F. Creating floor planes.

When two shapes are placed on top of one another, the adjoining surface becomes a floor plane. Floor planes are necessary to be able to draw structure onto and for the calculation of windward wind load levels. This is not making the model more complicated because the extra shapes create floor planes which are necessary for structure and wind load generation.
MODELING

Here are two ways to model floors of equal height.

1. Use STACK ON LAST SHAPE to draw the cubes.
   a. Set the INITIAL OBJECT SIZE to the proper width, length, and height of the building.
   b. Turn on STACK ON LAST SHAPE.
   c. Insert the correct number CUBES to represent the floors.

   **Note:** If there are no shapes to stack on, the shape will be stacked on to the ground plane.

   OR

2. Use the DUPLICATE command.
   a. Insert a CUBE to the correct proportions.
   b. DUPLICATE the cube vertically to create the additional floors.

G. Modeling one- and two-story spaces.

There are two ways to model a two-story space. One is to draw the two-story space as one shape. The second is to draw two shapes stacked on top of each other and then draw an opening on all or part of the adjoining floor plane.

Since the height of a structural column is calculated to the next lower floor plane, the column heights will be calculated correctly by the first method. If the second method is used, the column height will have to be manually adjusted when drawing the column. Currently, when finding the height of the column, the open areas are not checked.

**Here is a method to model the open gable roof space.**

   a. Draw the open gable roof space as a PRISM stacked on a CUBE.
   b. Drag the top plane of the cube above the ridge of the prism.
   c. SLICE the cube with both top planes of the prism.
   d. DELETE the unwanted parts of the cube and the prism.
H. Creating structural bays.

Use the structural grid to create structural bays, not duplicated cube shapes. This will simplify the model with no unnecessary shapes. The use of the structural grid will make it easier to adjust the bay size.

I. Modeling overhangs.

When modeling overhangs, use a plane shape, not the cube shape. This will not make the overhangs a main wind force-resisting element and will exclude their proportions in the B and L dimension calculations. For a wind component in the overhang, the wind components and cladding generation will add the additional uplift load from the bottom of the overhang to the component.

When drawing the overhang, make sure the top plane is exactly the same slope as the rest of the roof. Otherwise, the overhang will not be included with the plane of the roof. Using the SLICE command will ensure that the top plane of the overhang is the same as the roof.

Here are two ways to model the above overhang.

1. Use the SLICE command.
   a. Draw the main portion as a CUBE and a PRISM.
b. Set the INITIAL OBJECT SIZE Height to the width of the overhang and the Wall Thickness to the overall thickness of the overhang.

c. Turn on STACK ON PLANE.

d. Insert a VERTICAL PLANE on upper edge of the wall of the cube.

**Note:** A vertical plane is drawn perpendicular to the stacked surface. **Note:** If the plane remains vertical when stacked, switch the orientation to the other direction.

e. SLICE the plane shape with the roof surface.

f. DELETE the unwanted part of the plane shape.

- OR -

2. Use the DRAG EDGE command. For this method to work, the edge of plane shape has to be able to be dragged in 1-inch increments to achieve the correct slope.

a. Follow steps a through d as in method 1.

b. Turn off SNAP TO UNITS so the edge is dragged in 1-inch increments.

c. Use TAPE MEASURE on the top plane of the overhang to measure the slope.

d. Lock the N-S and E-W directions so the edge is only dragged vertically.

e. Drag the edge vertically to the same slope as the roof.

f. Unlock the N-S and E-W directions.

g. Turn on SNAP TO UNITS.

J. **Relationship of the shape to the angle of the ground plane.**

When drawing, the N-S and E-W dimensions correspond to the directions of ground plane. If the ground plane is rotated, all future draw commands will follow the new angle. There are two angles for the ground plane to allow for easy switching between angles. The commands which follow the angle of the ground plane are: all draw shape commands, define grid, draw openings, and draw structure.
Follow these steps for one way to draw a 45-degree angle dogleg.

a. Draw one CUBE the width of the leg and the length of the leg to the inner intersection point. Place the intersection point of the cube at the center of the ground plane.

   Hint: Translate the cube half the width and length to place the corner at the center of the ground plane.

b. Use DEFINE GROUND PLANE to change the angle of the ground plane to 45 degrees.

c. Use a similar process to draw the other leg.

d. Drag one of the cube's end planes to overlap the other cube completely.

e. SLICE the dragged plane cube with the exterior wall plane and the interior wall plane of the other cube.

f. DELETE the unwanted parts of the cube.

g. To draw the structural grid, use the DEFINE GRID OPTIONS to select the area where to grid will follow the ground plane, the bubble location, and the beginning letter and number. Rotate the ground plane before defining the other half of the structural grid.
K. Use of HIDE OBJECT and SHOW OBJECT.

Sometimes it is difficult to select the proper handle to perform an operation because the shape's handles overlap or are too close together. Using the HIDE OBJECT command to temporarily not display a shape can help select the proper handle because the handles of hidden shapes are not drawn. Hidden objects are still used in snow and wind calculations.

Another reason to use the HIDE OBJECT command is to view only the structure since the structure on the planes of a hidden shape is still drawn. To not display structure, turn off Structure in the SHOW LOADS dialog window.

Use the SHOW OBJECT command to redisplay all the hidden shapes.

L. Verifying the model.

Make sure the geometric model is complete and accurate before drawing structure and calculating loads. If you change the geometry after calculating wind and snow loads, the loads will have to be regenerated. The structure may
not line up correctly, and the structural grid will have to be redefined if the model is changed after drawing structure.

To verify the model, use the TAPE MEASURE command or zoom in on the plan, elevation, and 3-D views to check all the above precautions.
SNOW LOADS

This section includes examples of snow load design for (1) a gable roof, (2) an arched roof with several parameter variations, (3) a lean-to roof adjacent to a taller roof with drifted and sliding snow considerations, and (4) a multiple-gabled roof.

EXAMPLE ONE: Gable roof

Given: This gable roof example is taken from page E-1 of TM 5-809-1. It is a dormitory building sited among several nearby pine trees. It is a heated structure with composition shingles located at Westover AFB, MA. Dimensional data are given, and there are no adjacent structures.

Required: Determine the balanced and unbalanced roof snow loads.

Solution:

A. Establish Criteria

Select NEW from the FILE pull-down menu to start a new project file.

1. Select CRITERIA from the menu bar, and from the pull-down menu choose PROJECT. The PROJECT Criteria pop-up dialog window will appear.

<table>
<thead>
<tr>
<th>Basic Design Criteria: Project Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name: Dormitory</td>
</tr>
<tr>
<td>City/Installation: Westover AFB</td>
</tr>
<tr>
<td>Country: USA</td>
</tr>
<tr>
<td>State: MA</td>
</tr>
<tr>
<td>County:</td>
</tr>
<tr>
<td>Design Load: Tri-Services</td>
</tr>
<tr>
<td>Building Code:</td>
</tr>
<tr>
<td>Seismic Code:</td>
</tr>
<tr>
<td>Elevation: 40 Ft above sea level</td>
</tr>
<tr>
<td>No. of Stories: 1</td>
</tr>
<tr>
<td>Floor Area: 0 sf</td>
</tr>
<tr>
<td>Occupancy:</td>
</tr>
<tr>
<td>Type Const:</td>
</tr>
</tbody>
</table>

OK Cancel
2. Insert project name: Dormitory.
3. Move mouse arrow to CITY/INSTALLATION. Select Westover AFB from the pop-up dialog window. Note that stored information from the database is automatically inserted.
4. No user-inputted data are required here, so select OK and return to the basic WINDOW screen.
5. Select CRITERIA from the menu bar, and from the pull-down menu choose REGIONAL. Note that the GROUND SNOW LOAD has already been inserted, since the city/installation came from the database. No other data are required to solve this problem, so select OK and return to the basic WINDOW screen.

<table>
<thead>
<tr>
<th>Basic Design Criteria: Regional Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind</td>
</tr>
<tr>
<td>Basic Wind Speed: 60.0 mph</td>
</tr>
<tr>
<td>Coastal</td>
</tr>
<tr>
<td>Max. Storm</td>
</tr>
<tr>
<td>Max. Wind Speed: 0.0 mph</td>
</tr>
<tr>
<td>Temperature</td>
</tr>
<tr>
<td>Direction</td>
</tr>
<tr>
<td>Max. Temperature: 0.0 °F</td>
</tr>
<tr>
<td>Snow</td>
</tr>
<tr>
<td>Min. Snow</td>
</tr>
<tr>
<td>Ground Snow Load: 30.0 psf</td>
</tr>
<tr>
<td>Max. Depth</td>
</tr>
<tr>
<td>Snow Density: 15.0 psf</td>
</tr>
<tr>
<td>Minimum Snow Load: 0.0 psf</td>
</tr>
<tr>
<td>Frost Depth: 64 in</td>
</tr>
<tr>
<td>Maximum Depth: 0.0 in</td>
</tr>
<tr>
<td>Snow Density: 15.0 psf</td>
</tr>
<tr>
<td>Seismic Zone</td>
</tr>
</tbody>
</table>

6. Select CRITERIA from the menu bar, and from the pull-down menu choose SITE.

<table>
<thead>
<tr>
<th>Basic Design Criteria: Site Specific Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind</td>
</tr>
<tr>
<td>Importance: 1</td>
</tr>
<tr>
<td>Exposure</td>
</tr>
<tr>
<td>Distance to oceanline: 100 mi</td>
</tr>
<tr>
<td>Soil Name: Dorming 1</td>
</tr>
<tr>
<td>Allow. Bearing Pressure: 0.0 psf</td>
</tr>
<tr>
<td>Equivalent Fluid Pressure: 0.0 pcf</td>
</tr>
<tr>
<td>Water Table: 0.0 ft</td>
</tr>
<tr>
<td>Slope: 0.0 °</td>
</tr>
</tbody>
</table>

7. Move the mouse arrow to the box for SNOW IMPORTANCE factor. Click the left mouse key to activate the pop-up dialog window and make an appropriate selection of a factor. When the desired circle for factor I is high-
lighted, move the mouse pointer to OK and click the left mouse key. The
chosen factor will appear in the data box.

8. Repeat the previous step for EXPOSURE and select an exposure category
from the pop-up dialog window. Highlight category C and click on OK. A
'1.0' and a 'C' are automatically placed in the proper data box.

9. A composition roof is not considered a slippery surface, so leave the box
blank.

10. Move mouse pointer to the box for ROOF HEATED and click on the left
mouse key. An 'X' will appear to indicate that "yes" the building is heated.
Another click removes the 'X' if you wish to review an unheated building.

11. This completes the required input of data on the SITE SPECIFIC
dialog window. Select OK and return to the CASM program window. You have
now completed entry into CRITERIA.

B. Draw volumetric model

1. Select DRAW MODEL from the menu bar to activate the tool palette pop-
up window.

2. Establish general layout requirements.
   a. Select the DEFINE UNITS command from the Layout pull-down.
      (1) Set the SNAP_INCREMENT to 12 inches.
      (2) Click on OK.

   b. Turn on SNAP_TO_UNITS from the Layout pull-down.

   Note: Snap To Units is on when there is a checkmark next to the
command or the icon is highlighted.
c. Turn on SHOW GROUND PLANE from the Layout pull-down.
d. Select DEFINE GROUND PLANE command from the Layout pull-down.

**Note:** Make sure the ground plane dimensions are larger than the overall building dimensions.

1. Set the NS and EW WIDTH to 100 ft.
2. Set the NS and EW SPACING to 20 ft.

**Hint:** Use a larger spacing when using the single screen windows graphics library to decrease the number of lines drawn.

3. Set the NORTH ANGLE 1 to 0 degrees. (See reference manual)
4. Click on OK.

e. Select INITIAL OBJECT SIZE command from the Layout pull-down.

1. Set the NS WIDTH to 20 ft.
2. Set the EW WIDTH to 75 ft.
3. Set the HEIGHT to 18 ft.
4. Set the ORIENTATION to E-W since the ridge runs parallel to the east/west dimension.
5. Click on OK.
f. Turn on STACK ON GROUND PLANE from the Layout pull-down since we will want the first object to sit on the ground.

Note: The current stack mode's command has a checkmark next to it and the icon is highlighted.

g. Make sure no directions are locked. This allows shapes, edges, and vertices to be moved in all three orthogonal directions.

Note: A direction is locked if there is a checkmark next to the command or the icon is highlighted.

3. Create the first floor building volume.

a. Select the CUBE icon from the Draw Model tool palette or from the Shapes pull-down. The shape will appear on ground plane to the proportions selected under Initial Object Size. The Dimensions pop-up dialog window will appear with all the dimensions of the shape indicated. It is not possible to change these values from the keyboard, but only by the drag plane, edge, or vertex operations with the mouse.

(1) Drag the shape to a location on the ground plane by moving the mouse.
Note: Moving the mouse right/left moves the object east/west, while moving the mouse away/toward moves the object north/south.

(2) Click the left mouse key to fix the location of the cube. A duplicate shape appears and is movable.

(3) Double click the right mouse key to exit the command and stop adding shapes to the ground plane.

Note: Double clicking the right mouse key in any graphic command will exit the command.

4. Create the gable roof form.
   a. Turn on STACK ON LAST SHAPE from the Layout pull-down. The next selected shape will sit on top of the last shape.
   b. Select the PRISM icon from the Draw Model tool palette or from the Shapes pull-down. The prism will appear on the last shape drawn, and a pop-up dimensions dialog window will also appear. Click left mouse key to insert the prism.

Note: You do not need to double click the right mouse key to exit the command since you cannot stack another shape on top of a prism.

(c) Select the DEFINE UNITS command from the Layout pull-down.
      (1) Set the SNAP INCREMENT to 4 inches to make it easier to set the desired roof slope.
      (2) Click on OK.

d. LOCK the NS and EW directions from the Layout pull-down. We only want the vertical movement of the ridge allowed.

e. Select the DRAG EDGE command from the Edit pull-down. Solid circular handles appear on each edge of the constructed model.

Note: Only visible plane's edges can be dragged, and edges can only be dragged in directions where all planes connecting to the edge remain planar.

(1) Select the ridge edge handle by clicking the left mouse key when the pointer is over the handle.

(2) Hold the right mouse key down while dragging the mouse up and down until the roof slope appears as 8.00 in 12 in the dimensions dialog box. The vertical height of the prism becomes 6.67 feet, or 6'-8" more correctly.

Note: Holding the right mouse key down while dragging is the vertical direction for all drag commands.

(3) Click the left mouse key to fix the position of the dragged edge.

(4) Double click the right mouse key to exit the command. Otherwise, you could now drag another edge.

f. Unlock the NS and EW directions.

5. This completes the model for this example.
C. Develop snow loads on the roof.

1. Select LOADS AND DESIGN from the menu bar to activate the tool palette pop-up window.

2. Select SNOW LOADS from the Loads pull-down menu or from the snow icon within the Loads Tool Palette. A snow loads pop-up dialog window will appear.
3. The Snow Loads dialog window contains the decisions from completion of the Criteria windows that were previously entered for determination of snow design loads.

   a. Change any of the parameters upon which snow calculations will be based. Any value within the window can be revised or added at this time.

   Note: Pop-up windows will appear to help make decisions regarding Importance & Exposure factors, if these boxes are selected for modification.

   b. If satisfied, click on OK and the roof snow load calculations will automatically begin.

   c. A warning box may appear to prompt you if you will replace an existing output file.

   Note: A pop-up dialog window will keep you informed of the program’s progress to assure you that it is still calculating and has not stopped processing.

4. The building plan and a section elevation will appear upon completion of snow loads calculations. The various snow loads calculated will appear on the screen above the roof with magnitudes and descriptors.

   a. Drag the mouse to move the horizontal line in plan to where you want the section cut made.

   b. Click on the left mouse key to redraw the section.

   c. Double-click the right mouse key to fix the section cut location desired and generate the revised snow loads at that section.

   ![Snow Loads Diagram]

   D. Manipulation of building model and its snow loads.

   1. Enlarge the numeric and textual data on the screen.

      a. Move the mouse pointer to the viewpoint tool to the left side of the current distance value.

      b. Click on the left mouse key to increment the viewing distance toward you.
c. Press and hold the left mouse key while dragging the mouse left and right
to zoom in and out.
d. Release the mouse key when the desired zoom is achieved.

2. Pan the screen image.
   a. Press and hold the left mouse key while pointing to the cross in the center
      of the view direction.
   b. Hold the left mouse key down while dragging the mouse to pan the view.
   c. Release the left mouse key when the desired view is achieved.

3. View the model and its balanced snow load in wireframe 3-D.
   a. Select the Options pulldown from the Viewpoint window and select
      PERSPECTIVE (3D). Transparency and solids are also possible for the
      double screen users, but not for the single screen users. If a double
      screen is used, select SOLID OBJECT or TRANSPARENT OBJECT from
      the Options pull-down in the Viewpoint window.
   
   Note: Selection of Solid Object for a single screen user will result in a
dotted ground plane, while selection of Transparent Object will result
in a dotted ground plane and dotted objects.

4. Rotate the 3-D model view and its snow load.
   a. Hold the left mouse key down while moving the mouse pointer, and drag
      the black arrow around the circle in the Viewpoint window.
   b. Release the left mouse key when the desired viewing angle is achieved.
   c. You can also change the viewing height and distance similar to step 5.

5. View the unbalanced snow load in 3-D.
   a. Select SHOW LOADS from the Options pull-down menu and a dialog
      window of choices will appear.
   b. Click the left mouse key on the UNBALANCED SNOW LOAD.
c. Select OK. The 3-D snow pattern will be redrawn to reflect your choice.

Note: The wind direction for this unbalanced case is also shown with the model and will be in the direction of the last section cut.

E. Generation of hard copies.

1. Return to the 2-D section cut.
   a. Select SECTION from the Options menu in the Viewpoint window.

   Note: The 2-D section that appears is dependent on the viewing direction of the 3-D model. To obtain a section cut perpendicular to the ridge, rotate the 3-D view so that you are looking at a view that is approximately the desired section cut. It is not necessary to adjust the height or distance.

2. Print the screen image.
   a. Select PRINT SCREEN from the File pull-down menu on the CASM menu bar. A pop-up dialog window will appear.

   - In-a-Vision file
   - AutoCAD DXF file
   File: CASM.PIC
   OK Cancel

b. Select IN-A-VISION FILE with the mouse and modify the FILENAME to SNOW.PIC by typing over the present filename.

   Note: The extension .pic is automatically added to the filename.

c. Click the left mouse key on OK. The In-a-Vision program is executed and loads the screen image file which now appears on the screen.
d. Select **EDIT** and **DRAW** commands from the 'In-a-Vision bar menu to modify and compose the screen image as desired.

e. Select **PRINT** from the In-a-Vision File pull-down menu along the menu bar at the top of the screen. A pop-up dialog window will appear.

f. Select **VIEW** with the mouse pointer. You may need to **SELECT DEVICE** and **SET OPTIONS** at this time.

g. Select **OK** when finished. A hand will appear over the screen image that is movable with the mouse.

h. Window the desired image to be printed. Hold down the left mouse key at one corner and drag the dynamic rectangle to the desired size.

i. Release the left mouse key and the image is printed.

j. Exit In-a-Vision by selecting **CLOSE** from the System menu pull-down located at the extreme upper left corner of the screen. A pop-up dialog window may appear to ask if it should save the changes to **SNOW.PIC**. Select either **YES** or **NO** as desired. You will now be brought back to the CASM window.

>>> **Note:** If you are running the single-screen CASM version, the screen display will be blank. Click the left mouse key on the Distance in the Viewpoint window to redraw the screen.

3. Review the snow load calculations on the screen.
   a. Select **MINIMIZE** from the System menu pull-down, located in the extreme upper left part of the CASM window, to turn the CASM program into an icon.
   b. Click the left mouse key on the MS-DOS Executive icon (which looks like a diskette).
   c. Select **RESTORE** from the pull-down menu options.
   d. Find **SNOW.TXT** by scrolling through the files as required.

>>> **The current version of Windows does not automatically update the list of files. You must reselect the current directory in order to revise the list of files and display your output file. To reselect the current directory, place the mouse pointer on the directory name and double click the left mouse key. The directory listing will be revised.**

e. After placing the mouse pointer on the output file name, double click the left mouse key to execute **NOTEPAD** and have it load the snow output. The Notepad window will appear.

f. Use the scroll bars to view the various calculation pages.
4. Print the snow load calculations.

a. Select PRINT from the File pull-down menu to generate a hard copy.

b. Select EXIT from the File pull-down menu to close Notepad.

c. Select MINIMIZE from the MS-DOS Executive SYSTEM pull-down menu in order to change the MS-DOS program window into an icon. This will maximize the computer memory available to run CASM.

d. Click the left mouse key on the CASM icon (looks like a building) and if running the dual-screen CASM version select MAXIMIZE to return to the CASM window. Select RESTORE if running the single-screen CASM version and redraw the screen.

Project: Example 1, pg. 4-6
Location: Westover AFB
Design Load: Tri-Services
Time: Wed Oct 25, 1989 1:19 PM

********** Gable/Hip Roof Snow Load Design **********

Flat Roof Snow Load (PF)
PF = 0.7*Ce*Ct*I*Pg
Snow Exposure Category: C
Ce = 1.0
Heated structure
Ct = 1.0
Importance Category: I
I = 1.0
Pg = 30.0 psf
PF = 21.0 psf
Roof slope: 8.00 in 12
theta = 34 deg
Since theta > 15 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.

Pf = 21.00 psf

Sloped Roof Snow Load (Psf)

---

4-12
Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 0.90
Ps = 18.90 psf

Unbalanced Snow Load (Punbal)
since 15 deg theta 70 deg, unbalanced condition applies.
Punbal = 1.5*Ps/Ce
Punbal = 28.30 psf

F. Save the building model with its snow loads applied for future reference.
1. Select SAVE from the File pull-down on the CASM menu bar. A pop-up dialog window will appear.

2. Type in the desired Filename.
3. Click the left mouse key on SAVE.
4. The saved file can now be accessed as needed from OPEN in the File pull-down.

Note: The extension .bid is automatically added to the filename.
EXAMPLE TWO: Arched roof crown height of 15'-0"

Given: This arched roof example is taken from page E-4 of TM 5-809-1. It is a theater (greater than 300 occupancy) sited in a windy area with a few nearby coniferous trees. It is the tallest structure in a recreational complex. The building is heated and the roof is sheathed with built-up roofing. It is located in Milwaukee, WI (not Chicago as stated in the TM).

Required: Determine the balanced and unbalanced snow loads.

Solution: An abbreviated discussion is given here since the steps basically repeat those of example one.

A. Establish Criteria.
   1. Input the following data into the PROJECT, REGIONAL, and SITE CRITERIA dialog windows:

<table>
<thead>
<tr>
<th>PROJECT</th>
<th>City/Installation</th>
<th>State</th>
<th>Design Load</th>
<th>Ground Snow Load</th>
<th>Importance</th>
<th>Exposure</th>
<th>Roof Heated</th>
<th>Roof Slippery</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project name</td>
<td>Theater</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City/Installation</td>
<td>Milwaukee</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>WI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Load</td>
<td>Tri-Services</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ground Snow Load</td>
<td>35 psf</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Importance</td>
<td>category II</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exposure</td>
<td>category B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roof Heated</td>
<td>yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roof Slippery</td>
<td>no</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
B. Draw volumetric model

Note: There are many ways to construct the model. This example will illustrate a different approach to some of the steps to emphasize the variety of options.

1. Select **DRAW MODEL** from the menu bar.
2. Establish general layout requirements which are different than previously established.
   a. Use the following:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFINE UNITS (snap increment)</td>
<td>12 inches</td>
</tr>
<tr>
<td>SNAP TO UNITS</td>
<td>on</td>
</tr>
<tr>
<td>SHOW GROUND PLANE</td>
<td>on</td>
</tr>
<tr>
<td>DEFINE GROUND PLANE</td>
<td></td>
</tr>
<tr>
<td>WIDTH N-S</td>
<td>100 feet</td>
</tr>
<tr>
<td>E-W</td>
<td>200 feet</td>
</tr>
<tr>
<td>SPACING N-S</td>
<td>20 feet</td>
</tr>
<tr>
<td>E-W</td>
<td>20 feet</td>
</tr>
<tr>
<td>INITIAL OBJECT SIZE</td>
<td></td>
</tr>
<tr>
<td>N-S WIDTH</td>
<td>20 feet</td>
</tr>
<tr>
<td>E-W WIDTH</td>
<td>20 feet</td>
</tr>
<tr>
<td>HEIGHT</td>
<td>20 feet</td>
</tr>
<tr>
<td>ORIENTATION</td>
<td>E-W</td>
</tr>
<tr>
<td>STACK ON GROUND PLANE</td>
<td>on</td>
</tr>
<tr>
<td>DIRECTIONS LOCKED</td>
<td>none</td>
</tr>
</tbody>
</table>

Note: The ground plane grid is now rectangular for this example. You may wish to increase the viewing distance to make the entire ground plane visible.

3. Create the first floor building volume.
   a. Select **CUBE** and fix the initial object location in the northwest corner of the ground plane.
   b. Modify the initial object dimensions to the required building proportions.
      (1) Select **DRAG PLANE** from the Edit pull-down. Solid circular handles will appear at the centroid of each visible plane on the object.
      (2) Select the top plane handle with the left mouse key when the cursor is over the handle. The selected plane will be highlighted and the pop-up Dimensions dialog window will appear with the object's dimensions inserted.
      (3) Drag the mouse up and down to vertically change the top plane's height above the ground plane to 18 feet.
Note: Always move the mouse toward and away regardless of the plane's required direction of movement. There is no need to hold down the right mouse key to drag a plane vertically.

(4) Click the left mouse key to fix the location of the plane. The handles will reappear to allow for additional drag plane operations.
(5) Select the south plane handle with the mouse as in step 2.
(6) Drag the mouse toward and away until the N-S dimension shows 80 feet in the dialog window.
(7) Click the left mouse key to fix the location of the south plane.
(8) Select the east plane handle with the mouse.
(9) Drag the mouse toward and away until the E-W dimension shows 150 feet.
(10) Click the left mouse key to fix the location of the east plane.
(11) Double click the right mouse key to exit the Drag Plane command. This completes the first floor volume.

4. Create the barrel vault roof form.
   a. Turn on STACK ON PLANE from the Layout pull-down menu to select the appropriate plane to receive the barrel vault.
   b. Set the INITIAL OBJECT SIZE to 15 feet in height to reflect the required crown height.

Note: STACK ON LAST SHAPE could also have been used for this example since the barrel vault connects directly to the top plane of the first floor volume.

   Note: Barrel vault crown height cannot be modified from a Drag Edge or Drag Plane command.

   c. Select BARREL VAULT from the Shapes pull-down or the Draw Model tool palette icon. Solid circular handles will appear at the centroid of all visible planes.
   d. Select the top plane with the mouse. The barrel vault will automatically appear and assume the proportions of the plane selected to receive the barrel vault. The Dimensions pop-up dialog window will also appear with current dimensions inserted.

   Note: The ridge of the barrel is used to define its orientation, which was set to E-W under Initial Object Size.

   e. Click the left mouse key to fix the barrel vault shape to the selected plane. Solid circular handles will reappear to stack another barrel vault on another plane if so desired.
   f. Double click the right mouse key to exit the Draw Shape on Plane command.

5. This completes the model for this example.
C. Develop snow loads on the roof
1. Select LOADS AND DESIGN from the CASM menu bar to activate the tool palette pop-up window.
2. Select SNOW LOADS from the Loads pull-down menu or select the snowflake icon. A Snow Loads pop-up dialog window will appear.

<table>
<thead>
<tr>
<th>Snow Loads</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ground Snow   : 05.0 psf</td>
</tr>
<tr>
<td>Importance Factor II : 1.1</td>
</tr>
<tr>
<td>Exposure      : B 9</td>
</tr>
<tr>
<td>Roof Slippery : ☐</td>
</tr>
<tr>
<td>Roof Heated   : ☑</td>
</tr>
<tr>
<td>Output File   : SNOWOUT.TXT</td>
</tr>
</tbody>
</table>

3. Verify parameters, modify as required, and select OK when satisfied. Roof snow load calculations will automatically begin.
4. The building plan and a section will appear upon completion of the snow load calculations.

D. Manipulation of the building model and its snow loads.
1. Proceed as in Example 1 to enlarge and pan the 2-D view, to view in 3-D, and to view the unbalanced snow load in 3-D (see steps D-1 through D-5).

E. Generation of hard copies.
1. Print the 2-D section cut screen image as in steps E-1 and E-2 of Example 1.
2. Review and print the snow load calculations as in E-3 and E-4 of Example 1.

Project: Theater
Location: Milwaukee
Design Load: Tri-Services
Time: Mon Jan 15, 1990 1:20 PM

************** Arched Roof Snow Load Design **************

Flat Roof Snow Load (Pf)
Pf = 0.7*Ce*Ct*I*Pg
Snow Exposure Category: B
Ce = 0.9
Heated structure
Ct = 1.0
Importance Category: II
I = 1.1
Pg = 35.0 psf
Pf = 24.3 psf
Roof width: 80.0 ft
Crown height: 15.0 ft
equivalent slope theta = 21 deg
Since theta > 10 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.
Pf = 24.30 psf

Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 1.00
Ps = 24.30 psf

Unbalanced Snow Load (Punbal)
since equivalent slope, theta, is 21 deg
10 deg < theta < 60 deg.
Unbalanced condition applies
Where slope at eaves = 41 deg
use case II
SNOW LOADS

Crown
\[ \text{Punbal} = 0.5 \times Ps \]

| Punbal = 12.10 psf |

30 deg point (30.4 ft from crown)
\[ \text{Punbal} = 2 \times Ps/Ce \]

| Punbal = 54.00 psf |

Eave
Height of eave above grade or lower roof: 18.0 ft
\[ \text{Punbal} = \frac{(2 \times Ps/Ce) \times [1 - (\phi - 30)/40]}{1} \]

| Punbal = 39.20 psf |

F. Save the building model with its snow loads applied for future reference.

1. Save as filename: TUTOR2.BLD.

2. Refer to steps F-1 through F-4 in Example 1.
EXAMPLE THREE: Arched roof crown height of 5'-0"

Example Two is repeated for a crown height of 5.0 feet to test the snow design requirements when the equivalent slope theta is less than 10 degrees and no unbalanced snow load is required.

A. Establish Criteria
1. Data will be reused from Example 2.

B. Draw Volumetric Model
1. Select OPEN from the File pull-down menu on the CASM menu bar.
   a. Select Filename: TUTOR2.BLD (file created in Example 2) from the scroll box files on the pop-up dialog window.
   b. Click the left mouse key on OPEN to load the building data. The barrel vaulted building will appear on the screen.
   
   Note: If you were working on a different building, a warning pop-up box may appear to save that building's data before it loads the new data.

   2. Select DRAW MODEL from the CASM menu bar.
   3. Delete the barrel vault shape.
      a. Select DELETE OBJECT from the Edit pull-down menu. A warning pop-up box will appear stating that snow loads will need to be recalculated.

      Note: Snow loads will need to be recalculated

      OK Cancel

   Note: Anytime snow or wind loads have been calculated, and then an attempt is made to alter the geometry, this warning box will appear.
      b. Click the left mouse key on OK and solid circular handles will appear at the centroids of the visible planes.

   Note: More than one handle will appear for each constructed shape. Selecting any one of the handles for a given shape will delete the entire shape.

      c. Select one of the barrel vault handles with the mouse and the shape is deleted. Handles will reappear to allow deletion of any remaining shapes.
      d. Double click on the right mouse key to exit the delete object command.

   4. Insert a new barrel vault with a crown height of 5 feet.
      a. Set the INITIAL OBJECT SIZE to 5 feet in height to reflect the new crown height.
      b. Turn on STACK ON LAST SHAPE from the Layout pull-down menu.
c. Select BARREL VAULT from the Shapes pull-down menu. The barrel vault roof will appear on top of the last shape.

d. Click on the left mouse key to add the barrel vault.

Note: You do not need to double click the right mouse key to exit the command, since you cannot stack another shape on top of a barrel vault.

5. This completes the model for this example.

C. Develop snow loads on the roof.
   1. Follow the same procedure as steps C-1 through C-4 of Example 1.

D. Manipulation of building model and its snow load.
   1. Follow the same procedure as steps D-1 through D-5 in Example 1.

E. Generation of hard copies.
   1. Follow the same procedure as steps E-1 through E-4 of Example 1 to print a 2-D section and calculations.
Example 3 Sample Output:

Project : Theater  
Location : Milwaukee  
Design Load: Tri-Services  
Time : Mon Jan 15, 1990 1:23 PM

************* Arched Roof Snow Load Design *************

Flat Roof Snow Load (Pf)
Pf = 0.7*Ce*Ct*I*Pg
Snow Exposure Category: B
Ce = 0.9
Heated structure
Ct = 1.0
Importance Category: II
I = 1.1
Pg = 35.0 psf
Pf = 24.3 psf
Roof width : 80.0 ft
Crown height: 5.0 ft
equivalent slope theta = 7 deg
Check minimum Pf where theta < 10 deg
When Pg = 20.0 psf, min Pf = 20*I
min Pf = 22.0 psf
Since theta < 1/2 in/ft, rain-on-snow surcharge does not apply.

Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 1.00
Ps = 24.30 psf

Unbalanced Snow Load (Punbal)
since equivalent slope, theta, is 7 deg
Theta < 10 deg or > 60 deg, unbalanced condition does not apply.

F. Save the building model with its snow loads applied for future reference.
1. Select SAVE AS from the File pull-down menu on the CASM menu bar.
   This allows us to save the building data in a different file from Example 2.
   Note: Selecting SAVE would have replaced the existing file without allowing you to change the filename.
2. Type in Filename: TUTOR3.BLD.
3. Click mouse on SAVE.
EXAMPLE FOUR: Arched roof crown height of 10'-0"

Example Two is repeated for a crown height of 10 feet to test the snow design requirements for a CASE I situation that does include an unbalanced snow load.

Repeat all the steps of Example 3, but revise the crown height to 10 feet.

A sample output follows:

<table>
<thead>
<tr>
<th>Snow Unbalanced (psf)</th>
<th>12.1 22.6 33.39 46.1 54.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snow Balanced (psf)</td>
<td>24.3 324.3 324.3 24.3 24.3</td>
</tr>
<tr>
<td>Snow Drift (psf)</td>
<td>24.3 24.3 24.3 24.3 24.3 24.3 24.3</td>
</tr>
<tr>
<td>Snow Sliding (psf)</td>
<td>24.3 24.3 24.3 24.3 24.3 24.3 24.3 24.3</td>
</tr>
<tr>
<td>Snow Combined (psf)</td>
<td>24.3 324.3 324.3 24.3 24.3 24.3 24.3 24.3 24.3 24.3 24.3 24.3</td>
</tr>
</tbody>
</table>

\[ \text{Snow Combined (psf)} \]

\[ \text{Snow Combined (psf)} \]
Example 4 Sample Output:

<table>
<thead>
<tr>
<th>Project</th>
<th>Theater</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Milwaukee</td>
</tr>
<tr>
<td>Design Load</td>
<td>Tri-Services</td>
</tr>
<tr>
<td>Time</td>
<td>Mon Jan 15, 1990</td>
</tr>
</tbody>
</table>

*************** Arched Roof Snow Load Design ***************

Flat Roof Snow Load (Pf)
Pf = 0.7*Ce*Ct*I*Pg
Snow Exposure Category: B
Ce = 0.9
Heated structure
Ct = 1.0
Importance Category: II
I = 1.1
Pg = 35.0 psf
Pf = 24.3 psf
Roof width : 80.0 ft
Crown height: 10.0 ft
equivalent slope theta = 14 deg
Since theta > 10 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.
| Pf = 24.30 psf |

Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 1.00
| Ps = 24.30 psf |

Unbalanced Snow Load (Punbal)
since equivalent slope, theta, is 14 deg
10 deg < theta < 60 deg.
Unbalanced condition applies
Where slope at eaves = 28 deg
use case 1

| Punbal = 12.10 psf |

| Punbal = 54.00 psf |
Example Two is repeated for a crown height of 40 feet to test the snow design requirements for a CASE III situation where the 'eave' is now located at the phi = 70° location of 38 feet from the crown.

*Repeat all the steps of Example 3, but revise the crown height to 40 feet.*

A sample output follows:

- Snow Unbalanced (psf): 10.7
- Snow Balanced (psf): 21.4
- Snow Drift (psf): 421.4
- Snow Sliding (psf):
- Snow Combined (psf): 21.4
Example 5 Sample Output:

Project : Theater
Location : Milwaukee
Design Load: Tri-Services
Time : Mon Jan 15, 1990 1:28 PM

*************** Arched Roof Snow Load Design ***************

Flat Roof Snow Load (Pf)
Pf = 0.7*Ce*Ct*I*Pg
Snow Exposure Category: B
Ce = 0.9
Heated structure
Ct = 1.0
Importance Category: II
I = 1.1
Pg = 35.0 psf
Pf = 24.3 psf
Roof width : 80.0 ft
Crown height: 40.0 ft
equivalent slope theta = 35 deg
Since theta > 10 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.

| Pf = 24.30 psf |

Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 0.88
| Ps = 21.38 psf |

Unbalanced Snow Load (Punbal)
since equivalent slope, theta, is 35 deg
10 deg < theta < 60 deg.
Unbalanced condition applies
Where slope at eaves = 90 deg
use case III

Crown
Punbal = 0.5*Ps
| Punbal = 10.70 psf |

30 deg point (20.0 ft from crown)
Punbal = 2*Ps/Ce
| Punbal = 47.50 psf |

Eave
Height of eave above grade or lower roof: 18.0 ft
70 deg point (37.6 ft from crown)
| Punbal = 0.00 psf |
EXAMPLE SIX: Arched roof crown height of 15'-0"

Example Two is repeated for the original crown height of 15 feet, but with a zero height of eave above grade. The arch thus originates from grade. This is to illustrate the alternate distribution of snow accumulation when a lower roof or grade exists within 3 feet of the eave.

This example could begin as a new building; however, it will be approached by opening the saved Example 2. This eliminates reentering the Design Criteria.

A. Establish Criteria.
   1. Already entered in Example 2.

B. Draw Volumetric model.
   1. OPEN Filename: TUTOR2.BLD (file was created in Example 2).
   2. Select DRAW MODEL tool palette.
   3. Delete both existing shapes.
      a. Select DELETE OBJECT from Edit pull-down menu.
      b. Select OK on the warning pop-up box to indicate that snow loads will need to be recalculated.
      c. Select one handle on the barrel vault shape.
      d. Select one handle on the cube shape.
   
   Note: You will not need to double click the right mouse key, since there are no more objects to delete.

   4. Draw the new barrel vault on the ground plane.
      a. Turn on STACK ON GROUND.
      b. Select BARREL VAULT.
      Oops! The object size does not reflect the required proportions for this example. The editing functions cannot be used to completely revise the barrel vault size.
      c. Double click the right mouse key to exit the command and not add the barrel vault.
      d. Set the INITIAL OBJECT SIZE as follows:
         WIDTH N-S : 80 feet
         E-W : 150 feet
         HEIGHT : 15 feet
         ORIENTATION : E-W
      e. Select BARREL VAULT again.
      f. Click the left mouse key to add the shape.
      g. Double click the right mouse key to stop adding barrel vaults to the ground plane.

5. This completes the model for this example.
Repeat all the remaining steps (C through F) of Example 1.

| Snow Unbalanced (psf)           | 12.1 | 26.1 | 39.7 | 94.0 | 0.0 |
| Snow Balanced (psf)             | 24.3  | 24.3  | 24.3  | 24.3  | 24.3 |
| Snow Drift (psf)                |      |      |      |      |     |
| Snow Sliding (psf)              |      |      |      |      |     |
| Snow Combined (psf)             | 24.3  | 24.3  | 24.3  | 24.3  | 24.3 |
Example 6 Sample Output:

<table>
<thead>
<tr>
<th>Project</th>
<th>Theater</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Milwaukee</td>
</tr>
<tr>
<td>Design Load</td>
<td>Tri-Services</td>
</tr>
<tr>
<td>Time</td>
<td>Mon Jan 15, 1990 1:09 PM</td>
</tr>
</tbody>
</table>

*************** Arched Roof Snow Load Design ***************

Flat Roof Snow Load (Pf)
Pf = 0.7*Ce*Ct*I*Pg

Snow Exposure Category: B
Ce = 0.9
Heated structure
Ct = 1.0
Importance Category: II
I = 1.1
Pg = 35.0 psf
Pf = 24.3 psf
Roof width: 80.0 ft
Crown height: 15.0 ft

equivalent slope theta = 21 deg
Since theta >= 10 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.

Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 1.00
Ps = 24.30 psf

Unbalanced Snow Load (Punbal)
since equivalent slope, theta, is 21 deg
10 deg < theta < 60 deg.
Unbalanced condition applies
Where slope at eaves = 41 deg
use case II

Crown
Punbal = 0.5*Ps
Punbal = 12.10 psf

30 deg point (30.4 ft from crown)
Punbal = 2*Ps/Ce
Punbal = 54.00 psf

Eave
Height of eave above grade or lower roof: 0.0 ft
Eave < 3 ft above grade or lower roof
Punbal = 54.00 psf
DRIFTED AND SLIDING SNOW

Drifts may occur on lower roofs sited within 20 feet of a higher adjacent structure and also from projections above a lower roof. These projections may be parapets, penthouses, stair and elevator projections, mechanical equipment, etc. The snow load algorithm searches for the drift criteria stated above directly from the building model.

Sliding snow occurs on roofs situated below gable or shed roofs having a slope (or equivalent slope in the case of barrel vaults) greater than or equal to 2 in 12.

Lower roofs which are located below roofs having a slope (or equivalent slope) greater than or equal to 2 in 12 shall include sliding effects per the criteria detailed by the Metal Building Manufacturer's Association (MBMA) document, Low Rise Building Systems Manual, 1986. It is necessary to run the snow design for the upper roof creating the sliding prior to preparation of the input of data for the lower roof receiving the sliding snow. The following example illustrates the procedure.

EXAMPLE SEVEN: Lean-to roof adjacent to taller roof

Dimensions, siting, and location are the same as Example 2. The addition is unheated, but the theater is heated. This example is predominantly taken from TM 5-809-1, page E-6.

Given: A lean-to roof structure for a storage and office addition adjacent to a taller theater roof.

Required: Find the design snow load on the lean-to roof, including drift and sliding considerations.

Solution:

A. Establish Criteria.
   1. Open Filename: TUTOR2.BLD (file was created in Example 2).

B. Draw volumetric mod.
   1. Select DRAW MODEL.
2. Oops! The ground plane is of insufficient size to add the shed in this example if the building is centered on the ground plane width.
   a. Increase the Ground Plane N-S WIDTH to 140 feet.

3. Add the shed.
   a. Turn on STACK ON PLANE.
   b. Rotate the 3-D Viewpoint of the building so you are looking from the SE quadrant.
   c. Select CUBE and handles will appear.
   d. Select south wall handle and the cube will expand to match the wall dimensions.
   e. Click the left mouse key to fix the shed.
   f. Double click the right mouse key to exit Stack On Plane command.
   g. Proportion the shed.
      (1) Drag the shed roof plane down 6 feet from the barrel vault eave.
      (2) Drag the east plane of the shed to the west and make the length of the shed 40 feet.
      (3) Drag the south plane of the shed to make its width 18 feet.
   h. Create lean-to roof.
      (1) Select TAPE MEASURE from the Edit pull-down menu.

   Note: The height shown in the Dimensions pop-up dialog box will be 12 feet.

   (2) Drag the east plane of the shed to the west and make the length of the shed 40 feet.
   (3) Drag the south plane of the shed to make its width 18 feet.

   Note: Roof slopes shown in the Dimensions dialog window may not be correct for a Cube. This issue can be avoided by checking roof slopes with TAPE MEASURE.

   (2) Position the mouse pointer at the N1 corner vertex of the shed. Click the left mouse key. A red dot will appear at the vertex.
   (3) Position the mouse pointer at the SE upper vertex of the shed. Click the left mouse key. A red dot will appear at the vertex, and a dashed red line will connect the two dots. A pop-up Measure dialog window will appear displaying data regarding the dashed line between those two red dots.

   Note: You cannot edit the data in this dialog window. The values in the data blocks will change as you drag an edge which is connected to the vertices.

   Note: On the single-screen CASM version you may need to move the Measure dialog window to a more convenient location on the screen.

   (4) Lock the N-S direction.
   (5) Select DRAG EDGE and handles will appear.
   (6) Select the upper south edge of the shed. Hold the right mouse key down while moving it up and down. Drag the edge vertically until the N-S slope in the Measure dialog window reads 2.00 in 12.
(7) Click the left mouse key to fix the roof slope.
(8) Double click the right mouse key to exit the Drag Edge command.
(9) Select **CANCEL** on the Measure dialog window to stop tape measuring.

>> **Note: Tape Measure remains active until it is canceled.**

(10) Unlock the N-S direction.

4. This completes the model for this example.

C. Develop snow loads on the shed roof.

1. Select **LOADS AND DESIGN**.
2. Select **SNOW LOADS**. A pop-up dialog window will appear.
   a. Turn off **ROOF HEATED**.

>> **Note: The barrel vault portion of the building is heated, while the shed is unheated. The user must decide for which portion of the total building results are required. For this example, the shed roof is under consideration; thus, "unheated" was chosen. The barrel vault snow loads will therefore not be correct. A separate snow load study is required for the barrel vault, which will then make the shed output incorrect.**

   b. Select Importance Category I, since the shed has an occupancy less than 300 people.
   c. Select **OK** when satisfied with all the parameters. Roof snow load calculations will automatically begin. A pop-up dialog box will keep you informed of the program's progress.
   d. The building plan and a section will appear when the calculations are complete. Note that drift and sliding snow values exist over the shed portion of the roof.
### Drifted and Sliding Snow Loads

<table>
<thead>
<tr>
<th>Snow Unbalanced (psf)</th>
<th>13.3 28.5 43.3 68.7 22.7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snow Drift (psf)</td>
<td>13.3 28.5 43.3 68.7 22.7</td>
</tr>
<tr>
<td>Snow Sliding (psf)</td>
<td>13.3 28.5 43.3 68.7 22.7</td>
</tr>
<tr>
<td>Snow Combined (psf)</td>
<td>13.3 28.5 43.3 68.7 22.7</td>
</tr>
</tbody>
</table>

Repeat all the steps contained in items D, E, and F of Example 1.

**Project:** Theater  
**Location:** Milwaukee  
**Design Load:** Tri-Services  
**Time:** Mon Jan 15, 1990 1:39 PM

************** Arched Roof Snow Load Design **************

**Flat Roof Snow Load (Pf)**  
\[ Pf = 0.7 \cdot Ce \cdot Ct \cdot Pg \]

- **Ce** = 0.9  
- **Ct** = 1.2  
- **Importance Category:** I  
- **Pg** = 35.0 psf  
- **Pf** = 26.5 psf  

- **Roof width:** 80.0 ft  
- **Crown height:** 15.0 ft  

**Equivalent slope**: \( \theta = 21 \text{ deg} \)

Since \( \theta > 60 \text{ deg} \), the flat roof snow load does not apply.

**Sloped Roof Snow Load (Ps)**  
\[ Ps = Cs \cdot Pf \]

- **Cs** = 1.00  

\[ Ps = 26.50 \text{ psf} \]

**Unbalanced Snow Load (Psunbal)**  
\[ Psunbal = 0.5 \cdot Ps \]

\[ Psunbal = 13.30 \text{ psf} \]

---

Invalid for barrel vault roof portion.
30 deg point (30.4 ft from crown)
Punbal = 2*Ps/Ce
\[\text{Punbal} = 2*Ps/Ce\]
\[\text{Punbal} = 58.90 \text{ psf}\]

Eave
Height of eave above grade or lower roof: 18.0 ft
\[\text{Punbal} = [2*Ps/Ce] \times [1-(\phi-30)/40]\]
\[\text{Punbal} = 42.70 \text{ psf}\]

************** Arched Roof Snow Load Design **************

Flat Roof Snow Load (Pf)
Pf = 0.7*Ce*Ct*1*Pg
Snow Exposure Category: B
Ce = 0.9
Unheated structure
Ct = 1.2
Importance Category: I
I = 1.0
Pg = 35.0 psf
Pf = 26.5 psf
Roof width: 80.0 ft
Crown height: 15.0 ft
equivalent slope \theta = 21 deg
Since \theta > 10 deg, min. snow load does not apply.
Since \theta > 1/2 in/ft, rain-on-snow surcharge does not apply.
\[\text{Pf} = 26.50 \text{ psf}\]

Sloped Roof Snow Load
Ps = Cs*Ps
Roof slope: \theta =
Cs = 1.0
\[\text{Ps} = 6.0\]

Unbalanced Snow Load (Punbal)
since equivalent slope, \theta, is 21 deg
10 deg < \theta < 60 deg.
Unbalanced condition applies
Where slope at eaves = 41 deg
use case (ii)
Crown
Punbal = 0.5*Ps
\[\text{Punbal} = 13.30 \text{ psf}\]

30 deg point (30.4 ft from crown)
Punbal = 2*Ps/Ce
\[\text{Punbal} = 58.90 \text{ psf}\]

Eave
Height of eave above grade or lower roof: 6.0 ft
\[\text{Punbal} = [2*Ps/Ce] \times [1-(\phi-30)/40]\]
\[\text{Punbal} = 42.70 \text{ psf}\]

Invalid for barrel vault roof portion.
****** Flat/Lean-To Roof Snow Load Design *******

Flat Roof Snow Load (Pf)
Pf = 0.7*Ce*Ct*I*Pg
Snow Exposure Category: B
Ce = 0.9
Unheated structure
Ct = 1.2
Importance Category: I
I = 1.0
Pg = 35.0 psf
Pf = 26.5 psf
Roof slope: 2.00 in 12
theta = 9 deg
Check minimum Pf where theta < 15 deg
When Pg 20.0 psf, min Pf = 20*I
min Pf = 20.0 psf
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.

-------------------------------
Pf = 26.50 psf
-------------------------------

Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 1.00

-------------------------------
Ps = 26.50 psf
-------------------------------

*************** Drift Snow Load Design ***************

Pg = 35.0 psf
Snow density = 20.0 pcf
hb = Ps/density
hb = 1.33 ft
Projection height = 6.00 ft
hc = height-hb
hc = 4.68 ft
hc/hb = 3.53 = 0.20 Therefore consider drift load
Importance Category: I
I = 1.0
Snow Exposure Category: B
Ce = 0.9
Separation = 0.00 ft
hd = 2*I*Pg/Ce*density*(20-s/20) < hc
hd = 3.89 ft
hd < hc
Pd = hd*density

-------------------------------
Pd = 77.78 psf
-------------------------------

Width of drift for L = 40.00 < 50 ft: W = 3*hd = 10 ft

-------------------------------
W = 11.70 ft
-------------------------------

*************** Sliding Snow Load Design ***************

Theta = 37 deg 2 in 12, therefore sliding snow
Increase in drift height: hs = 0.4*hd
hs = 1.56
hd + hs > hc
hd + hs = 5.45
hc = 4.68
maximum height = 4.68
Pd + Ps = height*density

-------------------------------
Pd + Ps = 93.50 psf
-------------------------------
Notes for sliding snow:
Calculations based on MBMA 1986
EXAMPLE EIGHT: Multiple-gable roof

Given: This multiple-gable roof example is taken from page E-2 of TM 5-809-1. It is a warehouse located in Anchorage, Alaska, and the site is a windy field with a few birch trees planted nearby. It is an unheated structure with roofing that creates a rough surface. The following dimensional data are given, and there are no adjacent structures.

Required: Determine the balanced and unbalanced snow loads.

Solution:

A. Establish Criteria.

1. Input the following data into the PROJECT, REGIONAL, and SITE Criteria dialog windows:

   PROJECT:
   - Project Name : Warehouse
   - City/Installation : Anchorage
   - State : AK
   - Design Load : Tri-Services

   REGIONAL:
   - Ground Snow Load : 45 psf

   SITE SNOW:
   - Importance : Category I
   - Exposure : Category B
   - Roof Slippery : no
   - Roof Heated : no

   Note: The CASM program uses the abbreviations for the names of states rather than the full name. The insertion of AK for Alaska switches the program from TM equation 6-1a to 6-1b.

B. Draw volumetric model

   1. Select DRAW MODEL from the CASM menu bar.
   2. Establish general layout requirements, which are different than previously established.
a. Use the following:

- **SNAP INCREMENT**: 12 inches
- **SNAP TO UNITS**: on
- **SHOW GROUND PLANE**: on

**GROUND PLANE**
- **WIDTH** N-S: 140 feet
- **E-W**: 140 feet
- **SPACING** N-S: 20 feet
- **E-W**: 20 feet

**INITIAL OBJECT SIZE**
- **N-S**: 120 feet
- **E-W**: 60 feet

- **HEIGHT**: 18 feet
- **ORIENTATION**: N-S
- **STACK ON GROUND PLANE**: on
- **DIRECTIONS LOCKED**: none

3. Place a **CUBE** on the ground plane with the required dimensions.

4. Draw the multiple-gable roof.
   a. Change the following **INITIAL OBJECT SIZE** values:
      - **E-W WIDTH**: 30.0 feet
      - **HEIGHT**: 5.0 feet
      - **MAINTAIN INITIAL SIZE**: on
   b. Turn on **STACK ON PLANE**.
   c. Add one half of the multiple-gable roof.
      1. Select **PRISM** from the Shapes pull-down menu. Handle will appear on all the visible planes.
      2. Select the top plane of the cube with the mouse pointer. The plane is highlighted and a prism will appear at the Initial Object Size of 30.0 feet wide, 120.0 feet long, and 5.0 feet high at the center of the plane.
      3. Move the mouse left and right to position the prism at one edge of the cube.
      4. Click the left mouse key to fix the position of the prism. Handles will appear on planes to stack another prism onto.
(5) Select the top plane of the cube with the mouse pointer. The plane is highlighted, and a prism will appear on top of the cube.

(6) Move the mouse left and right to position the prism at the other edge on the cube.

(7) Click the left mouse key to fix the position of the prism. Handles will appear on planes to stack another prism onto.

(8) Double click the right mouse key to stop stacking prisms on planes.

5. This completes creation of the model.

C. Repeat all the steps contained in items C through F of Example 1 to develop and print snow loads for a multiple-gable roof.

| Snow Unbalanced (psf) | 14.6 |
| Snow Balanced (psf)   | 29.2 |
| Snow Drift (psf)      | 29.2 |
| Snow Sliding (psf)    | 29.2 |
| Snow Combined (psf)   | 29.2 |

Project: Warehouse
Location: Anchorage
Design Load: Tri-Services
Time: Tue Jan 30, 1990 10:19 PM

***** Multiple Folded Plate Roof Snow Load Design *****

Flat Roof Snow Load (Pf)
Pf = 0.6*Ce*Ct*I*Pg
Snow Exposure Category: B
Ce = 0.9
Unheated structure
Ct = 1.2
Importance Category: I
I = 1.0
Pg = 45.0 psf
Pf = 29.2 psf
Roof slope: 4.00 in 12
Theta = 18 deg
Since theta > 15 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.

\[ Pf = 29.20 \text{ psf} \]

**Sloped Roof Snow Load (Ps)**
\[ Ps = Cs \cdot Pf \]
Roof slippery: No
\[ Cs = 1.00 \]
\[ Ps = 29.20 \text{ psf} \]

Note: See Gable output for first windward and last leeward slope.

**Unbalanced Snow Load (punbal)**
Ridge
\[ \text{Punbal} = 0.6 \cdot Pf \]
\[ \text{Punbal} = 14.60 \text{ psf} \]

Valley
\[ \text{Punbal} = 3 \cdot Pf / Ce \]
\[ \text{Punbal} = 97.33 \text{ psf} \]
Height of unbalanced load = 4.87 ft < height of ridge = 5.00 ft
\[ \text{Punbal} = 97.33 \text{ psf} \]

**Flat Roof Snow Load Design**

\[ Pf = 0.6 \cdot Ce \cdot Ct \cdot I \cdot Pg \]

Snow Exposure Category: B
\[ Ce = 0.9 \]
Unheated structure
\[ Ct = 1.2 \]
Importance Category: I
\[ I = 1.0 \]
\[ Pg = 45.0 \text{ psf} \]
\[ Pf = 29.2 \text{ psf} \]
Roof slope: 4.00 in 12
\[ \theta = 18 \text{ deg} \]
Since theta > 15 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.
\[ Pf = 29.20 \text{ psf} \]

**Sloped Roof Snow Load (Ps)**
\[ Ps = Cs \cdot Pf \]
Roof slippery: No
\[ Cs = 1.00 \]
\[ Ps = 29.20 \text{ psf} \]

**Unbalanced Snow Load (Punbal)**
Since 15 deg < theta < 70 deg, unbalanced condition applies.
\[ \text{Punbal} = 1.5 \cdot Ps / Ce \]
\[ \text{Punbal} = 48.70 \text{ psf} \]
WIND LOADS

This section includes examples of wind load design for (1) main wind force resisting systems, (2) building components and cladding, and (3) unenclosed buildings. Subtopics under each of these three categories will address various roof forms and building heights to illustrate all provisions of the Tri-Services Load Assumption for Buildings Technical Manual.

Main Wind Force Resisting Systems

EXAMPLE ONE: One story - Gable roof

Given: This one-story gabled roof industrial building is an example taken from page D-1 of TM 5-809-1. It is to be used for storage and maintenance of equipment. It is located in Huntsville, AL and is sited in exposure category C. See illustration below.

Required: Determine the external pressures and suctions on all surfaces for wind perpendicular and parallel to the ridge.

Solution:

A. Establish Criteria.

1. Select CRITERIA from the CASM menu bar and scroll down the pull-down menu to PROJECT.
2. Insert the following data:
Project name: Industrial building,  
City/installation: Huntsville,  
State: AL  
Design load: Tri-Services.

Note: No database exists for Huntsville and you will have to fill in any other useful data. The elevation above sea level is not used in this version, and a default factor of 0.00256 is assumed to reflect air mass density for the so-called "standard atmosphere" in calculations of velocity pressure \( q_z \). Select OK when finished inputting data.

3. Select CRITERIA for a second time and scroll down the pull-down menu to REGIONAL.
4. Insert the following data into the appropriate boxes within the REGIONAL WINDOW:

- Basic Wind Speed: 70 mph (from the basic wind speed map)
- Coastal: no (leave the box blank)

Note: It is important not to omit consideration of coastal. If you click on the box, an X will appear, indicating that you are within 100 miles of the coastline. You will be asked for the distance later. Should you leave the box blank, it is assumed that you are inland and 100 miles will be the default value used later.

5. Select OK when finished, since no other data are required here.
6. Again select CRITERIA and scroll down the pull-down menu to SITE.
7. Insert the following WIND data into the appropriate boxes within the SITE WINDOW:

- Importance, I: 1.0
- Exposure: C

The pop-up dialog windows will assist you in the selections above.

Distance to oceanline: If the coastal box was left blank, 100 miles will exist here. This value cannot now be changed. If coastal was checked X, you may enter any number less than 100 miles.

8. Select OK when you have finished entering data. The CASM program will return to the CASM program window.

B. Draw volumetric model.
1. Select DRAW MODEL from the CASM menu bar.
2. Establish general layout requirements for this example.
   a. Use the following:
DEFINE UNITS (snap increment): 12 inches
SNAP TO UNITS: on
SHOW GROUND PLANE: on
GROUND PLANE
  WIDTH: N-S: 100 feet, E-W: 100 feet
  SPACING: N-S: 20 feet, E-W: 20 feet
INITIAL OBJECT SIZE
  N-S: 20 feet, E-W: 75 feet
  HEIGHT: 18 feet
  ORIENTATION: E-W
STACK ON GROUND PLANE: on
DIRECTIONS LOCKED: none

3. Create the first floor building volume.
   a. Select CUBE and center on the ground plane.

4. Create the gable roof form.
   a. Turn on STACK ON LAST SHAPE from Layout pull-down menu.
   b. Select PRISM.
   c. Lock the N-S and E-W directions.
   d. Select DRAG EDGE from Edit pull-down menu. Lower the ridge to 6 feet in height by selecting the handle on the ridge with the mouse pointer and by holding down the right mouse key while dragging the mouse toward you.
   e. Unlock the N-S and E-W directions.

5. Create wall openings.

   Note: It is not necessary to draw all the wall openings on every elevation, if you already know the internal pressure coefficients (GCpi) for your model. The computer will automatically compute the required GCpi if you are uncertain as to whether you meet the criteria upon which GCpi values are based. We will let the computer do the calculations for us in this example.

   a. Select DRAW STRUCTURE from the CASM menu bar.
   b. Select VERTICAL PLANE from the Viewpoint Options pull-down menu. Handles will appear on the visible vertical planes.
   c. Select the south plane with the mouse and a 2-D elevation of the selected wall will appear.
   d. Create the continuous top window opening.
      (1) Select ADD OPENINGS from the Grid/Open pull-down menu. A Tributary Area dialog window will appear which shows the distance of the mouse pointer from the lower left corner of the 2-D view, lengths of the opening, and the tributary area of the opening.
(2) Locate the mouse pointer at the upper left corner of the elevation. Single click the left mouse key to fix one opening corner.

(3) Drag the mouse to dynamically proportion the opening until the vertical length is 2 feet and the horizontal length is 75 feet.

(4) Click the left mouse key when the desired opening size is achieved.

(5) A dialog box appears asking you to name the opening. Type name: Eave Strip Window.

Note: The CONTINUOUS openings option only applies to horizontal floor planes. It would duplicate the opening on all other floors in the model.

(6) Click on OK when finished to add the opening.

Note: Clicking on CANCEL will not insert the opening.

e. Create the overhead door openings.

(1) Click on DRAW MODEL on the CASM menu bar.

(2) Set the SNAP INCREMENT to 6 inches from the Define Units command.

(3) Click on DRAW STRUCTURE from the CASM menu bar to activate the Draw Structure tool palette.

(4) Select ADD OPENING from the Grid/Open pull-down menu. The Tributary Area pop-up dialog window will again appear.

(5) Move the mouse pointer until the distance from the lower left corner is 2.5 feet horizontally and 0.0 feet vertically. Single click the left mouse key to fix the corner of the opening.

(6) Drag the mouse until the door proportions are 10 feet horizontally and vertically.

(7) Click the left mouse key to fix the opening dimensions.

(8) Name the opening: Door 1.
(9) Click on OK to add the opening.
(10) Repeat steps (4) through (9) to add the remaining openings on this elevation.

f. Select PERSPECTIVE (3D) from the Viewpoint Options pull-down menu to view the model at this stage.

g. Add eave strip windows along the other three elevations. Follow steps 5b through 5d.

Note: You will have to select PERSPECTIVE (3D) and rotate the model to view other elevations and facilitate wall selection.

Note: Only openings from the last selected plane will be shown on the 3-D model. To see all openings on all elevations, select SHOW STRUCTURE and select the check box for ALL.

h. This completes the model and its openings for this example.

C. Develop Main Wind Force Resistance wind loads on the building.

1. Select LOADS AND DESIGN from the CASM menu bar.

2. Select WIND from the Loads pull-down menu. A Wind Loads pop-up dialog window will appear with values selected under Criteria.

<table>
<thead>
<tr>
<th>Wind Loads</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Wind Speed</td>
</tr>
<tr>
<td>Importance Factor</td>
</tr>
<tr>
<td>Exposure Category</td>
</tr>
<tr>
<td>% Openings Coefs.</td>
</tr>
</tbody>
</table>

3. Select % OPENINGS COEFS. by clicking the left mouse key in either of the two boxes. An Internal Pressure Coefficients pop-up dialog window will appear listing options and their criteria.
LOADS

WIND LOADS

Internal Pressure Coefficient

-0.75 and -0.25
1. Percentage of openings in one wall exceeds that of all other walls by 10 percent or more, and openings in all other walls do not exceed 20 percent of respective wall area.
Percentage of openings is based on gross area of wall.

0.25 and -0.25
2. All other cases.

Compute percentage of openings
File name: GCPIOUT.TXT

OK Cancel

a. Select COMPUTE PERCENTAGE OF OPENINGS to have the computer select GCpi based on code criteria.
b. Modify filename if desired.
c. Select OK and internal pressure criteria will be tested. A pop-up dialog window will appear to keep you informed of the calculation progress. Final GCpi values will be displayed in the Wind Load dialog window.

Note: The output file can be displayed and printed similar to snow load calculations.

4. Turn on MAIN WIND FORCE RESISTANCE SYSTEM.
5. Modify Output Filename as desired.

Note: Selection of ASSUMPTIONS allows the user to choose a plan and height ratio for appropriate consideration of B/L and h/L ratios for irregular building forms. An option to use the eave height, rather than the roof mean height, for slopes less than 10 degrees can also be selected. See the Reference Manual for further elaboration.

6. Click on OK when satisfied, and wind load calculations will begin. A pop-up dialog window will keep you informed of the progress.

Wind Load: GCpi=0 (psf)

7. The building plan and a section will appear upon completion of the calculations. Wind pressures and suction will be shown for the wind direction arrow displayed and with GCpi = 0.

D. Manipulation of the building model and its wind loads.
1. Change wind direction.
a. Select PERSPECTIVE (3D) from Viewpoint Options menu. A 3D view will appear on the screen with a wind direction arrow and a ground plane north arrow.

Note: Pressures are shown in a cyan (light blue) color, and suctions are shown in a magenta (purple) color.

b. Rotate the view direction 90 degrees clockwise by dragging the black arrow around the circle in the Viewpoint window.

c. Select SECTION from the Options pull-down menu. The rotated 2-D plan and section will appear with new wind pressures and suctions shown.

Wind Load: GCpi=0 (psf)

Note: The wind direction is always shown left to right in the section view.

2. Display wind loads with consideration of internal pressures.
   a. Select SHOW LOADS from the Options menu in the Viewpoint window. A Show Loads dialog window will appear.
   b. Select either GCpi Negative or GCpi Positive.
   c. Click on OK. The selected wind loads will appear on the section.
   d. Repeat steps a through c to view the other GCpi case.

3. Review B and L Assumptions used in wind calculations.
   a. Select PERSPECTIVE (3D).
   b. Select B AND L ASSUMPTIONS from the Show Loads window.
   c. Click on OK. Red B & L rectangles for wind in all four directions will appear.
Note: For Example 1 refer to the B and L diagram shown on the right. Each rectangular outline represents the assumed B and L dimensions used in the calculations. The wind direction is shown by a triangle pointing in the direction of the wind. The numbered labels appearing on each red rectangle coincide with the numbered titles on the output calculations. To display all four rectangles, you will need to zoom out. Refer to the B&L examples below for irregular shapes.

4. Turn off the display of openings.
   a. Select SHOW STRUCTURE from the Options pull-down menu in the Viewpoint window. A Show Structure pop-up dialog window will appear.
   b. Turn off OPENINGS.
   c. Select OK and the displayed openings on the 3-D model will disappear.

5. To rotate, pan, zoom, change from wireframe to solid, and perform other operations with the 3-D model:
   a. Follow steps D-1 through D-4 of Example 1 in the snow load section.

E. Generation of hard copies.
1. Follow steps E-1 and E-2 of Example 1 in the snow load section to print a screen image.
2. Review and print the wind load calculations.
   a. Follow steps E-3 and E-4 of Example 1 in the snow load section.
3. To view the computed percentage of openings in NOTEPAD, select OPEN from the NOTEPAD FILE pull-down menu and select the GCPIOUT.TXT file. Use the PRINT command from the FILE pull-down menu to print the Computed Percentage of Openings file.
Note: Wind output titles include a number which corresponds to the number on the B & L Assumptions rectangles. This will assist the user in interpreting the direction of wind in the calculations.

Computed Percentage of Openings output:

Project: Industrial Building
Location: Huntsville
Design Load: Tri-Services
Time: Mon Jan 15, 1990 2:18 PM

********** Internal Pressure Coefficients, GCpi **********

1. Percentage of openings in one wall exceeds that of all other walls by 10 percent or more, and openings in all other walls do not exceed 20 percent of respective wall area. Percentage of openings is based on gross area of wall +0.75 & -0.25

2. All other cases. +0.25 & -0.25

Wall Plane Name Wall Area (sf) Opening Area (sf) Opening (%) Wall - 1 420.0 40.0 9.5 Wall - 2 1350.0 150.0 11.1 Wall - 3 420.0 40.0 9.5 Wall - 4 1350.0 650.0 48.1

Wall - 4 satisfies condition 1.
GCpi = +0.75 and -0.25

Main Force Resistance System Output:

Project: Industrial Building
Location: Huntsville
Design Load: Tri-Services
Time: Mon Jan 15, 1990 2:37 PM

************* Wind Load - 1 *************

Velocity Importance Exposure Width Length Roof Type Factor Perend. Parallel to Wind to Wind (mph) (ft) (ft)

70.0 1.00 C 20.0 75.0

Distance to ocean line >= 100 mi. h/d = 1.05 <= 5

********** Main Framing Pressures **********

Parallel to Ridge or Length

Location z or h Gh Kz qz Cp External Pressure P(psf)

Windward Wall
level 3 24.0 1.29 0.92 11.5 0.80 11.9 14.6 3.6
level 2-3 21.0 1.29 0.88 11.0 0.80 11.4 14.1 3.1
level 1-2 9.0 1.29 0.80 10.0 0.80 10.3 13.1 2.1
level 1 1.29 0.80 10.0 0.80 10.3 13.1 2.1

Leeward Wall
level 2 21.0 1.29 0.88 11.0 -0.71 -5.0 -0.2 -11.2
level 1-2 9.0 1.29 0.80 10.0 -0.71 -4.9 -0.2 -11.2
level 1 1.29 0.80 10.0 -0.71 -4.9 -0.2 -11.2

Side Wall
level 2 21.0 1.29 0.88 11.0 -0.70 -9.9 -7.2 -18.2
level 1-2 9.0 1.29 0.80 10.0 -0.70 -9.9 -7.2 -18.2
level 1 1.29 0.80 10.0 -0.70 -9.9 -7.2 -18.2

Roof
level 2 21.0 1.29 0.88 11.0 -0.70 -9.9 -7.2 -18.2
level 1-2 9.0 1.29 0.80 10.0 -0.70 -9.9 -7.2 -18.2
level 1 1.29 0.80 10.0 -0.70 -9.9 -7.2 -18.2

Internal
level 2 21.0 1.29 0.88 11.0 0.0 -2.8 8.3
level 1-2 9.0 1.29 0.80 10.0 0.0 -2.8 8.3
level 1 1.29 0.80 10.0 0.0 -2.8 8.3

4-49
**WIND LOADS**

---

### Wind Load - 2

**Velocity Importance Exposure Factor**

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Importance</th>
<th>Exposure Factor</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>(mph)</td>
<td></td>
<td></td>
<td>Perpend.</td>
<td>Parallel to Wind</td>
<td>(ft)</td>
</tr>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>75.0</td>
<td>20.0</td>
<td>WW</td>
</tr>
</tbody>
</table>

**Distance to oceanline>=100 mi. h/d=1.05<=5**

**Lee: 7.20 in 12**

---

#### Main Framing Pressures

**Location**

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External</th>
<th>Pressur P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>GCpi=0</td>
<td></td>
</tr>
<tr>
<td>Level 2</td>
<td>18.0</td>
<td>1.29</td>
<td>0.84</td>
<td>10.5</td>
<td>0.80</td>
<td>10.8</td>
<td>13.6</td>
</tr>
<tr>
<td>Level 1</td>
<td>9.0</td>
<td>1.29</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.3</td>
<td>13.1</td>
</tr>
<tr>
<td>Level 1-2</td>
<td>0.0</td>
<td>1.29</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.3</td>
<td>13.1</td>
</tr>
<tr>
<td>Leeward Wall</td>
<td>21.0</td>
<td>1.29</td>
<td>0.88</td>
<td>11.0</td>
<td>-0.50</td>
<td>-7.1</td>
<td>4.3</td>
</tr>
<tr>
<td>Side Wall</td>
<td>21.0</td>
<td>1.29</td>
<td>0.88</td>
<td>11.0</td>
<td>-0.70</td>
<td>-9.9</td>
<td>7.2</td>
</tr>
<tr>
<td>Windward Roof</td>
<td>21.0</td>
<td>1.29</td>
<td>0.88</td>
<td>11.0</td>
<td>-0.29</td>
<td>-4.1</td>
<td>1.4</td>
</tr>
<tr>
<td>Leeward Roof</td>
<td>21.0</td>
<td>1.29</td>
<td>0.88</td>
<td>11.0</td>
<td>-0.70</td>
<td>-9.9</td>
<td>7.2</td>
</tr>
<tr>
<td>Internal</td>
<td>21.0</td>
<td>0.88</td>
<td>11.0</td>
<td>0.0</td>
<td>0.0</td>
<td>8.3</td>
<td></td>
</tr>
</tbody>
</table>

**Notes for main framing:**

- Positive pressures act toward surfaces.
- Pressure or suction = P = q*Gh*Cp and/or P = qh*Gh*Cp - qh*(GCpi)

**Note:** Levels on the windward side are designated by numbers starting with 1 at elevation z = 0.0 feet. Level 2 becomes the eave height at elevation z = 18.0 feet, since no intermediate floors were created in the model. Level 3 is the ridge height for wind parallel to the ridge, which is z = 24.0 feet. Level 1-2 indicates a midheight level between levels 1 and 2. This corresponds to elevation z = 9.0 feet in this example. Level 2-3 also indicates a midheight level between levels 2 and 3, which in this case is also the mean roof elevation of 21.0 feet. The mean roof height is used to calculate pressures and suction for leeward, side, and roof surfaces. It is also used to calculate internal values.

---

**F. Save the building model with its wind loads applied for future reference.**

1. Follow the steps in part F of Example 1 in the snow loads section.

   a. A sample of the Main Framing Pressure levels is shown below.

   ![Diagram of building levels]

   - Level 3
   - Level 2-3 Mean
   - Level 2
   - Level 1-2
   - Level 1

---
EXAMPLE TWO: Three story - Flat roof

Given: This example is taken from page D-14 of TM 5-809-1. It is a three-story administrative building with a height less than 60 feet. It is sited in Mississippi at the Army Ammunition Plant on the coast of the Gulf of Mexico. It is assumed to be in exposure category C and to have an importance factor of I. The windows shown on the elevation exist on all four elevations. A plan and elevation follow:

Required: Determine the external wind pressure and suctions on all surfaces.

Solution:

An abbreviated discussion is given here since most of the steps repeat in a similar fashion to Example One.

A. Establish Criteria

1. Input the following data into the PROJECT, REGIONAL, and SITE CRITERIA dialog windows:

   PROJECT
   Project name : Administration Bldg.
   City/Installation : Ammo Plant
   State : MS
   Design Load : Tri-Services

   REGIONAL
   Basic Wind Speed : 100.0 mph
   Coastal : yes (highlight with an X)

   SITE WIND
   Importance : Category I
   Exposure : Category C
   Distance to Oceanline : 0.0 miles
B. Draw volumetric model.

1. Select **DRAW MODEL** from the CASM menu bar.
2. Create the first floor building volume.
   a. Establish general layout requirements as required.

   **Tip:** start with the default initial object size and drag planes or set the initial object size to the correct proportions.
   b. Add the Cube to the ground plane.
3. Create the second and third floor volumes.
   a. Select **DUPLICATE** from the Edit pull-down menu or click on the Rabbits icon. A Duplicate pop-up dialog window will appear asking you how many objects are to be added in each direction and the clear spacing between the objects.
   b. Change the **VERTICAL** number to 2. Leave the **VERTICAL SPACE** distance at 0.0 feet so that the objects will connect directly.

   ![Duplicate Dialog Window]

   - **N-S Direction**: 0
   - **E-W Direction**: 0
   - **Vertical**: 2
   - **N-S Space**: 0.00 ft
   - **E-W Space**: 0.00 ft
   - **Vertical Space**: 0.00 ft
   - **OK**
   - **Cancel**

c. Click on **OK** and solid circle handles will appear on the visible planes of the shape.

d. Select any one of the three handles on the shape and the two vertically duplicated shapes will appear. Handles will now appear on all three shapes to permit duplicating another shape.

e. Double click on the right mouse key to exit the Duplicate command.

4. This completes the model for this example.
C. Develop Main Wind Force Resistance wind loads on the building.

1. Select LOADS AND DESIGN from the CASM menu bar.
2. Select WIND from the Loads pull-down menu or the Wind icon. The Wind Loads pop-up dialog window will appear.
   a. The % OPENINGS COEFS. are set at the default values of +0.25 and -0.25.

   Note: It is not necessary to draw in the openings on the building and have the computer check code criteria and select coefficients when it is obvious that similar openings exist on all four elevations.

b. Turn on MAIN WIND FORCE RESISTANCE SYSTEM.
c. Modify Output Filename as desired.

3. Click on OK when satisfied, and wind load calculations will begin. A pop-up dialog window will keep you informed of the progress.
4. The building plan and a section will appear upon completion of the calculations. Wind pressures and suctions will be shown for the wind direction arrow displayed and with GCpi = 0.
D. Manipulation of the building model and its wind loads.

1. Follow steps D-1 through D-4 from Example 1 in this section and steps D-1 through D-4 from Example 1 in the snow load section.

E. Generation of hard copies.

1. Follow steps E-1 and E-2 of Example 1 in the snow load section to print a screen image.

2. Review and print the wind load calculations.
   a. Follow steps E-3 and E-4 of Example 1 in the snow load section.

---

Project: Administration Bldg.
Location: Ammo Plant
Design Load: Tri-Services
Time: Mon Jan 15, 1990 2:50 PM

* ** Wind Load - 1 ****************************

<table>
<thead>
<tr>
<th>Velocity (mph)</th>
<th>Importance Factor</th>
<th>Exposure</th>
<th>Perpendicular to Wind (ft)</th>
<th>Parallel to Wind (ft)</th>
<th>Roof Type</th>
<th>Width (ft)</th>
<th>Length (ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>100.0</td>
<td>1.05</td>
<td>C</td>
<td>40.0</td>
<td>40.0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Distance to ocean line: 0 mi.  h/d = 1.05 <= 5

* ************* Main Framing Pressures *************

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh (psf)</th>
<th>Kz (psf)</th>
<th>qz (psf)</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
<th>GCpi=0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-0.25</td>
<td>0.25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Windward Wall
level 1 42.0 1.23 1.07 30.2 0.80 29.7 37.3 22.2
level 2-3 21.0 1.23 0.88 24.8 0.80 24.4 32.0 16.9
level 1-2 7.0 1.23 0.80 22.6 0.80 22.2 29.8 14.7
level 1 0.0 1.23 0.80 22.6 0.80 22.2 29.8 14.7
Leeward Wall 42.0 1.23 1.07 30.2 0.50 -18.6 -11.0 -26.1
Side Wall 42.0 1.23 1.07 30.2 0.70 -26.0 -18.5 -33.6
Roof 42.0 1.23 1.07 30.2 -0.70 26.0 18.5 33.6
Internal 42.0 1.07 30.2 0.0 7.6 7.6

Notes for main framing:
Positive pressures act toward surfaces.
Pressure or suction = P = q * Gh * Cp and/or P = qh * Gh * Cp * qh * (GCpi)

External wind pressure and suction values are typically computed for wind applied parallel and perpendicular to the long dimension or ridge of a building. The answers are the same in this example since it is a square in plan.

F. Save the building model with its wind loads applied for future reference.

1. Follow the steps in part F of Example 1 in the snow load section.
EXAMPLE THREE: One story - Arched roof

Given: This example is taken from page D-18 of TM 5-809-1. It is a one-story auditorium with a barrel vault roof. It is sited at Robbins AFB, GA, and has an assumed exposure category of C. It has a seating capacity of more than 300 people, which requires an importance category II. The percentage of openings is no more than 10%. A typical elevation follows:

Required: Determine the external wind pressures and suctions for all surfaces for wind applied parallel and perpendicular to the crown.

Solution:
An abbreviated discussion is given here since most of the steps repeat in a similar fashion to Example 1.

A. Establish Criteria
1. Input the following data into the PROJECT, REGIONAL, and SITE pop-up dialog windows from Criteria on the CASM menu bar:

   PROJECT
   Project Name: Auditorium
   City/Installation: ROBBINS AFB
   State: GA
   Design Load: Tri-Services

   REGIONAL
   Basic Wind Speed: 75 mph
   Coastal: no (leave blank)

   SITE WIND
   Importance: Category II
   Exposure: Category C
   Distance to Coastline: 100 miles (default)

B. Draw volumetric model
1. Follow the procedure outlined in step B of Example 2 from the snow load section, or any appropriate combination of commands from previous examples to create the basic geometry required.
C. Develop Main Wind Force Resistance wind loads on the building.
   1. Follow the procedure outlined in step C of Example 2 from this section.

D. Manipulation of the building model and its wind loads.
   1. Follow steps D-1 through D-4 from Example 1 in this section and steps D-1 through D-4 from Example 1 in the snow load section.

E. Generation of hard copies.
   1. Follow steps E-1 and E-2 of Example 1 in the snow load section to print a screen image.

2. Review and print the wind load calculations.
   a. Follow steps E-3 and E-4 of Example 1 in the snow load section.
   b. The output includes wind pressures and suctions on all surfaces for the cases of wind applied perpendicular and parallel to the crown. Values for the arch are broken into windward quarter (two values), middle half, and leeward quarter. Three columns of values are provided to account for no consideration of internal pressure ($\text{GC}_{pi} = 0$), and positive and negative internal pressures considered ($\text{GC}_{pi} = -0.25$ or $+0.25$). The internal pressure coefficients were selected by you. A sample output follows:
**WIND LOADS**

**Project**: Auditorium  
**Location**: Robbins AFB  
**Design Load**: Tri-Services  
**Time**: Mon Jan 15, 1990 3:36 PM

---

**Wind Load - 1**

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure</th>
<th>P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windward Wall</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 2</td>
<td>10.0</td>
<td>1.24</td>
<td>0.80</td>
<td>13.2</td>
<td>0.80</td>
<td>13.1</td>
<td>17.3</td>
</tr>
<tr>
<td>Level 1-2</td>
<td>5.0</td>
<td>1.24</td>
<td>0.80</td>
<td>13.2</td>
<td>0.80</td>
<td>13.1</td>
<td>17.3</td>
</tr>
<tr>
<td>Level 1</td>
<td>0.0</td>
<td>1.24</td>
<td>0.80</td>
<td>13.2</td>
<td>0.80</td>
<td>13.1</td>
<td>17.3</td>
</tr>
<tr>
<td><strong>Leeward Wall</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side Wall</td>
<td>35.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.70</td>
<td>-14.6</td>
<td>-10.4</td>
</tr>
<tr>
<td>Roof</td>
<td>35.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.70</td>
<td>-14.6</td>
<td>-10.4</td>
</tr>
</tbody>
</table>

---

**Wind Load - 2**

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure</th>
<th>P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windward Wall</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 1</td>
<td>0.0</td>
<td>1.24</td>
<td>0.80</td>
<td>13.2</td>
<td>0.80</td>
<td>13.1</td>
<td>17.3</td>
</tr>
<tr>
<td><strong>Leeward Wall</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side Wall</td>
<td>35.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.70</td>
<td>-14.6</td>
<td>-10.4</td>
</tr>
<tr>
<td>Windward Quarter</td>
<td>35.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.70</td>
<td>-14.6</td>
<td>-10.4</td>
</tr>
<tr>
<td>Windward Quarter*</td>
<td>35.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.60</td>
<td>-15.6</td>
<td>-24.0</td>
</tr>
<tr>
<td>Middle Half</td>
<td>35.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.95</td>
<td>-15.6</td>
<td>-24.0</td>
</tr>
<tr>
<td>Leeward Quarter</td>
<td>35.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.50</td>
<td>-6.5</td>
<td>-16.8</td>
</tr>
<tr>
<td>Internal</td>
<td>0.0</td>
<td>1.24</td>
<td>1.02</td>
<td>16.8</td>
<td>0.00</td>
<td>-4.2</td>
<td>-16.8</td>
</tr>
</tbody>
</table>

---

**Note:**  
*Windward quarter roof pressure has 2 values per Table 5-5.*
Notes for main framing:
Positive pressures act toward surfaces.
Pressure or suction $P=q\cdot gh\cdot C_p$ and/or $P=q\cdot gh\cdot C_p-q\cdot gh\cdot (G\cdot C_{pi})$

F. Save the building model with its wind loads applied for future reference.
   1. Follow the steps in part F of Example 1 in the snow load section.
Components and Cladding

**EXAMPLE ONE: Building height less than 60 feet**

**Given:** This example uses all the building data of Example One for Main Wind-Force Resisting Systems and continues the example on page D-1 of TM 5-809-1.

**Required:** Determine the pressures and suctions on the following building components:

- Overhead door adjacent to building corner.
- Typical corner wall girt.
- Maximum tension on a wall fastener.

**Solution:**

**A. Establish Criteria.**

1. Retrieve the saved file of main wind force resisting system (Example 1).
   - Select OPEN from the File pull-down menu on the CASM menu bar. A pop-up dialog window will appear with a list of all saved files.
   - Scroll if necessary to find the desired filename.
   - Use the mouse to highlight the filename and select OPEN to load the data file.

2. Review the PROJECT, REGIONAL, and SITE Criteria windows to ensure that the desired values are present.
B. Draw volumetric model.
   1. The model is already complete for this example and appears on the screen.

C. Draw structural girts as shown on the given isometric drawing.
   1. Select DRAW STRUCTURE from the CASM menu bar. The Draw Structure tool palette will appear.
   2. Develop a structural grid within which structural elements can be drawn.

   It is necessary to establish a structural grid before structural elements can be inserted.

   a. Select DEFINE GRID from the Grid/Open pull-down menu. A Define Grid dialog window will appear with default values.

   
   ![Define Grid Dialog Window]

   b. Set N-S SPACING to 20 feet and the E-W SPACING to 15 feet which is the typical bay for this example.
   c. Leave the PERIMETER OFFSET at 0.0 inch to indicate that the grid coincides with the extreme outer surface of the exterior envelope.
   d. Select OK to define the grid on the building volume. The grid will appear on the currently selected plane.

   The grid will appear on the last vertical plane upon which work was done.

   Note: The Grid OPTIONS selection is not needed for this example since we will use the default lettering, numbering, and bubble locations. The Reference manual explains the available options in more detail.

   ![Define Grid Options]

3. Select the end wall vertical plane which is to receive the girts.
   a. Select VERTICAL PLANE from the Options pull-down on the Viewpoint window. Handles will appear on the visible vertical planes.
b. Select the end wall vertical plane with the mouse.

The plane will appear in 2-D with its openings and pertinent grids with their dimensions.

4. Draw the two widely spaced horizontal girts on the end wall.
   a. Select WIDELY SPACED from the Floor/Roof pull-down menu. Handles appear at the midpoints of the gridline segments and the midpoints of the modeled plane lines.

   **Note:** Floor/Roof contains surface and linear structural elements which can be placed within horizontal, inclined, and vertical planes.

   b. Select a sufficient number of handles in a clockwise order to define the perimeter within which structure is to be drawn. The perimeter should not include the opening. A highlighted dotted line will be drawn showing the perimeter.

   **Note:** A handle represents the midpoint of a line which contains two points on one edge of the perimeter. The perimeter is made up of these points.

   **Note:** There are several ways to select the desired perimeter: (1) by selecting handles in a clockwise order around the entire perimeter, or (2) by selecting one handle and the mutually opposite side handle.
Note: If you select an incorrect handle, double click the right mouse key to stop adding to the perimeter and select CANCEL in the element dialog box.

c. When the desired perimeter is selected, double click the right mouse key to fix the perimeter. The Linear Elements dialog window appears and a single widely spaced linear element appears on the screen.

Note: The spans indicated in the dialog window are calculated from the selected perimeter.

d. Revise data in the dialog window to draw two girts spaced 6 feet apart and 6 feet from grade as follows:

(1) Set ORIENTATION to HORIZ.
(2) Fix the SPACING and set to 6.0 feet.

Note: Linear elements are placed by fixing the spacing or fixing the number of elements.

Note: A checkmark in front of a variable fixes that variable.

(3) Fix the BOTTOM OFFSET and set to 6.0 feet.

Note: If neither Offset is fixed, the elements are centered within the perimeter.

(4) Click on RECALC to redraw the girts at the new settings. The Number of Elements will be calculated as 2 and the Top Offset as 4.0 feet.

(5) Click on SAVE to fix the two girts.

5. Draw two girts on the long elevation without the door openings.

a. Return to the PERSPECTIVE (3D) view of the model.
b. Rotate the 3-D view to make the backside elevation visible.
c. Follow steps 3 and 4 above to insert two horizontal girts 15 feet long and spaced as the girts on the end elevation. Place the girts in the far right end bay.
D. Develop Components and Cladding wind loads on the 15-foot-long girt.

1. Switch to a PERSPECTIVE (3D) view of the model.

Note: It is necessary to be in the 3-D mode to calculate components and cladding wind loads.

2. Select LOADS AND DESIGN from the CASM menu bar.

   a. Verify the wind load criteria.
   b. Turn on COMPONENTS AND CLADDING.
   c. Revise OUTPUT FILE name as: GIRT.TXT.
   d. Click on OK to begin calculation of the "a" edge distances. A dialog window will appear to keep you informed of the progress. When finished, the 3-D model will display the "a" distances by dashed red lines. Handles will appear on the visible surfaces.

4. Select one of the handles on the plane which contains the two 15-foot-long girts. A 2-D elevation of the plane and a Tributary Area dialog window will appear.

5. Create the tributary area for the upper girt.
   a. Move the mouse pointer to a distance from the lower left corner of 9.0 feet vertically and 75.0 feet horizontally.
   b. Click the left mouse key to fix the lower right corner of the tributary area.
   c. Move the mouse pointer to dynamically expand the rectangle to 15 feet horizontally and 6 feet vertically.
   d. Click the left mouse key to fix the tributary area. A Wind Components and Cladding dialog window will appear.

   ![Wind Components & Cladding]

   Name: **Upper Girt**

   ![OK Cancel]

   e. Enter the name "Upper Girt" and click on OK. A blue hatched rectangle will denote the tributary area.
Note: Selection of CANCEL will not add the tributary area.

6. Double click the right mouse key to end creation of tributary areas. Wind load calculations are now performed for the component. A 3-D view of the wind load on the girt will appear when calculations are completed.

Note: The wind direction is set perpendicular to the plane that contains the component and is pointed to create a windward load.

E. Develop Components and Cladding wind loads for one fastener on the end elevation with the two girts.

1. Select WIND from the Loads pull-down menu.

2. Verify the information shown in the Wind Loads dialog window and change the OUTPUT FILE name to: FASTENER.TXT.

3. Click on OK when satisfied and "a" distance calculations begin. When completed, the "a" distances and handles will appear on the 3-D model.

4. Select one of the end elevation handles and a 2-D elevation will appear as will a Tributary Area dialog window.

5. Place a fastener tributary area with dimensions of 8 inches (0.67 foot) horizontally and 6 feet vertically with its lower left corner a distance of 4 inches (0.33 foot) from the left edge of the elevation and 3 feet up from grade.

Note: The actual tributary length is 8 inches, yet the prescribed minimum length is 2 feet for tributary area calculations on fasteners.
6. Select CANCEL from the Wind Components and Cladding dialog window to not add this incorrect tributary area. The drawn tributary area will be erased from the model.

7. Redo step 5 for a tributary area with dimensions 2 feet horizontally and 6 feet vertically using the same lower left corner location.

8. Name the component: FASTENER in the Wind Components and Cladding dialog window and select OK to add this desired tributary area. The area will become hatched on the 2-D elevation.

9. Double click the right mouse key to stop adding tributary areas. Wind load calculations are now performed for the component. A 3-D view of the wind load for the fastener will appear when calculations are completed.

   Note: The graphical depiction of the wind load on the girt is no longer shown since for this wind direction the girt is on a side wall. Side wall pressures and suction are not included in code requirements for consideration of wind on components and cladding.

F. Develop Components and Cladding wind loads for the door adjacent to the end elevation with the two girts.

1. Rotate the model to reveal the long elevation with the overhead doors.

   Note: The doors on that elevation will not appear on the 3-D model since it was not the last structural plane selected. The openings will appear when the component and cladding plane is selected.

2. Select WIND from the Loads pull-down menu.

3. Verify the information in the Wind Loads dialog window and change the OUTPUT FILE name to: DOOR.TXT.

4. Click on OK when satisfied and "a" distance calculations begin. When completed, the "a" distances and handles will appear on the 3-D model.

5. Select the elevation handle and a 2-D elevation will appear as will a Tributary Area dialog window.

6. Place a door tributary area with dimensions of 10 feet horizontally and 10 feet vertically with its lower left corner a distance of 2.5 feet from the left edge of the elevation and 0.0 foot vertically (at grade).

7. Name the component: DOOR in the Wind Components and Cladding dialog window and select OK to add this desired tributary area. The area will become hatched on the 2-D elevation.

8. Double click the right mouse key to stop adding tributary areas. Wind load calculations are now performed for the component. A 3-D view of the wind load for the door will appear when calculations are completed.

   Note: Because of the new wind direction, the girt’s tributary area wind suction is displayed on the leeward elevation. The fastener’s tributary area wind load is not displayed since it is now on a side wall which is parallel to the wind direction.

G. This completes drawing and calculation for component and cladding wind loads on all three components.
H. Manipulation of the building model and all of its wind loads.

1. Take a section cut to view the girt and door components and cladding wind values.

   Note: Presently, only vertical section cuts can be taken.

   a. Select various cursor positions to view wind magnitudes inside and outside of the "a" distance.
   b. Return to the 3-D model and rotate the model 180 degrees.
   c. Take another section cut to view the wind magnitudes on the girt and door, when the wind comes from the opposite direction.

Wind Load: Components & Cladding (psf)

2. Repeat step 1 for the fastener wind loads.

3. View the code-prescribed zonal areas for components and cladding.

   a. Return to a 3-D view of the model.
   b. Select SHOW LOADS from the Viewpoint Options pull-down menu. A Show Loads dialog window will appear.
   c. Turn on ZONE AREAS.
   d. Click on OK and the zone areas with their circled number will appear on the 3-D model. Red dashed lines separate the zone areas.

   Note: The numbers shown on the model and used in the output calculations correspond to the specific zones established in TM 5-809.
4. To rotate, pan, zoom, change from wireframe to solids, and perform other operations with the 3-D model:
   a. Follow steps D-1 through D-4 of Example 1 in the snow loads section.

I. Generation of hard copies.
   1. Print screen images of any of the wind load views desired.
      a. Follow step E-2 in Example 1 in the snow loads section.
   2. Review and print wind load calculations.
      a. Follow steps E-3 and E-4 of Example 1 in the snow loads section.
**GIRT.TXT Output File:**

Project: Industrial Building  
Location: Huntsville  
Design Load: Tri-Services  
Time: Wed Jan 24, 1990 11:55 PM

| Velocity Importance Exposure Width Length Roof Type Factor Perpendicular Parallel to Wind to Wind (mph) (ft) (ft) |
|---|---|---|---|---|---|
| 70.0 | 1.00 | C | 75.0 | 20.0 |

Distance to ocean line = 100 mi.  
h/d = 1.05 <= 5  
Height Kh qh GCpi (ft) (psf)

| Height <= 60 ft |
|---|---|---|
| 21.0 | 0.88 | 11.0 |

Height <= 60 ft  

<p>| Height &lt;= 60 ft |
|---|---|---|---|---|---|---|---|---|</p>
<table>
<thead>
<tr>
<th>Component/Cladding Pressures (psf)</th>
<th>Windward</th>
<th>Wall_s</th>
<th>Leeward</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tributary Zone</td>
<td>Zone 4</td>
<td>Zone 5</td>
<td>Zone 4</td>
</tr>
<tr>
<td>Area (sf)</td>
<td>middles corners</td>
<td>middles corners</td>
<td></td>
</tr>
<tr>
<td>Internal GCP</td>
<td>P</td>
<td>GCP</td>
<td>P</td>
</tr>
<tr>
<td>Upper Girt 90.0</td>
<td>1.18 15.7</td>
<td>1.18 15.7</td>
<td>-1.28 -22.3</td>
</tr>
<tr>
<td>a = 3.0 ft</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes for components and cladding:  
P = qh(GCp) - qh(GCpi)  
Internal pressures have been included in above values.  
* for roof overhangs: algebraically add this pressure to the above values.  
  \[ P = 0.8qh(GCp) \]
**FASTENER.TXT Output File:**

Project: Industrial Building  
Location: Huntsville  
Design Load: Tri-Services  
Time: Wed Jan 24, 1990 11:58 PM

************************ Wind Load - 1 ************************

Velocity Importance Exposure Width Length Roof Type
Factor Perpend. Parallel to Wind to Wind (mph) (ft) (ft)

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Importance</th>
<th>Exposure</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>20.0</td>
<td>75.0</td>
<td></td>
</tr>
</tbody>
</table>

Distance to ocean line=100 mi.  h/d = 1.05 <= 5

Height | Kh | qh | GCpi |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>21.0</td>
<td>0.88</td>
<td>11.0</td>
<td>-0.25</td>
</tr>
</tbody>
</table>

Height <= 60 ft

************************ Component/Cladding Pressures (psf) ************************

--- Walls ---

Tributary Zone 4 Zone 5 Zone 4 Zone 5
Area (sf) middles corners middles corners

<table>
<thead>
<tr>
<th>Internal</th>
<th>Fastener</th>
</tr>
</thead>
<tbody>
<tr>
<td>-2.8</td>
<td>12.0</td>
</tr>
<tr>
<td>-2.8</td>
<td>1.38</td>
</tr>
<tr>
<td>8.3</td>
<td>17.9</td>
</tr>
<tr>
<td>8.3</td>
<td>1.38</td>
</tr>
</tbody>
</table>

Notes for components and cladding:

- \( P = qh(GCp) - qh(GCpi) \)
- Internal pressures have been included in above values.
- * for roof overhangs: algebraically add this pressure to the above values. \( P = qh(GCp) = 0.8qh \)
- To comply with TM 5-809-1. Wall external pressures have not been reduced 10% per ANSI fig 3, note 3.

\( a = 3.0 \) ft
**DOOR.TXT Output File:**

<table>
<thead>
<tr>
<th>Project</th>
<th>Industrial Building</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Huntsville</td>
</tr>
<tr>
<td>Design Load</td>
<td>Tri-Services</td>
</tr>
<tr>
<td>Time</td>
<td>Thu Jan 25, 1990</td>
</tr>
</tbody>
</table>

Distance to ocean line=100 mi.  h/d = 1.05 <= 5

### Wind Load

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Importance</th>
<th>Exposure Factor</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
<th>Perpend. to Wind</th>
<th>Parallel to Wind</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>75.0</td>
<td>20.0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Height and Kh

<table>
<thead>
<tr>
<th>Height (ft)</th>
<th>Kh (psf)</th>
<th>qh (psf)</th>
<th>GCpi</th>
</tr>
</thead>
<tbody>
<tr>
<td>21.0</td>
<td>0.88</td>
<td>11.0</td>
<td>-0.25</td>
</tr>
</tbody>
</table>

Height <= 60 ft

### Component/Cladding Pressures (psf)

- **Walls**
  - **Tributary Zone 4**: Middles corners 8.3 8.3
  - **Zone 5**: middles corners -1.26 15.5 15.5
  - **Door**: 98.0 1.16 15.5 1.16 15.5

**Internal pressures have been included in above values.**

* for roof overhangs: algebraically add this pressure to the above values.  \( P = qh(GCp) = 0.8qh \)
# Unenclosed Buildings

**EXAMPLE ONE: One story - Monoslope roof**

**Given:** This one-story open-sided structure example is taken from page D-20 of TM 5-809-1. It is an open storage facility located at Hickman AFB, Honolulu, HI. The wind exposure category is D, and the importance category is I. An elevation and section are shown below:

**Required:** Determine the design roof wind force, F.

**Solution:**

An abbreviated discussion of input is given here since many of the steps repeat in a similar fashion to Example 1 in the Main Wind Force Resisting System section.

**A. Establish Criteria**

1. Input the following data into the **PROJECT, REGIONAL, and SITE CRITERIA** dialog windows:

   **PROJECT**
   - Project Name: Open Storage
   - City/Installation: Hickman AFB
   - State: HI
   - Design Load: Tri-Services

   **REGIONAL**
   - Basic Wind Speed: 80 mph
   - Coastal: no (leave blank)

   **SITE WIND**
   - Importance: Category I
   - Exposure: Category D
   - Distance to Oceanline: 100 miles (default)
B. Draw volumetric model

Note: The drawing of open structures involves the use of planes and columns rather than the cube and prism shapes used to create solid (enclosed) buildings.

1. Select DRAW MODEL from the CASM menu bar.

Note: There are many ways to construct this open structure; however, it is recommended to begin with the plane and add the columns as a second step.

2. Establish general layout requirements which are different than previously established.
   a. Use the following:
      
      SNAP INCREMENT : 6 inches  
      SNAP TO UNITS : on  
      SHOW GROUND PLANE : on  
      GROUND PLANE  
      WIDTH N-S : 100 feet  
      E-W : 100 feet  
      SPACING N-S : 20 feet  
      E-W : 20 feet  
      INITIAL OBJECT SIZE  
      N-S : 20 feet  
      E-W : 40 feet  
      HEIGHT : 25 feet  
      FLOOR THICKNESS : 6 inches  
      COL. THICKNESS : 6 inches  
      ORIENTATION : E-W  
      STACK ON GROUND PLANE : on  
      DIRECTIONS LOCKED : none  

   Note: The Initial Object Size Floor Thickness becomes the horizontal plane thickness and the E-W Width becomes the length of the roof. The Initial Object Size Height for the column is arbitrary, but it must be high enough to extend the columns through the horizontal (roof) plane.

3. Select HORIZONTAL PLANE from the Shapes pull-down menu. A horizontal plane will appear on the ground plane. A Dimensions dialog window will also appear.
   a. Hold down the right mouse key while dragging the mouse toward and away from you to elevate the plane a TRANSLATED DISTANCE vertically of 14.5 feet. Keep the N-S and E-W Translated Distances at 0.0 foot.

   Note: The N-S and E-W directions could have been locked under the Layout discussion to prevent the plane from translating in these two directions while elevating the plane.

   Note: The 14.5-foot vertical dimension is to the underside of the plane.
b. Click the left mouse key to fix the plane.
c. Double click the right mouse key to stop adding planes.

4. Rotate the plane 15 degrees.
a. Select **ROTATE** from the Edit pull-down menu. Handles appear at the centroid of all visible planes on the object.
b. Select one of the handles with the mouse pointer. The shape becomes highlighted and handles appear on the edges and on the centroidal axes of the shape about which the desired rotation can be selected.

**Oops!** Handles on the top and bottom edges, as well as the centroidal axes handles, overlap due to the view being quite distant.

Each dot represents a rotational possibility.

![Diagram of handles and rotational possibilities](image)

...-

Select

-...

c. Double click the right mouse key to cancel the Rotate command.
d. Zoom the plane toward you with by selection of **HEIGHT** and **DISTANCE** on the Viewpoint window. Strive for an approximate height of 25 feet and a distance of 40 feet. Also, rotate the view so you are looking almost straight at the long edge of the plane.

**Note:** Zoom and rotate incrementally (slowly) when using the single-screen option of CASM. Due to the slow graphic response of the VGA system, the graphic memory limits can be exceeded and you will get an error message.

e. Select **ROTATE** and one of the handles on the plane again. The shape becomes highlighted, and this time all the handles are visible.
f. Select the upper handle of the left side long dimension of the plane with the mouse pointer. All the handles will disappear, and a Rotate dialog window will appear.
g. Move the mouse left-right to rotate the plane about the selected edge. Rotate the plane counterclockwise to a -15.0-degree angle.
h. Click the left mouse key to fix the position of the plane. Handles will again appear for additional rotation operations.
i. Double click the right mouse key to exit the rotation command.
j. Adjust the view back in space to see the whole plane.

5. Insert a temporary cube to create the roof plane projected width of 20 feet.
a. Select **CUBE** from the Shapes pull-down menu. The shape appears on the screen at its Initial Object Size previously set in Layout.
b. Do not Translate the object. Translated Distance values in the Dimensions dialog window should remain at 0.0 foot.

c. Click the left mouse key to fix the cube.

Note: The cube will seem to disappear because the next shape falls directly on top of it.

d. Double click the right mouse key to exit the command. The cube will reappear.

6. Increase the width of the roof plane to facilitate slicing with the cube.

a. Select DRAG PLANE from the Edit pull-down menu. Handles will appear on the visible planes to drag.

Note: Each Plane shape is composed of six planes, four of which are its edges and two of which are surfaces.

b. Use the mouse pointer to select the handle which corresponds to the edge plane of the roof plane. The plane will be highlighted and the Dimensions dialog window will appear.

c. Move the mouse toward and away from you to Drag the plane beyond the extremity of the cube.

d. Click the left mouse key to fix the plane's position.

e. Double click the right mouse key to exit the command.

f. Rotate the view of the model to make the opposite side of the roof visible by use of the Viewpoint window.

g. Redo steps a through e to extend the roof plane beyond the extremity of the cube.

7. Slice the roof plane to the 20 foot-projected width.

a. Select SLICE OBJECT from the Edit pull-down menu. Handles will appear on the visible planes of each shape.

b. Select the shape to be sliced. Use the mouse pointer to select one of the roof plane handles. The shape will become highlighted.

c. Select the plane to do the slicing. Use the mouse pointer to select the long vertical plane on the cube. The selected plane is highlighted and the shape is sliced into two parts. New handles appear for another object to be sliced.

d. Double click the right mouse key to exit the Slice command.
e. Rotate the model to view the opposite side of the roof plane by use of the Viewpoint window.
f. Redo steps a through d to slice the roof plane on this side.

8. Delete the unwanted parts of the sliced roof plane.
   a. Select DELETE OBJECT from the Edit pull-down menu. Handles will appear on the visible planes of the shapes and the sliced parts.
   b. Use the mouse pointer to select one of the handles on one of the unwanted sliced parts. The part will be deleted.
   c. Select the other unwanted sliced part of the roof plane.
   d. Select a handle on the cube since it is no longer needed.
   e. Double click the right mouse key to exit the Delete command.

9. Insert the first column in the geometric model.

   Note: The columns are not required for the wind analysis of an open structure in the CASM program. They are drawn here for graphical completeness and to illustrate the required column modeling commands.

   a. Insert the column shape.
      (1) Select COLUMN from the Shapes pull-down menu. A column appears on the ground plane to the proportions set in layout, and a Dimensions dialog window will appear.
      (2) Position the first column somewhere in the southwest corner of the roof plane.
      (3) Click the left mouse key to insert the column.
      (4) Double click the right mouse key to exit the Column command.
   b. Select the vertices between which measurements are to be taken to locate the position of the column.
      (1) Select TAPE MEASURE from the Edit pull-down menu to accurately locate the column with respect to the roof plane.
      (2) Select a southwest corner vertex of the roof plane with the mouse pointer. A red dot will appear to highlight the vertex.
Note: The vertex selected is the one closest to the point of the mouse pointer or the center of the cross hairs.

(3) Select the southwest corner vertex of the column (top or bottom) by clicking the left mouse key when satisfied. The selected vertex is highlighted, a dotted red line will connect the two selected vertices, and a Measure dialog window will appear. The values therein represent the relationship between the two vertices.

Note: There are four vertices at each end of the column, not just one.

Note: Switch to the 2-D Plan view to verify that the correct column vertex has been selected and then switch back to the 3-D view.

c. Select DEFINE UNITS and set the SNAP_INCREMENT to 3 inches.
d. Move the column to its correct location.
   (1) Select MOVE OBJECT from the Edit pull-down menu and handles will appear on the visible planes of the shapes.
   (2) Use the mouse pointer to select a handle on the column. The column will be highlighted.
   (3) Move the mouse to drag the column to a position N-S of 2.5 feet and E-W of 2.5 feet.

Note: Watch the dynamic change in values within the Measure dialog window, rather than be fooled by the position of the column in the perspective view.

(4) Click the left mouse key to fix the column location.
(5) Double click the right mouse key to exit the Move command.

e. Select CANCEL from the Measure dialog window to stop measuring between the two vertices.

10. Duplicate the first inserted column at the northwest corner of the roof.

a. Select DUPLICATE from the Edit pull-down menu. A Duplicate dialog window will appear.
b. Enter the following data:
   
<table>
<thead>
<tr>
<th>N-S DIRECTION</th>
<th>E-W DIRECTION</th>
<th>VERTICAL</th>
<th>N-S SPACE</th>
<th>E-W SPACE</th>
<th>VERTICAL SPACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>14.0 feet</td>
<td>0.0 feet</td>
<td>0.0 feet</td>
</tr>
</tbody>
</table>

c. Click on OK and handles will appear on the visible surfaces of the shapes.
d. Select one handle on the column. The shape will be duplicated one time 14 feet away.
e. Double click the right mouse key to exit the Duplicate command.
11. Slice the two columns with the bottom surface of the roof plane.
   a. Rotate the view of the model to a worm’s eye perspective looking up at
      the underside of the roof plane.

   **Note:** It is possible to verify the wireframe view by switching to the solid
   view, if on a dual monitor station.

   b. Select `SLICE OBJECT` from the Edit pull-down menu. Handles will ap-
      pear on the visible surfaces of the shapes.
   c. Select the column shape to be sliced with the mouse pointer. The column
      will be highlighted.
   d. Select the bottom surface of the roof plane to slice the column with the
      mouse pointer. The plane is highlighted and the column is sliced into two
      parts.
   e. Select the other column to be sliced. It will be highlighted.
   f. Select the bottom surface of the roof plane. The plane will be highlighted
      and the column will be sliced into two parts.
   g. Double click the right mouse key to exit the Slice command.

12. DELETE the two unwanted upper parts of the two columns.

13. Duplicate the remaining six columns.
   a. Select `DUPLICATE` from the Edit pull-down menu. A Duplicate dialog
      window will appear.
   b. Enter the following data:
      
      | Parameter     | Value     |
      |---------------|-----------|
      | N-S DIRECTION | 0         |
      | E-W DIRECTION | 3         |
      | VERTICAL      | 0         |
      | N-S SPACE     | 0.0 feet  |
      | E-W SPACE     | 11.0 feet |
      | VERTICAL SPACE| 0.0 feet  |
   c. Click on `OK` and handles will appear on the visible surfaces of the shapes.
   d. Select a handle on one of the columns. The shape will be duplicated three
      times and spaced 11 feet apart.
   e. Select the handle on the other column and it will be duplicated three
      times and spaced 11 feet apart.
   f. Double click the right mouse key to exit the Duplicate command.

14. This completes creation of the model.
C. Develop the open structure wind forces on the shed roof.

1. Select LOADS AND DESIGN from the CASM menu bar.

   Note: A 3-D view must appear on the screen to be able to calculate open roof wind loads.


3. Verify values in the Wind Loads dialog window and turn on OPEN ROOF. Modify any values as desired.

4. Click on OK for CASM to begin finding the Open Roof planes. Handles will appear on the open planes found.

5. Use the mouse pointer to select the roof plane to receive wind loads. Wind calculations are then performed on the open plane. A 3-D depiction of the wind load will appear on the model when calculations are completed.

   Note: You must position the 3-D view of the model to see the top surface of the roof in order to activate the wind load calculations.

D. Manipulation of the building model and its wind loads.

1. Follow steps D-1 through D-4 from Example 1 in the main wind force resistance system wind examples and steps D-1 through D-4 from Example 1 in the snow load section.

Wind Load: Open Roof (psf)
E. Generation of hard copies.

1. Follow steps E-1 and E-2 of Example 1 in the snow load section to print a screen image.

2. Review and print the wind load calculations.
   a. Follow steps E-3 and E-4 of Example 1 in the snow load section.

---

Project: Open Storage
Location: Hickman AFB
Design Load: Tri-Services
Time: Sun Jan 21, 1990 10:07 PM

---

Wind Load - 3

<table>
<thead>
<tr>
<th>Velocity Importance</th>
<th>Exposure</th>
<th>Perpendicular to Wind</th>
<th>Parallel to Wind</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>(mph)</td>
<td>(ft)</td>
<td>(ft)</td>
<td></td>
<td>(ft)</td>
</tr>
<tr>
<td>80.0</td>
<td>1.00</td>
<td>D</td>
<td>40.0</td>
<td>20.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flat/Monoslope</td>
<td></td>
<td>3.22</td>
</tr>
</tbody>
</table>

Distance to ocean line = 100 mi.

---

Open Roof Pressures (psf)

\[
q_z = 0.00256 \times K_z \times (I \times V) \times (I \times V) = 20.30 \text{ psf}
\]

\[
A_f = \frac{L}{\cos(\theta)} \times B = 828.2 \text{ sqft}
\]

\[
C_f = 1.10
\]

\[
X/L = 0.40
\]

\[
\theta + 10 \text{ deg} = 25.0 \text{ deg}
\]

Pressure on top of roof

\[
X = 8.00 \text{ ft from low eave}
\]

\[
F = q_z \times G_h \times C_f \times A_f = 21.30 \text{ k}
\]

\[
P_1(\text{leeward edge}) = \left[ \frac{2 \times F \times \cos(\theta)}{B \times L} \right] \times 3 \times X/L - 1 = 10.30 \text{ psf}
\]

\[
P_2(\text{windward edge}) = \left[ \frac{2 \times F \times \cos(\theta)}{B \times L} \right] \times [2 - 3 \times X/L] = 41.10 \text{ psf}
\]

Notes for open roof pressures:

Positive pressures act toward surfaces.

---

F. Save the building model with its wind loads applied for future reference.

1. Follow the steps in part F of Example 1 in the snow load section.
EXAMPLE TWO: One story - Open gable roof

Given: The one story open-gabled roof carport shown below. It is located at the Chanute AFB in Rantoul, IL. The importance category is I and the exposure category is C.

Required: Determine the design wind pressures on the roof.

Solution:

The minimum recommended exterior force coefficients for such an open gabled roof are extracted from NAVFAC DM 2.2, STRUCTURAL ENGINEERING LOADS, DESIGN MANUAL 2.2, NOVEMBER 1981, and referenced in TM 5-809-1 on page 5-12. These recommended coefficients are not included in ANSI A58.1-1982.

A. Establish Criteria.

1. Input the following data into the PROJECT, REGIONAL, and SITE Criteria dialog windows:

   PROJECT: Project Name : Carport
              City/Installation : Chanute AFB - Rantoul
              State : IL
              Design Load : Tri-Services

   REGIONAL: Basic Wind Speed : 70 mph
              Coastal : No

   SITE WIND: Importance : Category I
                  Exposure : Category C
                  Distance to Oceanline : 100 mile

B. Draw volumetric model

1. Select DRAW MODEL from the CASM menu bar.
2. Establish general layout requirements which are different than previously established.
   a. Use the following:
SNAP INCREMENT: 3 inches
SNAP TO UNITS: on
SHOW GROUND PLANE: on
GROUND PLANE:

<table>
<thead>
<tr>
<th>WIDTH</th>
<th>N-S</th>
<th>100 feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-W</td>
<td>100 feet</td>
<td></td>
</tr>
<tr>
<td>SPACING</td>
<td>N-S</td>
<td>20 feet</td>
</tr>
<tr>
<td>E-W</td>
<td>20 feet</td>
<td></td>
</tr>
</tbody>
</table>

INITIAL OBJECT SIZE:

<table>
<thead>
<tr>
<th></th>
<th>N-S</th>
<th></th>
<th></th>
<th>E-W</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>N-S</td>
<td>10 feet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E-W</td>
<td>68 feet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HEIGHT: 20 feet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLOOR THICKNESS: 6 inches</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COL. THICKNESS: 6 inches</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORIENTATION: E-W</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

STACK ON GROUND PLANE: on
DIRECTIONS LOCKED: none

3. Select **HORIZONTAL PLANE** from the Shapes pull-down menu. A horizontal plane will appear on the ground plane. A Dimensions dialog window will also appear.

   a. Hold down the right mouse key while dragging the mouse toward and away from you to elevate the plane a **TRANSLATED DISTANCE** vertically of 7.5 feet, N-S distance of -5.0 feet, and an E-W distance of 0.0 feet.

   **Note:** The vertical dimension is to the underside of the plane.

   b. Click the left mouse key to fix the plane. A second plane will appear on the ground plane ready for positioning next to the first plane.

   c. Hold down the right mouse key while dragging the mouse toward and away from you to elevate the second plane a **TRANSLATED DISTANCE** vertically of 7.5 feet, N-S distance of 5.0 feet, and an E-W distance of 0.0 foot.

   d. Click the left mouse key to fix the plane.

   e. Double click the right mouse key to stop adding planes.

4. Drag the common edges of the two planes to create the ridge for the roof with a slope of 3 in 12.

   **Note:** It is necessary to drag the top and bottom edge of each plane; thus, four edges will be elevated to create the ridge of the roof.

   a. **LOCK** the N-S and E-W directions.

   b. Hide the plane closest to you.

   **Note:** This enables viewing one plane's edges at a time.

   (1) Select **HIDE OBJECT** from the Options pull-down menu located in the Viewpoint window. Handles will appear on the visible planes of each shape.
(2) Select one of the handles on the shape closest to you and the shape will be hidden. Handles will appear on the remaining shapes to permit more shapes to be hidden.

(3) Double click on the right mouse key to exit the Hide Object command.

C. Activate the Tape measure command.
   1. Select TAPE MEASURE from the Edit pull-down menu.
   2. Use the mouse pointer to select the two top vertices along the short edge of the plane. Red dots will appear at the two vertices and a Measure dialog window will also appear.

D. Drag the two common edges of the horizontal plane.
   1. Zoom in on the view of the plane to space the edges farther apart so each edge handle will be visible.
   2. Select DRAG EDGE from the Edit pull-down menu. Handles appear on the visible edges to drag.

   Note: If both the top and bottom edge handles do not appear, it will be necessary to cancel the command and repeat step 1 to further separate the edges.

   3. Select the top edge with the mouse pointer. The edge will be highlighted.
   4. Hold down the right mouse key while dragging the mouse toward and away from you to elevate the edge to a roof slope of 3 in 12. The slope is dynamically adjusted in the Measure window as the mouse is moved. The translated vertical distance is shown in the Dimensions and Measure windows as 2.5 feet.
   5. Click the left mouse button to fix the edge.
   6. Select the bottom edge of the plane and drag it to a translated vertical distance of 2.5 feet as displayed in the Dimensions window.

   Note: None of the values in the Measure window will change, since they apply to the already elevated edge.

   7. Click the left mouse key to fix the bottom edge.
   8. Double click the right mouse key to exit the Drag Edge command.
   9. Select CANCEL on the Measure window to stop measuring between the two vertices.
   10. Select SHOW OBJECT from the Options pull-down menu to have the hidden objects reappear.
   11. Rotate the view of the model so the plane containing the remaining ridge edges is visible.
   12. Use the DRAG EDGE command to elevate these edges 2.5 feet vertically (a slope of 3 in 12).

E. Insert the first column in the geometric model.
1. Insert the first column shape.
   a. Select **COLUMN** from the Shapes pull-down menu. A column appears on the ground plane to the proportions set in layout, and a Dimensions dialog window will appear.
   b. Position the first column somewhere in the southwest corner of the gable roof.
   c. Click the left mouse key to insert the column.
   d. Double click the right mouse key to exit the Column command.

2. Select the vertices between which measurements are to be taken to locate the position of the column.
   a. Select **TAPE MEASURE** from the Edit pull-down menu to accurately locate the column with respect to the roof plane.
   b. Select a southwest corner vertex of the roof plane with the mouse pointer. A red dot will appear to highlight the vertex.

   **Note:** The vertex selected is the one closest to the point of the mouse pointer or the center of the cross hairs.

   c. Select the southwest corner vertex of the column by clicking the left mouse key when satisfied. The selected vertex is highlighted, a dotted red line will connect the two selected vertices, and a Measure dialog window will appear. The values therein represent the relationship between the two vertices.

   **Note:** There are four vertices at each end of the column, not just one.

   **Note:** Switch to the 2-D plan view to verify that the correct column vertex has been selected, and then switch back to the 3-D view.

3. Move the column to its correct location.
   a. Select **MOVE OBJECT** from the Edit pull-down menu and handles will appear on the visible planes of the shapes.
   b. Use the mouse pointer to select a handle on the column. The column will be highlighted.
   c. Move the mouse to drag the column to a position N-S of 0.0 foot and E-W of 0.0 foot.

   **Note:** Watch the dynamic change in values within the Measure dialog window, rather than be fooled by the position of the column in the perspective view.

   d. Click the left mouse key to fix the column location.
   e. Double click the right mouse key to exit the Move command.

4. Select **CANCEL** from the Measure dialog window to stop measuring between the two vertices.
5. Duplicate the first inserted column at the northwest corner of the roof.
   a. Select **DUPLICATE** from the Edit pull-down menu. A Duplicate dialog window will appear.
   b. Enter the following data:
      - N-S DIRECTION : 1
      - E-W DIRECTION : 0
      - VERTICAL : 0
      - N-S SPACE : 19.0 feet
      - E-W SPACE : 0.0 feet
      - VERTICAL SPACE : 0.0 feet

   **Note:** The Space values represent clear distances, not centerline distances.
   c. Click on **OK** and handles will appear on the visible surfaces of the shapes.
   d. Select one handle on the column. The shape will be duplicated one time 19 feet away.
   e. Double click the right mouse key to exit the Duplicate command.

6. Slice the two columns with the bottom surfaces of the roof planes.
   a. Rotate the view of the model to a worm's eye perspective looking up at the underside of both roof planes.

   **Note:** It is possible to verify the wireframe view by switching to the solid view, if on a dual-monitor station.
   b. Select **SLICE OBJECT** from the Edit pull-down menu. Handles will appear on the visible surfaces of the shapes.
   c. Select the column shape to be sliced with the mouse pointer. The column will be highlighted.
   d. Select the bottom surface of the roof plane that intersects the column to slice the column with the mouse pointer. The plane is highlighted and the column is sliced into two parts.
   e. Select the other column to be sliced. It will be highlighted.
   f. Select the bottom surface of the other roof plane. The plane will be highlighted, and the column will be sliced into two parts.
   g. Double click the right mouse key to exit the Slice command.

7. **DELETE** the two unwanted upper parts of the two columns.

8. Duplicate the remaining eight columns.
   a. Select **DUPLICATE** from the Edit pull-down menu. A Duplicate dialog window will appear.
   b. Enter the following data:
WIND LOADS

N-S DIRECTION : 0
E-W DIRECTION : 4
VERTICAL : 0
N-S SPACE : 0.0 feet
E-W SPACE : 16.375 feet
VERTICAL SPACE : 0.0 feet

c. Click on OK and handles will appear on the visible surfaces of the shapes.
d. Select a handle on one of the columns. The shape will be duplicated four times and spaced 16.375 feet apart.
e. Select the handle on the other column and it will be duplicated four times, spaced 16.375 feet apart.
f. Double click the right mouse key to exit the Duplicate command.

9. This completes creation of the model.

F. Develop the open structure wind forces on the gable roof.

1. Select LOADS AND DESIGN from the CASM menu bar.

Note: A 3-D view must appear on the screen to be able to calculate open roof wind loads.


3. Verify values in the Wind Loads dialog window and turn on OPEN ROOF. Modify any values as desired.

4. Click on OK for CASM to begin finding the Open Roof planes. Handles will appear on the open planes found.

5. Use the mouse pointer to select one of the gable roof planes to receive wind loads. Wind calculations are then performed on both open gable planes. A 3-D depiction of the wind load will appear on the model when calculations are completed.
G. Manipulation of the building model and its wind loads.
   1. Follow steps D-1 through D-4 from Example 1 in the main wind force resistance system wind examples and steps D-1 through D-4 from Example 1 in the snow load section.

Wind Load: Open Roof (psf)

H. Generation of hard copies.
   1. Follow steps E-1 and E-2 of Example 1 in the snow load section to print a screen image.
   2. Review and print the wind load calculations.
      a. Follow steps E-3 and E-4 of Example 1 in the snow load section.
Project: Carport  
Location: Chanute AFB - Rantoul  
Design Load: Tri-Services  
Time: Sun Jan 21, 1990 11:11 PM

************** Wind Load - 3 **************

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Importance</th>
<th>Exposure</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>(mph)</td>
<td>Factor</td>
<td>Perpend.</td>
<td>Parallel</td>
<td>to Wind</td>
<td>to Wind</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>----------</td>
<td>----------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>68.0</td>
<td>10.0</td>
<td>Gable</td>
</tr>
</tbody>
</table>

Distance to ocean line = 100 mi.
Lee: 3.00 in 12

**Open Roof Pressures (psf) ********************

\[
z = h = 9.25 \text{ ft} \\
Gh = 1.32 \\
Kz = 0.80 \\
qz = 0.00256 * Kz * (I^*V)^*(I^*V) = 10.00 \text{ psf} \\
Af = \left[ \frac{L}{\cos(\theta)} \right] * B = 700.8 \text{ sq ft} \\
\theta = 14.0 \text{ deg} 30 \text{ deg} \\
Cf = 0.6 \\
F = qz * Gh * Cf * Af \\
\]

| Windward F = | 5.55 k |
| Leeward F =   | -5.55 k |

\[
X = 0.5 * L = 5.00 \text{ ft} \\
w = F / Af \\
\]

| Windward w = | 7.92 psf |
| Leeward w =   | -7.92 psf |

Notes for open roof pressures:
Positive pressures act toward surfaces.

I. Save the building model with its wind loads applied for future reference.
   1. Follow the steps in part F of Example 1 in the snow load section.
EXAMPLE THREE: One story - Open arched roof

Given: The one-story open arched roof carport shown below. All criteria are the same as Example 2.

Required: Determine the design wind pressures on the roof.

Solution: The source for exterior force coefficients is the same as Example 2.

A. Establish Criteria.
   1. Use the same Criteria as in Example 2 in this section.

B. Draw volumetric model.
   1. Select DRAW MODEL from the CASM menu bar.
   2. Establish general layout requirements which are different than previously established.
      a. Use the following:
         - SNAP INCREMENT: 3 inches
         - SNAP TO UNITS: on
         - SHOW GROUND PLANE: on
         - GROUND PLANE
           - WIDTH N-S: 100 feet
           - E-W: 100 feet
         - SPACING N-S: 20 feet
         - E-W: 20 feet
         - INITIAL OBJECT SIZE
           - N-S: 20 feet
           - E-W: 68 feet
           - HEIGHT: 5 feet
           - FLOOR THICKNESS: 6 inches
           - COL. THICKNESS: 6 inches
           - ORIENTATION: E-W
           - STACK ON GROUND PLANE: on
           - DIRECTIONS LOCKED: none

   >> Note: Height refers to the crown height of the arch for this example.

   3. Select OPEN BARREL VAULT from the Shapes pull-down menu. An open barrel vault will appear on the ground plane, and a Dimensions dialog window will also appear.
WIND LOADS

4. Insert the first column in the geometric model.
   a. Change the INITIAL OBJECT SIZE to reflect the column height of 8.0 feet and click on OK.
   b. Select COLUMN from the Shapes pull-down menu and place the column in the southwest corner of the roof shape.
   c. Use TAPE MEASURE to select the two vertices between which measurements are to be taken to locate the position of the column.

   Note: Switch to the 2-D plan view to verify that the correct vertices on the roof and column have been selected, and then switch back to the 3-D view.

   d. Use MOVE OBJECT to place the column directly under the southwest corner of the roof form. The N-S and E-W distances in the Measure dialog window should be 0.0 foot.
   e. CANCEL measuring distances between the two distances set with Tape Measure.

5. Duplicate the remaining columns.
   a. Select DUPLICATE from the Edit pull-down menu. A Duplicate dialog window will appear.
   b. Enter the following data:
      
      N-S DIRECTION : 1
      E-W DIRECTION : 4
      VERTICAL : 0
      N-S SPACE : 19.0 feet
      E-W SPACE : 16.375 feet
      VERTICAL SPACE : 0.0 feet

   c. Click on OK and handles will appear on the visible surfaces of the shapes.
   d. Select a handle on the column. The shape will be duplicated nine times, spaced at 16.375 feet apart in the E-W direction and 19.0 feet in the N-S direction.
   e. Double click the right mouse key to exit the Duplicate command.

6. This completes creation of the model.
C. Develop the open structure wind forces on the open barrel vault roof.
   1. Select LOADS AND DESIGN from the CASM menu bar.
   
   Note: A 3-D view must appear on the screen to be able to calculate open roof wind loads.
   3. Verify values in the Wind Loads dialog window and turn on OPEN ROOF. Modify any values as desired.
   4. Click on OK for CASM to begin finding the Open Roof planes. Handles will appear on the open planes found.
   5. Use the mouse pointer to select one of the planes of the polygonal construction of the barrel roof to receive wind loads. Wind calculations are then performed on all of the planes comprising the barrel vault. A 3-D depiction of the wind load will appear on the model when calculations are completed.

D. Manipulation of the building model and its wind loads.
   1. Follow steps D-1 through D-4 from Example 1 in the main wind force resistance system wind examples and steps D-1 through D-4 from Example 1 in the snow load section.
   
   Note: Analysis has been performed for a 90- and a 60-degree wind angle. Use SHOW LOADS to display each wind load case.
E. Generation of hard copies.

1. Follow steps E-1 and E-2 of Example 1 in the snow load section to print a screen image.
2. Review and print the wind load calculations.
   a. Follow steps E-3 and E-4 of Example 1 in the snow load section.
**Load: Carport**
**Location:** Chanute AFB - Rantoul
**Design Load:** Tri-Services
**Time:** Sun Jan 21, 1990 11:35 PM

************ Wind Load - 3 ************

<table>
<thead>
<tr>
<th>Velocity Importance</th>
<th>Exposure</th>
<th>Factor</th>
<th>Perpnd. Parallel to Wind</th>
<th>to Wind (mph)</th>
<th>(ft)</th>
<th>(ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>68.0</td>
</tr>
</tbody>
</table>

Distance to ocean line = 100 mi.

************ Open Roof Pressures (psf) ************

\[
z = h = 10.50 \text{ ft}
\]
\[
Gh = 1.32
\]
\[
Kz = 0.80
\]
\[
g_z = 0.00256 \times K_z \times (I^*V) \times (I^*V) = 10.00 \text{ psf}
\]
\[
f/L = 0.25
\]
\[
Af = 788.20 \text{ sqft}
\]

90 deg wind

Windward half \( Cf = +0.08 \)

Leeeward half \( Cf = -0.58 \)

\[
F = g_z \times Gh \times Cf \times Af
\]

\[
\begin{align*}
\text{Windward F} &= 0.83 \text{ k} \\
\text{Leeward F} &= -6.03 \text{ k}
\end{align*}
\]

\[
w = F/Af
\]

\[
\begin{align*}
\text{Windward w} &= 1.06 \text{ psf} \\
\text{Leeward w} &= -7.66 \text{ psf}
\end{align*}
\]

60 deg wind

Windward half \( Cf = -0.01 \)

Leeeward half \( Cf = -1.04 \)

\[
\begin{align*}
\text{Windward F} &= -0.10 \text{ k} \\
\text{Leeward F} &= -10.82 \text{ k}
\end{align*}
\]

\[
w = F/Af
\]

\[
\begin{align*}
\text{Windward w} &= -0.13 \text{ psf} \\
\text{Leeward w} &= -13.73 \text{ psf}
\end{align*}
\]

Notes for open roof pressures:
Positive pressures act toward surfaces.

**F. Save the building model with its wind loads applied for future reference.**

1. Follow the steps in part F of Example 1 in the snow load section.
DEAD LOADS

This section describes the technique that CASM employs to generate dead loads for floor, roof, ceiling, and wall assemblies you may design. SNOW and WIND load design, as you have already seen, is dependent on data input into the three CRITERIA windows. The DEAD LOADS program, however, is independent of the CRITERIA menu and its associated pop-up dialog windows. A volumetric model does not need to be drawn to create dead load assemblies.

Select LOADS AND DESIGN to bring up the Loads and Design Tool Palette. You may then proceed to LOADS on the Loads and Design menu bar and scroll down to ROOF (DL), FLOOR (DL), CEILING (DL), or WALL (DL). The other option is to select either of the four respective icons from the Loads and Design Tool Palette.

Regardless of the option preferred, click the left mouse key on the desired Dead Load and highlight it. The accompanying pop-up dialog window will appear, and you are ready to develop the material weights for the assembly. Many system assemblies can be generated for a given project. They can be stored and retrieved as needed. The following examples will take you step by step through dead load calculations for wood, steel, and concrete floor and roof assemblies.

Floor Assemblies

EXAMPLE ONE: Open web steel joist framing

Given: The floor assembly shown:

1/2" quarry tile
partitions (min. int'l stud)
normal weight concrete
20 ga deck (composite)
32' span joists @ 2'-0" o.c.
mechanical & electrical
suspended ceiling (channels & tile)
**Required**: Calculate the total assembly dead load and save as ENTRY-TYPE 1

**Solution**:  

1. Select LOADS from the top menu bar and scroll to FLOOR (DL) or select the FLOOR (DL) ICON from the tool palette. A FLOOR (DL) pop-up dialog window will appear.

2. Type 'Entry-Type 1' over the highlighted current name.

3. Input the assembly materials.
   a. Move the mouse pointer to a required 'Type' box.
   b. Click the left mouse key and a pop-up dialog window will appear showing a list of possible materials.

   ![FLOOR (DL) pop-up dialog window]

   - **Name**: Entry-Type 1
   - **Type**: [Select desired material]
   - **psf**: [Weight of the selected material]

   c. Scroll the pop-up dialog window list for the desired material.
   d. Place the mouse pointer on that material and click the left mouse key to highlight your choice.
   e. Click on **OK**. Your material choice and its corresponding weight will appear in the 'Type' box and 'psf' box. The 'Total' box will automatically sum the weights of all current choices.

   **Note**: An alternate approach is to select the material by double clicking on the highlighted material. This avoids having to also click on **OK**.

f. Complete the filling in of all 'Type' boxes as follows:
Upon completion of all entries a total weight of 53.3 psf will exist in the 'total' box. You can edit or change any item in a 'type' or 'psf' box, as described in the REFERENCE chapter of the Reference Manual. The FLOOR (DL) window should look as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition</td>
<td>0 - 50 PLF</td>
<td>0.0</td>
</tr>
<tr>
<td>Finish</td>
<td>Quarry Tile 1/2&quot;</td>
<td>5.0</td>
</tr>
<tr>
<td>Deck</td>
<td>MTL DK 1.5/ NLWT 2.5</td>
<td>36.0</td>
</tr>
<tr>
<td>Structure</td>
<td>Steel bar jst 32'@ 2'</td>
<td>4.5</td>
</tr>
<tr>
<td>Mechanical</td>
<td>Mech a/c ducts (3 psf)</td>
<td>3.0</td>
</tr>
<tr>
<td>Electrical</td>
<td>Elect/ Lighting (2 psf)</td>
<td>2.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td>none required</td>
<td>0.0</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Susp. Chnl/ Tile</td>
<td>2.0</td>
</tr>
<tr>
<td><strong>Total:</strong></td>
<td></td>
<td>53.3</td>
</tr>
</tbody>
</table>

4. Select **SAVE** with the mouse pointer and click on the left mouse key. This saves what currently exists in the window and permits you to prepare another window of data. To save all windows related to the current project under one filename, consult either the **REFERENCE** or **OVERVIEW** chapters of the Reference Manual for the File Save or File Save As commands.

5. Select **ASSIGN** to place the current floor DL shown in the window on a floor plane in the building model. The next chapter will perform this operation.

6. Click on **NEXT** if you want to review already saved FLOOR (DL) assemblies.

7. Select **STOP** if you completed entering floor assemblies to return to the CASM program window. You may continue with another assembly after saving the current assembly.

8. All the assemblies will be printed at the end of this section.
EXAMPLE TWO: Cast-in-place concrete pan joist

Given:  The floor assembly shown:

![Diagram of floor assembly]

- 25/32 Maple Floor on Sleepers
- NLWT Concrete
- Indirect Lighting (2.5 ft)

Required:  Develop the total dead weight of the given assembly and name it GYM-Type 2.

Solution:

This example proceeds the same as Example 1, except none of the components exist in the materials database, and you must create them.

1. Repeat step 1 of Example 1. The last entered assembly will appear on the FLOOR (DL) pop-up dialog window.
2. Type over the present NAME and enter: GYM-TYPE 2.
3. Delete the PARTITION 'TYPE' and 'PSF'.
   a. Place the vertical line cursor anywhere in the 'TYPE' box and click the left mouse key. The pop-up dialog window of materials will appear.
   b. Select CANCEL and the flashing vertical line cursor will appear after the last letter in the box.
   c. Use the backspace key to delete the current text.
   d. Press and hold the left mouse key after positioning the vertical line cursor after the last digit in the 'PSF' box and drag the vertical line over the existing digits to highlight them.
   e. Type in 0.0. The highlighted value will be replaced with 0.0.
4. Replace the FINISH material and weight with 1" hardwood.
5. Repeat step 3 for DECK to clear the 'TYPE' box and place 0.0 in the 'PSF' box.
6. Replace the STRUCTURE material and weight with the concrete pan joist proportions given. Scrolling the choices in the pop-up dialog window reveals that the closest choice is Conc Pan 12+ 3x5x20 weighing 74.0 psf. Select it and edit the 'TYPE' and 'PSF' boxes to read: CONC PAN 12+ 3x6x20 weighing 78 psf. An alternate approach would have been to...
click on CANCEL and merely write in the entire description of the item and its new weight.

7. Delete MECHANICAL 'TYPE' description and place 0.0 in the 'PSF' box as in step 3.

8. Leave the ELECTRICAL boxes as they are.

9. Delete CEILING 'TYPE' description and place 0.0 in the 'PSF' box as in step 3. The new assembly FLOOR (DL) window will look as follows:

10. Select SAVE to store the assembly.

11. Select ASSIGN to place the current floor DL shown in the window on a floor plane in the building model. The next chapter will perform this operation.

12. Select NEXT to review all the saved FLOOR (DL) assemblies for your project.

13. Edit either assembly, or select STOP to end the development of floor dead load types. This clears the CASM program window. The hard copy will be printed at the end of this section.
**Roof Assemblies**

**EXAMPLE ONE: Wood rafter framing**

*Given:* The wood framing section shown:

- Concrete Shingles
- 1/2" OSB Sheathing
- 12" Batt Insul. (fiberglass)
- 2x12 @ 16" o.c.
- 1" Cedar Lap-siding

*Required:* Calculate the system dead weight and save as HOUSE-TYPE 1.

*Solution:*

It is assumed that you now have an understanding of the process and it is assumed that you can bring up the ROOF (DL) pop-up dialog window and enter the new name.

1. Enter the following 'TYPE' and 'PSF' items:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>PSF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roofing</td>
<td>Concrete shingles</td>
<td>9.5</td>
</tr>
<tr>
<td>Deck</td>
<td>CSB &amp; Waferbrd 1/2&quot;</td>
<td>1.7</td>
</tr>
<tr>
<td>Structure</td>
<td>2x12 @ 16&quot;</td>
<td>3.2</td>
</tr>
<tr>
<td>Insulation</td>
<td>Fiberglass batt 12&quot;</td>
<td>3.6</td>
</tr>
</tbody>
</table>

2. Scroll the ceiling choices and select CANCEL since cedar lap siding is not listed. Type in the material and its 2.0 psf weight.

3. Select SAVE to store the assembly. The completed dialog window looks as follows:
DEAD LOADS

**Table: Roof (DL)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roofing</td>
<td>Concrete Shingles</td>
<td>9.5</td>
</tr>
<tr>
<td>Deck</td>
<td>OSB &amp; Waferbrd 1/2&quot;</td>
<td>1.7</td>
</tr>
<tr>
<td>Structure</td>
<td>Wood 2x12 @ 16</td>
<td>3.2</td>
</tr>
<tr>
<td>Mechanical</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Electrical</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Insulation</td>
<td>Fiberglass Batt 12&quot;</td>
<td>3.6</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Cedar Lap Siding</td>
<td>2.0</td>
</tr>
<tr>
<td><strong>Total:</strong></td>
<td></td>
<td><strong>20.0</strong></td>
</tr>
</tbody>
</table>

4. Select ASSIGN to place the current roof DL shown in the window on a floor plane in the building model. The next chapter will perform this operation.

5. The total weight of this assemblage of components is 20.0 psf acting downward along the slope.

**Note:** The computer will calculate the projected load value during analysis.

**EXAMPLE TWO: Open web steel joist framing**

**Given:** The steel joist framing section shown:

- Ballasted Single-ply Roofing
- Rigid Tapered Insul 3"-7"
  (use 5" average)
- 1-1/2" Metal Deck - 20 ga.
- Metal Ducts: 1 psf
- 24' span joists @ 4'-0" o.c.
- Electrical: 1 psf
- No Ceiling
- Wet Sprinkler System (2 pcf)


**Required:** Calculate the total dead weight of the given assembly and name it MECH.RM-TYPE 2.

**Solution:**

1. Edit the previous ROOF (DL) window with the following data:
   - **Name:** MECH.RM-TYPE 2
   - **Roofing:** Single-ply/ Ballast 12.0
   - **Deck:** Steel 1-1/2" - 20 ga 2.5
   - **Structure:** Steel bar jst. 24'@ 4' 1.8
   - **Mechanical:** Mech a/c ducts 1.0
   - **Electrical:** Elect/ Lighting 1.0
   - **Fire protection:** Sprinklers - wet 2.0
   - **Insulation:** Rigid roof insul. 5" 4.0
   - **Ceiling:** none

2. Select **SAVE** when you have finished editing and changing values. The TOTAL system weight of 24.3 psf is shown. A sample ROOF (DL) window follows:

   ![Sample ROOF (DL) window]

3. Select **ASSIGN** to place the current roof DL shown in the window on a floor plane in the building model. The next chapter will perform this operation.

4. Select **NEXT** to review all the saved ROOF (DL) assemblies.

5. Select **STOP** to return to the cleared CASM program window.
Ceiling Assemblies

Many times in the design of trusses it is advantageous to separate top chord and bottom chord dead loads and live loads. This is typical in wood, but also in steel trusses for floors or roofs. Interstitial trusses, used most often in hospitals, also require separation of top and bottom chord loads; however, since these ceiling assemblies also combine with flooring, they are best treated as a FLOOR (DL). Thus, they are the truss exception. A typical example of a CEILING (DL) would thus be the bottom chord of a wood truss.

EXAMPLE ONE: Wood roof truss system

Given: The bottom chord of a metal plate connected wood truss for a residential application.

Required: Prepare the bottom chord dead load for the truss fabricator and his engineer.

Solution:

1. Bring up the CEILING (DL) pop-up dialog window and input the following data:

   Name: House-Type 1
   Mechanical: none 0.0
   Electrical: Elect/ Lighting 1.0
   Fire Protection: none 0.0
   Insulation: Fiberglass batt 6" 1.8
   Structure: Half- 2x6 truss @ 24" 1.5
   Ceiling: Gypsum 5/8" 3.1

2. Select SAVE. A completed window should look as follows:
### Ceiling (DL)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanical</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Electrical</td>
<td>Elect/Lighting</td>
<td>1.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Insulation</td>
<td>Fiberglass Batt 6&quot;</td>
<td>1.8</td>
</tr>
<tr>
<td>Structure</td>
<td>Half-2x6 truss @ 24&quot;</td>
<td>1.5</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Gypsum 5/8&quot;</td>
<td>3.1</td>
</tr>
</tbody>
</table>

**Total:** 7.4

3. Select **ASSIGN** to place the current ceiling DL shown in the window on a floor plane in the building model. The next chapter will perform this operation.

4. Select **STOP** to return to the cleared CASM program window.
**Wall Assemblies**

The weight of wall assemblies is prepared in a similar fashion to that of floors, roofs, and ceilings. The wall weights will be in PSF and must merely be multiplied by the wall height to obtain linear loads in PLF, or merely multiplied by the wall area to obtain the total wall weight in pounds. When the load is assigned, the computer will calculate the linear load of the assembly.

**EXAMPLE ONE: Exterior wood stud wall brick veneer**

**Given:** Wall section shown below:

```
4" Brick Veneer
1" (Pinkboard) Exp. Poly. Insul.
4" Fiberglass Batt Insul.
2x4 @ 16" o.c.
1/2" Drywall
```

**Required:** Determine wall weight in PSF and name it EXT.WALL-TYPE 1.

**Solution:**

1. Select WALL (DL) from the Loads pull-down menu or from the icon on the Loads and Design tool palette. The WALL (DL) pop-up dialog window will appear.
2. Enter the following 'TYPE' and 'PSF' items:

<table>
<thead>
<tr>
<th>Name</th>
<th>Finish</th>
<th>40.0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sheathing</td>
<td>0.2</td>
</tr>
<tr>
<td></td>
<td>Structure</td>
<td>1.5</td>
</tr>
<tr>
<td></td>
<td>Insulation</td>
<td>1.2</td>
</tr>
<tr>
<td></td>
<td>Finish</td>
<td>2.5</td>
</tr>
</tbody>
</table>

3. Select SAVE. A completed window should look as follows:
4. Select **ASSIGN** to place the current wall DL shown in the window, "...a floor plane in the building model. The next chapter will perform this operation.

5. The next wall assembly can be prepared by directly changing values in the current WALL (DL) assembly window. It is necessary to insert a new name, unless it is desired to just replace the existing assembly.

6. Select **STOP** to return to the cleared CASM program window.

7. Obtain a hard copy of the assemblies.
   a. Select File from the CASM top menu bar and scroll down to **PRINT DATA**. The Print Data pop-up dialog window will appear.
   b. Place an 'X' in the LOADS option.
   c. Remove the 'X' in the BASIC DESIGN CRITERIA option. This will only print the Loads assemblies.
   d. Place an 'X' in the box for either **PRINT TO PRINTER** or **PRINT TO FILE**.
   e. Click on OK and if you selected PRINT TO PRINTER, your printer will be activated. If you selected PRINT TO FILE, you will be placed in NOTEPAD.

   ![Print Data Dialog](image)

---

Note: See the Printing Project Criteria Data in this Tutorial Manual for more information on the PRINT DATA command.
## Dead Loads

### Floor Dead Loads

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Type psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry-Type 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partition</td>
<td>0-50 PLF</td>
<td>0.0</td>
</tr>
<tr>
<td>Finish</td>
<td>Quarry Tile 1/2&quot;</td>
<td>5.8</td>
</tr>
<tr>
<td>Deck</td>
<td>MTL DK 1.5/NLWT 2.5</td>
<td>36.0</td>
</tr>
<tr>
<td>Structure</td>
<td>Steel Bar Jst 32'x2'</td>
<td>4.5</td>
</tr>
<tr>
<td>Mechanical</td>
<td>Mech A/C Ducts</td>
<td>3.0</td>
</tr>
<tr>
<td>Electrical</td>
<td>Elect/Lighting</td>
<td>2.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Susp Chn/Tile</td>
<td>2.0</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>53.3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Type psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gym-Type 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partition</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Finish</td>
<td>Hardwood 1&quot;</td>
<td>4.0</td>
</tr>
<tr>
<td>Deck</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Structure</td>
<td>Conc Pan 12+3x6+20</td>
<td>78.0</td>
</tr>
<tr>
<td>Mechanical</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Electrical</td>
<td></td>
<td>2.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Ceiling</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>84.0</td>
</tr>
</tbody>
</table>

### Roof Dead Loads

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Type psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>House-Type 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roofing</td>
<td>Concrete Shingles</td>
<td>9.5</td>
</tr>
<tr>
<td>Deck</td>
<td>OSB &amp; Waferbrd 1/2&quot;</td>
<td>1.7</td>
</tr>
<tr>
<td>Structure</td>
<td>Wood 2x12 @ 16</td>
<td>3.2</td>
</tr>
<tr>
<td>Mechanical</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Electrical</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Insulation</td>
<td>Fiberglass Batt 12&quot;</td>
<td>3.6</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Cedar Lap Siding</td>
<td>2.0</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>20.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Type psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mech.RM-Type 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roofing</td>
<td>Single Ply/Ballast</td>
<td>12.0</td>
</tr>
<tr>
<td>Deck</td>
<td>Steel 1-1/2&quot; 20ga</td>
<td>2.5</td>
</tr>
<tr>
<td>Structure</td>
<td>Steel Bar Jst 24'x4'</td>
<td>1.8</td>
</tr>
<tr>
<td>Mechanical</td>
<td>Mech A/C Ducts</td>
<td>1.0</td>
</tr>
<tr>
<td>Electrical</td>
<td>Elect/Lighting</td>
<td>1.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td>Sprinklers Wet</td>
<td>2.0</td>
</tr>
<tr>
<td>Insulation</td>
<td>Rigid Roof Ins 5&quot;</td>
<td>4.0</td>
</tr>
<tr>
<td>Ceiling</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>24.3</td>
</tr>
</tbody>
</table>
### Ceiling Dead Loads

<table>
<thead>
<tr>
<th>Name</th>
<th>House-Type 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>psf</td>
</tr>
<tr>
<td>Mechanical</td>
<td>0.0</td>
</tr>
<tr>
<td>Electrical</td>
<td>1.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td>0.0</td>
</tr>
<tr>
<td>Insulation</td>
<td>1.8</td>
</tr>
<tr>
<td>Structure</td>
<td>1.5</td>
</tr>
<tr>
<td>Ceiling</td>
<td>3.1</td>
</tr>
<tr>
<td>Total</td>
<td>7.4</td>
</tr>
</tbody>
</table>

### Wall Dead Loads

<table>
<thead>
<tr>
<th>Name</th>
<th>Ext.Wall-Type 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>psf</td>
</tr>
<tr>
<td>Finish</td>
<td>Brick Veneer 4&quot;</td>
</tr>
<tr>
<td>Sheathing</td>
<td>1&quot; Rigid Insul pnkbd</td>
</tr>
<tr>
<td>Structure</td>
<td>Wood Stud 2x4@16</td>
</tr>
<tr>
<td>Insulation</td>
<td>Fiberglass Batt 4&quot;</td>
</tr>
<tr>
<td>Finish</td>
<td>Gypboard 1/2&quot;</td>
</tr>
<tr>
<td>Total</td>
<td></td>
</tr>
</tbody>
</table>
MINIMUM ROOF LIVE LOAD

The basic minimum roof live load for members supporting flat, pitched, or arched roofs is 20 psf as prescribed in ANSI-A58.1-1982 and cited in TM 5-809-1 referenced at the beginning of this chapter. Reductions to the 20 psf are a function of the horizontal projected tributary area carried by the member and the roof slope. The following example illustrates this provision as set up in CASM.

EXAMPLE ONE: Minimum roof live load

Given: An industrial building framed with repetitive bays at 20 feet on center. The roof is framed with 60-foot span trusses in each bay. The top chord slope is 3 in 12 creating a low sloped gable roof. This example can be found in TM 5-809-1 on page C-2.

Required: Determine the minimum live load to be carried by each truss.

Solution:

A. Establish Criteria.
   1. Input the following data into the PROJECT dialog window:

      PROJECT Name: Industrial Building
      City/Installation: Vicksburg
      State: MS
      Design Load: Tri-Services

      Note: This is the minimum information required to do minimum roof live load calculations.

B. Draw volumetric model.
   1. Select DRAW MODEL from the CASM menu bar.
      2. Establish general layout requirements which are different than previously established.
         a. Use the following:

         DEFINE UNITS(snap increment) : 6 inches
         SNAP TO UNITS : on
         SHOW GROUND PLANE : on
         GROUND PLANE
         WIDTH N-S : 100 feet
                      E-W : 100 feet
         SPACING N-S : 20 feet
                       E-W : 20 feet
         INITIAL OBJECT SIZE
            N-S : 80 feet
            E-W : 60 feet
         HEIGHT : 20 feet
         ORIENTATION : N-S
         STACK ON GROUND PLANE : on
         DIRECTIONS LOCKED : none
3. Place a CUBE on the ground plane with the required dimensions.

4. Draw the gable roof.
   a. Turn on STACK ON LAST SHAPE.
   b. Stack a PRISM on the cube.
   c. LOCK the N-S and E-W directions.
   d. Use the DRAG EDGE command to make the roof slope 3 in 12.
   e. Unlock the N-S and E-W directions.

5. Draw roof structural elements.

   Note: This is the logical next step for typical linear elements presently implemented in CASM. Trusses are currently not implemented, but will be in the next phase of development. It is possible to determine minimum roof live loads without drawing structure. This is the approach which follows.

6. This completes creation of the model and insertion of any structure (none in this case).

C. Determine the minimum roof live load for a typical roof truss.

   Note: You must be in a 2-D view of a selected plane on the 3-D model to be able to apply a minimum roof live load. You cannot be in a 3-D, plan, elevation, or section view.

1. Select LOADS AND DESIGN from the CASM menu bar.
2. Select INCLINED PLANE from the Options pull-down menu contained in the Viewpoint window. Handles will appear on the visible inclined planes.
3. Use the mouse pointer to select one of the handles and a 2-D view of the plane will appear.

   Note: This is a view of the true width, not a view of the projected width.

5. Modify the Output File name to TRUSSMIN.TXT and click on OK. A Tributary Area dialog window will appear.
   a. Use the mouse pointer to set the lower left corner of the tributary area to be created.
   b. Drag the mouse pointer to create a tributary area with a tributary width of 40 feet and a length equal to the width of the roof plane.

   Note: The tributary width has been doubled to account for the inability to deal with double sloped (gabled) top chord trusses that span the full width of the building.

   Note: The tributary area is a projected area above the 2-D plane.

   c. Click the left mouse key to fix the tributary area. Calculation then begins. The minimum roof live load and its name will appear on the 2-D plane within the drawn tributary area.

6. Click on CANCEL to exit the Minimum Roof Live Load command.

D. Manipulation of the building model and its loads.

1. Follow steps D-1 through D-4 from Example 1 in the snow load section.

E. Generation of hard copies.

1. Follow steps E-1 and E-2 of Example 1 in the snow load section to print a screen image.

2. Review and print the minimum live load calculations.
   a. Follow steps E-3 and E-4 of Example 1 in the snow load section.
Project: Industrial Building
Location: Vicksburg
Design Load: Tri-Services
Time: Tue Jan 30, 1990 10:48 PM

*************** Minimum Roof Live Load (Lr) ***************

Tributary area (At): 810 sf
Roof slope (F): 3.00 in 12

\[
Lr = 20*R1*R2 = 12 \\
At \geq 600 \quad R1 = 0.60 \\
F \leq 4 \quad R2 = 1.00 \\
Lr = 12.00 \text{ psf} \\
\text{minimum } Lr = 12 \text{ psf}
\]

Check minimum roof live load, Lr, against minimum snow design loads.

Additionally, for the design of secondary members such as roof decking and rafters, a concentrated live load with 250 lbs uniformly distributed over an area of 2 feet square (4 sqft) will be included. The concentrated load will be located so as to produce the maximum stress in the member.

F. Save the building model with its minimum live load applied for future reference.

1. Follow the steps in part F of Example 1 in the snow load section.
LIVE LOADS: OCCUPANCY

This section describes the procedures used by the CASM program to generate uniformly distributed floor occupancy live loads for different projects. This version of CASM addresses occupancy live loads based on the provisions stated in the TRI-SERVICES manual only. Future versions of CASM will include the UBC and BOCA code provisions as well.

It is not necessary to select a Design load code from the PROJECT CRITERIA window to prepare occupancy live loads, as it was for SNOW and WIND loads. It is not necessary to draw the geometric model to create a list of occupancy live loads for the building.

A typical procedure for creating the occupancy live load list for the building is as follows:

1. Select Loads and Design from the CASM menu bar to display the Loads and Design Tool Palette.
2. Select Loads from the menu bar and scroll down to OCCUPANCY (LL). Click on this highlighted choice with the left mouse key. The typical alternate approach is to select the occupancy live load icon from the LOADS tool palette. An OCCUPANCY (LL) pop-up dialog window will appear.
3. Drag the mouse pointer to the ADD box and click on the left mouse key. This will activate the occupancy live load selection list in the overlay pop-up dialog window.
4. Use the scroll bar arrows to scan the list for desired choices.
5. Use the mouse pointer to select a choice.
6. Double click the left mouse key or single click and then click on OK. The occupancy live load will appear in the OCCUPANCY (LL) window.
Note: Certain live load magnitudes are followed by a letter which represents a reminder note that appears on the screen when the load is selected. Click on OK to remove the note.

---

**Note**

- a. Variable design load. Increase may be necessary.

OK

---

7. To modify the live load magnitude or name, or view the note:
   a. Double click the left mouse key on the live load name. A pop-up dialog window will appear.

   ![Image of dialog window]

   - a. Variable design load. Increase may be necessary.

   OK Cancel

   b. Change the name or psf as desired.
   c. Select OK when satisfied or CANCEL to not save the change.

8. Repeat the process as many times as required to create a list of the project's uniformly distributed live loads.

9. Decide if live load reductions are to be applied to all the loads listed.
   a. Select LLR GUIDELINES for the code criteria to aid your decision process.

---

**Uniformly distributed live loads for supporting members; i.e., two-way slab, beam, girder or columns having an influence area of 400 sq ft or more may be reduced with:**

\[ L = L_0 \times \left( 0.25 \times \frac{15}{\sqrt{A_i}} \right) \]

The reduced design live load will not be less than 50% of the unit live load for members supporting one floor, nor less than 40% of the unit live load for members supporting two or more floors.

Exceptions: For live loads less than 100 psf, no reduction is permitted for members supporting floor(s) in the following areas:
- public assembly
- garages (except where 2 or more floors are supported)
- one-way slab floor

For live loads greater than 100 psf and for garages used for passenger cars only, no reduction is permitted for members supporting one floor; however, where two or more floors are supported, a 20% reduction is permitted.

---

b. Place an 'X' next to APPLY LIVE LOAD REDUCTION to have the reductions automatically calculated during analysis.
Note: It is not possible to have live load reduction apply to only a select few loads from the list.

10. Select ASSIGN to apply the highlighted live load from the list on a floor plane in the building model. This process is performed in the next chapter.

11. When finished, select STOP to return to a clear CASM program window. Your live load choices can be saved to a file according to procedures described in the REFERENCE and OVERVIEW chapters of the Reference Manual. The following example illustrates the application of the discussion described above.

EXAMPLE ONE: Multiuse facility

Given: A four-story multiuse facility that will be designed based on the TM 5-809-1 Loads Manual contains the following functions:

- Offices (3 stories)
- Corridors (main)
- Files and storage
- Lobbies
- Lecture hall, meeting room w/ movable seats
- Dining room
- Parking garage (1 story)
- Kitchen

Required: Prepare a list of live loads for the project. Live load reductions are to be taken for all live loads. The Files and Storage live load should be increased to 90 psf. Save the list in a file called OFFICE.BLD.

Solution:

1. Follow the steps outlined above to create the project’s live load list. The completed OCCUPANCY (LL) window will look as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office: Offices</td>
<td>50</td>
</tr>
<tr>
<td>Office: Corridor (main)</td>
<td>100</td>
</tr>
<tr>
<td>Office: Files &amp; Storage</td>
<td>90</td>
</tr>
<tr>
<td>Office: Lobbies</td>
<td>100</td>
</tr>
<tr>
<td>Assembly: Movable seats</td>
<td>100</td>
</tr>
<tr>
<td>Dining rooms</td>
<td>100</td>
</tr>
<tr>
<td>Garages (passenger cars)</td>
<td>50</td>
</tr>
<tr>
<td>Kitchens (non domestic)</td>
<td>150</td>
</tr>
</tbody>
</table>

Apply Live Load Reduction

LLR Guidelines
Add Assign Stop
2. Select STOP and return to the clear CASM program window.

3. Save the project live load list to a file.
   a. Select the File pull-down menu from the CASM top menu bar and select SAVE. A pop-up dialog window will appear.
      ![Print Data Dialog](https://example.com)

      b. Type in the project filename: OFFICE.BLD
      c. Select SAVE. The filename 'untitled' at the top of the CASM window will be replaced with the new filename.

4. Print the project live load list.
   a. Select File pull-down menu again and select PRINT DATA. The Print Data dialog window will appear.
   b. Select LOADS and PRINT TO FILE.
   c. Enter the filename: OFFICE.TXT
   d. Select OK and respond to the pop-up dialog window warning to replace the output file if one appears.
   e. The NOTEPAD program window will appear displaying the live load file and accompanying notes.
   f. Select the File pull-down menu and select PRINT. The file is then sent to be printed on the printer. A sample output is as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office: Offices</td>
<td>50</td>
</tr>
<tr>
<td>Office: Corridor (main)</td>
<td>100</td>
</tr>
<tr>
<td>Office: Files &amp; storage</td>
<td>90a</td>
</tr>
<tr>
<td>Office: Lobbies</td>
<td>100</td>
</tr>
<tr>
<td>Assembly: Movable seats</td>
<td>100</td>
</tr>
<tr>
<td>Dining rooms</td>
<td>100</td>
</tr>
<tr>
<td>Garages (passenger cars)</td>
<td>50</td>
</tr>
<tr>
<td>Kitchens (non domestic)</td>
<td>150a</td>
</tr>
</tbody>
</table>

   a. Variable design load. Increase may be necessary.

   **Notes**
   Uniformly distributed live loads for supporting members: i.e., two-way slab, beam, girder or columns having an influence area of 400 sq ft or more may be reduced with: 
   \[ L = L_0 \times [0.25 + (15/\sqrt{A_i})] \]
The reduced design live load will not be less than 50% of the unit live load for members supporting one floor, nor less than 40% of the unit live load for members supporting two or more floors. Exceptions: For live loads less than 100 psf, no reduction is permitted for members supporting floor(s) in the following areas:
- public assembly
- garages [except where 2 or more floors are supported]
- one-way slab floor

For live loads greater than 100 psf and for garages used for passenger cars only, no reduction is permitted for members supporting one floor; however, where two or more floors are supported, a 20% reduction is permitted.

Note: An alternate (simpler) way to obtain a printout is to select PRINT TO PRINTER instead of PRINT TO FILE. The latter was done here merely to show the process.
This chapter is intended to present the structural planning capabilities of CASM. It will synthesize the many pieces of CASM you have learned in the previous chapters and give you an understanding of the program's application in the preliminary structural design process. The entire flowchart, illustrated in Chapter 1, will now be used to compare structural systems and assist the engineer in his decision-making process.

This chapter will assume that you have mastered CRITERIA, LOADS generation, and the basics of GEOMETRIC MODELING from the previous chapters. Emphasis will be on the commands necessary to:

A. Establish structural grids
B. Create openings
C. Draw structural framing systems
D. Establish structural element parameters
E. Assign loads and generate load combinations
F. Perform preliminary analysis
G. Perform preliminary structural member design

EXAMPLE ONE: Alternative structural schemes for a repetitive floor framing system

Given: A three-story 6 x 3 bay office building. A typical bay will be 24 feet by 24 feet. The building will be a braced frame with x-bracing around the corner stair towers providing lateral load resistance.

The occupancy live load will be assumed a smear of office, corridor and partitions totaling 70 psf.

The exterior wall construction will include 4-inch brick veneer with a 2-inch air space and a lightweight 8-inch CMU back-up. A 1-inch rigid insulation (expanded polystyrene) will be placed in the cavity. The exterior wall will be supported at each floor level. The exterior face of brick is 9 inches in front of the spandrel beam centerline.

Required: Perform a preliminary analysis and design for the following structural framing options:

1. Open-web steel joists with steel beams on the column lines.
   a. All joists spanning in the same direction.
b. Checkerboard arrangement of joists.

Assume the following structural cross section and floor dead loads:
2. Steel beam framing at third points and on the column lines.
   a. Noncomposite construction with checkerboard layout. All connections are simple shear type.
b. Noncomposite construction with checkerboard layout. The girder lines in the short direction of the building are continuous.

Assume the following structural cross section and floor dead loads:

c. Composite construction with checkerboard layout. All connections are simple shear type.

Not Yet Implemented
3. Cast-in-place concrete one-way beam/slab system.
Assume the following structural cross section and floor dead loads:

![Structural Diagram]

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Finish</td>
<td>Carpet &amp; Pad</td>
<td>1.0</td>
</tr>
<tr>
<td>Deck</td>
<td>Concrete HLWT 4&quot;</td>
<td>50.0</td>
</tr>
<tr>
<td>Structure</td>
<td>Est. Member Weight</td>
<td>19.5</td>
</tr>
<tr>
<td>Mechanical</td>
<td>Mech A/C Ducts</td>
<td>3.0</td>
</tr>
<tr>
<td>Electrical</td>
<td>Elect/Lighting</td>
<td>1.0</td>
</tr>
<tr>
<td>Fire Protection</td>
<td></td>
<td>0.0</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Susp Chnl/File</td>
<td>2.0</td>
</tr>
</tbody>
</table>

*Initially enter a member weight of 0.0. An Estimated Member Weight will be provided during Preliminary Analysis and automatically added to the Floor Type 3 list.*
Solution: Scheme 1a

A. Establish Criteria.
1. Select PROJECT and input the following data:
   Project Name: CORPS OFFICE BUILDING
   City/installation: VICKSBURG
   State: MS

   Note: This is the only information required, since we will not need snow or wind loads to design floor framing.

B. Draw Volumetric Model.

   Note: It is only necessary to draw a portion of the building to study typical bay framing. A one-level, three-bay by three-bay model will be sufficient to design typical interior, exterior, and corner bay members. Consideration of the 9-inch perimeter offset is also not required when studying typical bay framing.

1. Prepare the following basic model on the ground plane:

   72 feet x 72 feet x 14 feet high.

   Note: It is best not to draw the individual bays in any model. The bays are defined by the structural grid.

   Note: This minimal model will not produce accurate wind load values. The complete building volume, including offsets, is necessary to properly address B/L and h/L factors, as well as the number of floor levels. Snow load values will be correct if no projections are anticipated above the flat roof plane.

---

Diagram:

- 72 feet x 72 feet x 14 feet high.
- 3 x 24' = 72'
- 75'-6" = 72'
- 145'-6"
C. Establish the Structural Grid.

Note: It is necessary to have a structural grid within which structure can be drawn.

1. Select DRAW STRUCTURE from the CASM menu bar.
2. Select DEFINE GRID from the Grid/Open pull-down menu. A Define Grid dialog window will appear.

<table>
<thead>
<tr>
<th>Define Grid</th>
</tr>
</thead>
<tbody>
<tr>
<td>N-S Spacing: 24.00 ft</td>
</tr>
<tr>
<td>E-W Spacing: 24.00 ft</td>
</tr>
<tr>
<td>Perimeter Offset: 0.00 in</td>
</tr>
</tbody>
</table>

3. Set the N-S and E-W SPACING to 24.0 feet.

Note: The Perimeter Offset will be left at 0.0 inch as mentioned above. It does not influence the analysis or design of floor framing components.

4. Click on OK when satisfied and the grid will appear on the 3-D model.

D. Define Structurally Significant Openings.

1. Typical floor framing does not include areas where openings occur. None will be inserted for this example.

Note: Significant openings would include stairs, elevators, mechanical chases, atriums, skylights, etc.

E. Draw Structure.

Note: It is necessary to be in a 2-D view of a plane taken from the 3-D model to draw Structure.

1. Select HORIZONTAL PLANE from the Options pull-down menu located within the Viewpoint window. Handles will appear on the horizontal planes within the 3-D model for selection.

Note: CASM defines a roof plane as one which has no objects stacked on it; otherwise, it is a floor plane. Therefore, the top horizontal plane in our model is considered a roof plane, and the plane sitting on the ground plane is considered a floor plane.

Note: Floor loads cannot be assigned to a roof plane, but roof loads can be assigned to a floor plane since planes which are partial roof and partial floor are considered as a floor plane.

2. Select the floor plane (lower handle) from the 3-D model. A 2-D view of the selected plane will appear with the defined structural grid. A North arrow will appear in the lower right hand corner to aid the user in compass orientation.

3. Name the floor plane.
Note: All structural planes are automatically uniquely named and numbered.

a. Select **DISPLAY INFORMATION** from the Options pull-down menu in the Viewpoint window. A Structural Plane Information dialog window will appear showing the plane's name as well as any loads or openings that have been assigned to it.

![Structural Plane Information](image)

b. Change the name to: **TYPICAL FLOOR**.

c. Select **CLOSE** from the System pull-down menu in the Structural Plane Information dialog window to remove the window from the screen.

**Note:** An optional way to close the Structural Plane Information dialog window is to reselect **Display Information** from the Options pull-down menu or double click on the System menu icon.

**Note:** The Structural Plane Information dialog window will remain on the screen until it is closed.

4. Draw the narrowly spaced elements (joists).

**Note:** CASM defines narrowly spaced elements as elements that are spaced less than or equal to 4 feet apart and produce distributed reactions on other elements. Widely spaced elements are spaced greater than 4 feet apart and produce concentrated reactions on other elements.

**Note:** There is no need to consider material choice at this time, only the skeletal structural arrangement.

a. Select **NARROWLY SPACED** from the Floor/Roof pull-down menu. Handles will appear at the mid points of the grid intersections.

b. Draw joists in the bay defined by grids B to C and 1 to 2. Select a sufficient number of handles in a clockwise order to define the perimeter within which structure is to be drawn. A highlighted dotted line will be drawn showing the perimeter.

**Note:** A handle represents the midpoint of a line which contains two points on one edge of the perimeter. The perimeter is made up of these points.
Note: There are several ways to select the desired perimeter: (1) by selecting handles in a clockwise order around the entire perimeter, or (2) by selecting one handle and the mutually opposite side handle.

Note: If you select an incorrect handle, double click the right mouse key to stop adding to the perimeter and select CANCEL in the element dialog box.

c. When the desired perimeter is selected, double click the right mouse key to fix the perimeter. The Linear Elements dialog window appears and narrowly spaced linear elements appear on the screen.

Note: The spans indicated in the dialog window are calculated from the selected perimeter.

![Linear Elements dialog window](image)

Orientation: N-S  E-W
Number of Elements: 11
Spacing: 24.0 in
Offsets: East: 24.0 in  West: 24.0 in
Span: H-S: 24.0 ft  E-W: 24.0 ft

Recalc  Save  Cancel

d. Revise data in the dialog window to draw joists spaced at 2 feet on center.

(1) Set ORIENTATION to N-S.

(2) Fix the SPACING and select 24 inches.

Note: Linear elements are placed by fixing the spacing or fixing the number of elements.

Note: A checkmark in front of a variable fixes that variable.

Note: If neither Offset is fixed, the elements are centered within the perimeter.

(3) Click on RECALC to redraw the joists at the new settings. The Number of Elements will be calculated as 11 and the Offsets will be 24.0 inches.

(4) Click on SAVE to fix the joists in the bay.

e. Repeat steps a through d to draw joists in the bay defined by grids B to C and 2 to 3.
Note: Design of a typical girder requires drawing all elements that produce reactions on the girder so that load transfer is complete.

5. Draw the widely spaced elements (girders).
   a. Select **WIDELY SPACED** from the Floor/Roof pull-down menu. Handles will appear at the midpoints of all grid lines.
   b. Select the handle between grid intersections B-2 and C-2. The line between those two grid intersections will be highlighted.
   c. Double click the right mouse key to end selection of the handles and add the widely spaced element along the grid line. A Linear Elements dialog window will appear with information about the element. A girder will be drawn.

   ![Linear Elements Dialog](image)

   **Linear Elements**
   - **Orientation:** ON-SOUTH
   - **Number of Elements:** 1
   - **Spacing:** 8.0 ft
   - **Offsets:** South: 0.0 ft, North: 0.0 ft
   - **Span:** N-S: 24.0 ft, E-W: 24.0 ft

   ![Girder](image)

   Note: Values in the boxes reflect that only one element has been drawn. Attempts to alter the number of elements, spacing, or offsets will revert back to the correct values for one element.

   d. Select **SAVE** to fix the girder location.
   e. Repeat steps a through d to add the spandrel girder at grid intersections B-1 and C-1.

6. Draw the surface elements (decking and slab).
   a. Select **ONE-WAY** from the Floor/Roof pull-down menu. Handles will appear at the midpoint of the grid lines.
   b. Draw decking and slab in the bay defined by gridlines B to C and 1 to 2. Select a sufficient number of handles in a clockwise order to define the perimeter within which structure is to be drawn. A highlighted dotted line will be drawn showing the perimeter.
   c. Double click the right mouse key to stop defining the perimeter. A Surface Elements dialog window and a one-way surface symbol will appear. The
area of the selected perimeter and the maximum span of the slab/deck are shown.

Orientation: ON-S
Area: 576.8 sqft
Maximum span: 24.0 in

Note: It is not necessary to draw the slab/deck in the other bay since narrowly spaced elements are assumed to have a surface above them to distribute loads.

7. Draw the column and wall structural elements.

Note: It is not necessary to draw columns or bearing walls, as support is assumed at the ends of elements. Column and bearing wall gravity load run-downs are not included in this version of CASM.

8. Manipulation of the structural and geometric model.

It is possible to view the structure in 3-D, turn on and off the structure and structural grid with the SHOW STRUCTURE command, print screen, etc.

F. Establish independent load cases and assign to the floor plane.

1. Select LOADS AND DESIGN from the CASM menu bar.
2. Prepare floor dead load and name as: FLOOR TYPE 1.
   The total dead load should be 49.5 psf.
3. Assign the dead load to the floor plane.
   Note: You must be in a 2-D view of a selected horizontal or inclined plane to assign loads. You cannot assign dead load or live load to a vertical plane.
   a. Select ASSIGN and a Tributary Area dialog window will appear.
   b. Move the mouse pointer to the lower left corner of the plan and click the left mouse key to fix the starting corner of the area to be selected.
c. Move the mouse to the upper right corner of the floor plan and single click the left mouse key again. A hatched texture will appear within the selected area. Its color corresponds to the range within which the magnitude falls. The load name and magnitude will also appear within the selected area.

![Floor Plan Diagram]

**Note:** The color of assigned loads will correspond with the following load ranges:

- **Blue:** 0 to 59.9 psf
- **Cyan:** 60.0 to 99.9 psf
- **Yellow:** 100.0 to 199.9 psf
- **Red:** 200.0 psf and above

**Note:** The assigned load is automatically saved.

**Note:** Changing the magnitude of a load will automatically update all the areas to which that load was assigned.

4. Select **STOP** to end working with the floor dead load.

5. Prepare the Floor live load of 70 psf.

**Note:** It is necessary to edit the Office Occupancy live load of 50 psf to account for the smeared corridor and partition load. Double click anywhere along the Office name/psf line to edit the load magnitude and name as required.

**Note:** We will not use live load reductions in this example due to the smear corridor and partition load inclusion.

6. Assign the live load to the entire floor plane similar to that done in step 3.

**Note:** Selection of **ASSIGN** with the mouse pointer will turn off the display of all other loads and turn on the display of the load to be assigned.
Note: The hatched color will be cyan in this case.

7. Select STOP to end working with the occupancy live load.

8. Prepare the exterior wall dead load and name as: EXTERIOR WALL TYPE 1. The total wall surface load is 73.2 psf.

Note: Wall surface loads are automatically multiplied by the wall height, when assigned, to obtain the linear wall load in plf.

3. Select ASSIGN and a Tributary Area dialog window will appear.
   a. Move the mouse pointer to grid location A-1 and click the left mouse key to fix the start point of the wall.
   b. Move the mouse pointer to grid location D-1 and click the left mouse key to fix the end point of the wall. A Wall Height dialog window will appear.

Note: Walls can only be placed parallel to the N-S or E-W directions. Diagonal walls can be placed by rotating the ground plane.

   c. The default floor to floor height of 14 feet will be used for this example.
   d. Click on OK and the wall will be displayed.

Note: The cyan color displayed is based on the psf load value, not the plf value.

Note: All the dead loads, whether point, linear, or distributed, will be displayed simultaneously, since we are working with dead loads.
10. Select STOP to end work with the wall dead load.
11. This completes the Assigning of loads for the typical deck, joists, and girders.

G. Establish element parameters necessary to design a typical steel open-web joist.

1. Select STEEL from the Materials (mat'l) pull-down menu.
   
   Note: It is necessary to select the material before any other element parameter, since the element type is material dependent.

   Note: A checkmark appears in front of the current material in the pull-down menu and the material icon will be highlighted.

2. Select OPEN-WEB JOISTS-K from the Floor/Roof system category pull-down menu in the Loads and Design tool palette. Handles will appear on all the narrowly spaced elements.

3. Select any handle and click the left mouse key. The selected element will be highlighted by a red dashed line. The Linear Elements dialog window will appear showing the dimensions of the selected element. An additional window will appear showing the element attributes. These attributes include span/depth ratio, approximate depth, typical span range, efficient span range, and typical depth range.

4. Review the data shown and select GUIDELINES to be prompted with additional considerations for the element type selected.
5. Three options exist at this point:
   a. Select CANCEL to end consideration of that element type.
   b. Select a different narrowly spaced element type from the Floor/Roof pull-down menu.
   c. Continue on to preliminary analysis with the present element type selected.

H. Preliminary analysis of a typical steel open-web joist.

1. Establish load combination for analysis.
   a. Select LOAD COMBINATIONS from the Loads pull-down menu. The Load Combinations dialog window will appear with a list of the independent loads that can be combined.

   Note: It is necessary to set a factor to a value other than zero to include that load in the load combination.

<table>
<thead>
<tr>
<th>Type</th>
<th>Factor</th>
<th>Type</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead</td>
<td>1.00</td>
<td>Wind</td>
<td>0.00</td>
</tr>
<tr>
<td>Live</td>
<td>1.00</td>
<td>Seismic</td>
<td>0.00</td>
</tr>
<tr>
<td>Snow</td>
<td>0.00</td>
<td>Temperature</td>
<td>0.00</td>
</tr>
<tr>
<td>Min. Roof LL</td>
<td>0.00</td>
<td>Soil</td>
<td>0.00</td>
</tr>
<tr>
<td>Pattern Occupancy Live Load</td>
<td><strong>on</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   b. Select GUIDELINES to review code recommended load combinations for allowable stress design and strength design methods, as well as symbol definitions. Click on OK to erase each overlapping window.
   c. Enter a FACTOR of 1.0 next to the Dead and Live load types.
   d. Select ADD to enter the load combination into the list.

   Note: The highlighted load combination in the list will be used for the structural analysis. If several load combinations are listed, scroll to the desired load combination.
   e. Do not turn on Pattern Occupancy Live Load for this example.

   Note: Patterned live load is only of interest for continuous member analysis.
   f. Select OK to end selection of load combinations.
2. Select PRELIMINARY from the Design pull-down menu. An Analysis dialog window will appear.

Note: You must have an element selected and a load combination selected to perform a preliminary analysis.

Note: Single-screen users will find it convenient to move the Linear Elements and the Element Attributes dialog windows to the edges of the display to be able to view the floor plan.

3. Select appropriate options within the Analysis dialog window.
   a. Select UNITS of Feet and Pounds.
   b. Do not check DL = DECK + SELF WEIGHT, since the joist is a noncomposite element.
   c. Select GUIDELINES for information on when to turn on DL = Deck + Self Weight.
   d. Select OK to continue preparation for analysis of the joist element. A Connectivity dialog window will appear, and the left and right ends of the selected element will be highlighted on the floor plane.

Note: Selection of CANCEL in any of the Preliminary Analysis dialog windows will stop the process.

Note: Single-screen users can at any time zoom and pan the floor plan as necessary to view the selected element in the most convenient location on the display.

4. Select appropriate connectivity options.
   a. Create a simple joist span by setting the left support as a HINGE and the right support as a ROLLER.

Note: The default connectivity is for a simple span.

Note: The nondefaulted hinge and roller options are used for elements that are continuous over the support.

b. Continuous spanning elements require setting the number of adjacent spans to the left or right of the single span selected for analysis. Additional Connectivity dialog windows will appear to select the adjacent span support conditions.
Note: The number of adjacent spans to either side cannot be set unless a continuous support type has been selected at that end.

Note: Combinations of left and right end connectivity cannot be selected that produce instability.

5. Select appropriate self weight options.
   a. Perform option 2 of the following available options for insertion of the element's self weight:
(1) Use the smeared element self weight called "Structure" in floor dead load type 1. This is an appropriate choice for joists, not the appropriate choice for girders. The plf self weight value is already shown on the Dead load diagram. Leave the estimated self weight value in the dialog window as 0.0 plf.

1.00 Dead (plf) 2.0
1.00 Superimposed Dead (plf) 92.0
1.00 Live (plf) 140.0

(2) Insert a new estimated plf self weight. This is an appropriate choice for joists, not the appropriate choice for girders.
(a) Click the left mouse pointer within the plf value box. A help dialog window for open-web steel joists will appear with an estimated midrange weight for the joist span.
(b) Estimate the element's self weight with guidance from the weights shown in the help window and type the magnitude in the plf box.
(c) Click on CLOSE to erase the help dialog window from the display.
(d) Turn on UPDATE AREA STRUCTURE LOADS if you wish the smeared element self weight, contained in the floor dead load types, to be replaced with the new estimated value. The plf value will be automatically converted to a psf value and its name will be changed to "est. member weight." The new name will make it easy to recognize that the value was changed.

(3) Add the estimated self weight to the smeared structural dead load. This is the appropriate choice for beams and girders, but not for joists.
(a) Follow steps (a) to (c) of option 2.
(b) Turn on ADD SELF WEIGHT.
b. Click on OK and an Analysis File Name window will appear.

Analysis
Analysis file name: schene14.txt
Are the loads and connectivity correct?
Yes  No
c. It is possible to obtain a hardcopy of the plf load diagrams by selecting PRINT SCREEN from the File pull-down menu.

6. Enter the desired ANALYSIS FILE NAME and select YES if the Loads and Connectivity are correct as displayed.

   Note: The speed of the analysis can be increased by not assigning a file name; however, no analysis output will be generated for later review.

   Note: Selection of NO ends the preliminary analysis process.

7. Preliminary analysis of the element begins.
   a. When analysis is complete the shear, moment and relative deflection diagrams for the selected load combination will appear on the display. Simultaneously, a View Shear, Moment & Deflection dialog window will appear.

   b. Select any of the loads listed in the dialog window to have its shear, moment and relative deflection displayed.
   c. It is possible to obtain a hardcopy of the diagrams for any of the load types by selecting PRINT SCREEN from the File pull-down menu.
   d. Click on OK to continue to the preliminary design of the joist.

I. Preliminary design of a typical open-web steel joist.
   1. Make appropriate selections within the Excel Data dialog window.
      a. The following two options are available:
(1) Select **EXECUTE EXCEL** to go directly to the Excel open-web steel joist spreadsheet.

(2) Select **SEND DATA TO FILE** and enter a **FILE NAME** to defer design to a later date.

Note: This is the proper choice if you do not have Excel installed or insufficient memory is available to run both CASM and Excel at the same time. Generally, 512K of expanded memory in addition to 640K conventional memory and a dual-screen Matrox graphics card work station will provide sufficient memory.

b. Turn on **EXECUTE EXCEL**.

c. Click on **OK** to continue. The CASM program will become an icon, and Excel will be executed loading the open-web steel joist design spreadsheet.

---

**STEEL BAR JOIST PRELIMINARY SELECTION**

**Project:** Corps Office Building  
**Location:** Vicksburg  
**Date:** Feb 23, 1990  
**Engr:**

**CASM Load & Analysis Data:**

<table>
<thead>
<tr>
<th>Load Combination</th>
<th>D + L</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Member ID:</strong> J1</td>
<td><strong>Load Factored Moment (ft-lb)</strong></td>
</tr>
<tr>
<td><strong>Connection:</strong> Hinge (Left)</td>
<td><strong>Type</strong></td>
</tr>
<tr>
<td><strong>Roller (Right):</strong></td>
<td><strong>Dead</strong></td>
</tr>
<tr>
<td><strong>Span:</strong> 24.0 ft</td>
<td><strong>Sup Dead</strong></td>
</tr>
<tr>
<td><strong>Spacing:</strong> 24.0 in</td>
<td><strong>Live</strong></td>
</tr>
<tr>
<td><strong>Depth Limit:</strong> 24.0 in max</td>
<td><strong>Min Roof</strong></td>
</tr>
<tr>
<td><strong>Fy:</strong> 36.0 ksi</td>
<td><strong>Wind</strong></td>
</tr>
<tr>
<td><strong>Fb:</strong> 24.0 ksi</td>
<td><strong>Summary</strong></td>
</tr>
</tbody>
</table>

Total Def = L/240 = 1.20 in  
Live Def = L/360 = 0.80 in  

**CASM Joist Selection Table:**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>16K2</td>
<td>254</td>
<td>170</td>
<td>18,268</td>
<td>3,048</td>
<td>0.66</td>
<td>1.13</td>
<td>2.8</td>
<td>5.5</td>
</tr>
<tr>
<td>14K3</td>
<td>246</td>
<td>141</td>
<td>17,840</td>
<td>2,940</td>
<td>0.90</td>
<td>1.36</td>
<td>3.0</td>
<td>6.0</td>
</tr>
<tr>
<td>16K3</td>
<td>232</td>
<td>189</td>
<td>20,376</td>
<td>3,396</td>
<td>0.59</td>
<td>1.02</td>
<td>3.2</td>
<td>6.3</td>
</tr>
<tr>
<td>18K3</td>
<td>500</td>
<td>242</td>
<td>23,040</td>
<td>3,840</td>
<td>0.47</td>
<td>0.80</td>
<td>3.3</td>
<td>6.6</td>
</tr>
<tr>
<td>14K4</td>
<td>295</td>
<td>165</td>
<td>21,240</td>
<td>3,540</td>
<td>0.68</td>
<td>1.16</td>
<td>3.4</td>
<td>6.7</td>
</tr>
</tbody>
</table>

**CASM Bar Joist Selection:**

<table>
<thead>
<tr>
<th>Joist Size</th>
<th>Total / Live</th>
</tr>
</thead>
<tbody>
<tr>
<td>16K2</td>
<td>24.0 ft</td>
</tr>
<tr>
<td>28.0 in</td>
<td></td>
</tr>
</tbody>
</table>

---

**Analysis Data from CASM Preliminary Analysis**  
**Preliminary Bar Joist selections**
Note: If there is not enough memory to execute Excel, an error dialog box will appear and you will need to send the data to a file.

Note: If SEND DATA TO FILE was turned on, the data necessary to design the open-web steel joist will be written to the selected file. Proceed directly to step 3.

2. Design the joist within the Excel design spreadsheet.
   a. The preliminary design spreadsheet and a portion of the CASM joist selection table will appear showing K-Series joist sizes which satisfy the reaction, shear, moment and deflection values for the load combination analyzed, based on criteria of the Steel Joist Institute.
   b. Use the scroll bar to view the remaining portions of the spreadsheet.
   c. Select CARDFILE from the Guidelines pull-down menu to review additional factors which may influence the decision-making process. CLOSE the Cardfile program when finished reviewing the additional factors.
   d. Select the lightest joist size.
      (1) Select SELECT MEMBER from the Member pull-down menu to choose the desired joist size. A Member Size Selection dialog window will appear.
      (2) Click on the 16K2 joist from the list and the selected joist size will be displayed in the lower box within the window.
      (3) Select SAVE SELECTION to insert the joist designation in the CASM Bar Joist Selection line in the lower part of the spreadsheet.
   e. Select PRINT SPREADSHEET from the File pull-down menu to obtain a hardcopy of the spreadsheet.
   f. Test the influence of a change in floor finish from carpet to Thin-set terrazzo without going back to CASM.

Note: Changes to load, span, or spacing cannot be made on the design spreadsheet, since its data are obtained from the analysis done in...
CASM. A scratchpad spreadsheet is available to allow varying any of the parameters.

(1) Select BAR JOIST from the Scratchpad pull-down menu. A steel bar joist scratchpad spreadsheet will appear.

(2) Use the scroll bar to view hidden portions of the spreadsheet and change the Superimposed area dead load to 53 psf to reflect a 7-psf dead load increase. Data contained in the scratchpad will be recalculated automatically.

(3) Review the changed bar joist sizes and note that the 16K2 still works.

(4) Select SELECT MEMBER from the Member pull-down menu to choose the desired joist size. A Member Size Selection dialog window will appear.

(5) Click on the 16K2 joist in the list and it will be displayed in the lower box within the window.
(6) Select SAVE SELECTION to insert the joist designation in the CASM Bar Joist Selection line in the lower part of the spreadsheet.

(7) Select PRINT SCRATCHPAD from the File pull-down menu to obtain a hardcopy of the spreadsheet.

(8) Select RTN TO START from the File pull-down menu to resume work in the Design Spreadsheet.

g. Select RETURN TO CASM from the File pull-down menu. The Excel program will be closed.

h. Reactivate the CASM program by selecting MAXIMIZE from the System menu if you are using a dual-screen workstation. Select RESTORE if you are using the single-screen workstation.

3. Proceed to the design of another element or revise the preliminary analysis of the current element as desired.

4. Select CANCEL in the Linear Elements dialog window to end work with the selected narrowly spaced element and be able to proceed to the design of the interior rolled shape girder.

5. The following procedure is necessary if SEND DATA TO FILE was selected:

a. SAVE the building project model to a file.

b. Select EXIT from the File pull-down menu to close CASM. An MS-DOS Executive window will appear.

c. Execute the SENDXL.EXE program to send the data in a file to the Excel spreadsheet programs. A Send Data to Excel dialog window will appear.

```
Send Data to Excel

Input: *.TXT
C:\CASM
1ABDATA2.TXT
1ABDATA1.TXT
1DATA.TXT
DEADLDS.TXT
DOOR.TXT
FRASINDER.TXT
FRAMEOUT.TXT
```

d. Select the appropriate datafile name from the list and select SEND. The Send data to Excel program will become an icon and Excel will be executed. The Open-Web Steel Joist Design Spreadsheet will appear.

e. Proceed to step 1-2 to select a joist size.

f. RESTORE the Send Data to Excel program from an icon after completion of step 1-2g.

g. Select another file to send to Excel or CLOSE the program window.

h. Execute CASM to design another element (double click on CASM.EXE file in MS-DOS Executive window).

J. Establish element parameters necessary to design a typical interior steel girder.

1. Steel should still be the selected material.
2. Select **ROLLED SECTIONS** from the Floor/Roof system category pull-down menu. Handles will appear on all the widely spaced elements.

3. Select the girder on gridline 2 between grids B and C. The selected element will be highlighted by a red dashed line. The Linear Elements dialog window will appear showing the dimensions of the selected element. An additional window will appear showing the element attributes.

4. Review the data shown and select **GUIDELINES** to be prompted with additional considerations for the element type selected.

   **Note:** Two element attributes dialog windows exist for steel rolled shapes: one for beams and the other for girders. Click on the visible portion of the hidden dialog window to view the hidden window.

5. Three options exist at this point:
   a. Select **CANCEL** to end consideration of that element type.
   b. Select a different widely spaced element type from the Floor/Roof pull-down menu.
   c. Continue on to preliminary analysis with the present element type selected.

**K. Preliminary analysis of a typical interior girder.**

1. Use the current dead + live load combination for analysis.

2. Select **PRELIMINARY** from the Design pull-down menu. An Analysis dialog window will appear.

3. Select appropriate options within the Analysis dialog window.
   a. Select **UNITS** of Feet and Kips.
   b. Do not check **DL = DECK + SELF WEIGHT**, since the girder is a noncomposite element.
c. Select OK to continue preparation for analysis of the girder element. A Connectivity dialog window will appear, and the left and right ends of the selected element will be highlighted on the floor plane.

4. Select appropriate connectivity options.
   a. Create a simple girder span by setting the left support as a HINGE and the right support as a ROLLER.
   b. Select OK to continue with the preliminary analysis. The tributary area for load calculations on the element will briefly appear on the floor plan followed by the loads and connectivity diagram for the selected load combination for analysis. A Self Weight dialog window will also appear.

5. Select appropriate self weight options.
   a. Add the estimated self weight to the smeared structural dead load.
      (1) Click the left mouse pointer within the pfl value box. A help dialog window for Steel: Rolled Sections - Beams will appear with an estimated midrange weight for the girder span.

      **Note:** Add the load values shown on the display to arrive at an approximate total load to find the appropriate load range within the help window. Once a klf total load column is identified, choose an element weight close to the actual span. Estimate the self weight to be 57 plf for this case.

      (2) Estimate the element’s self weight with guidance from the weights shown in the help window and type the magnitude in the pfl box.

   b. Click on OK and an Analysis File Name window will appear. The klf load shown on the dead load diagram will be updated to include the estimated self weight.

6. Enter the desired ANALYSIS FILE NAME and select YES if the Loads and Connectivity are correct as displayed.
7. Preliminary analysis of the element begins.
   a. When analysis is complete the shear, moment and relative deflection diagrams for the selected load combination will appear on the display. Simultaneously, a View Shear, Moment & Deflection dialog window will appear.
   b. Select any of the loads listed in the dialog window to have its shear, moment and relative deflection displayed.
   c. Click on OK to continue to the preliminary design of the girder.

L. Preliminary design of a typical girder.
   1. Make appropriate selections within the Excel Data dialog window.
      a. This time, turn on SEND DATA TO FILE and change the FILE NAME to BEAM1.TXT.
      b. Click on OK to continue. The data necessary to design the steel girder will be written to the selected file.
   2. Send the girder data file to Excel outside of CASM.
      a. Select CANCEL in Linear Elements dialog window; then SAVE the building project model to a file called STRUCT1.BLD.
b. Select EXIT from the File pull-down menu to close CASM. The MS-DOS Executive window will appear.

c. Execute the SENDXL.EXE program to send the data in a file to the Excel spreadsheet program. A Send Data to Excel dialog window will appear.

d. Select the data file name BEAM1.TXT from the list and select SEND. The Send data to Excel program will become an icon and Excel will be executed. The Steel Beam Design Spreadsheet will appear.

3. Design the girder within the Excel design spreadsheet.

a. The Preliminary Design Spreadsheet will appear, including a portion of the CASM beam selection table which shows wide flange sizes that satisfy the reaction, shear, moment and deflection values for the load combination analyzed.
b. Use the scroll bar to view the nonvisible portions of the spreadsheet.
c. Other system factors that may influence your selection can be found in CARDFILE from the Guidelines pull-down menu. CLOSE the Cardfile program when finished reviewing the additional factors.

d. Set the depth limit to 21.5 inches and select the lightest steel beam size. Based on the depth limit, the lightest section is a W21x57.

   (1) Select SELECT MEMBER from the Member pull-down menu to choose the desired beam size. A Member Size Selection dialog window will appear.

   (2) Click on the selected beam in the list and the selected beam size will be displayed in the lower box within the window.

   (3) Select SAVE SELECTION to insert the beam designation in the CASM Beam Selection line in the lower part of the spreadsheet.

e. Select PRINT SPREADSHEET from the File pull-down menu to obtain a hardcopy of the spreadsheet.

f. Test the influence of a change in floor finish from carpet to Thin-set terrazzo without having to go back to CASM.

   Note: Changes to load, span or spacing cannot be made on the preliminary design spreadsheet, since its data are obtained from the analysis done in CASM. A scratchpad spreadsheet is available to allow varying any of the parameters.

   (1) Select STEEL WIDE FLANGE from the Scratchpad pull-down menu. A steel beam scratchpad spreadsheet will appear.

   (2) Change the Superimposed area dead load to 53 psf to reflect a 7-psf dead load increase. Data contained in the scratchpad will be recalculated automatically.

   (3) Set the depth limitation to 21.5 inches.

   (4) Review the changed beam sizes in the Beam Selection Table and select the lightest section as the W18x65.
### STEEL BEAM PRELIMINARY SELECTION

**Project:** Corps Office Building  
**Date:** 2/23/90  
**Engr:**

**Location:** Vicksburg

**CASM Load & Analysis Data:**

<table>
<thead>
<tr>
<th>Method: Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Member ID: J1</td>
</tr>
<tr>
<td>Connectivity Hinge (Left)</td>
</tr>
<tr>
<td>Roller (Right)</td>
</tr>
<tr>
<td>Bm Span: 24.0 ft</td>
</tr>
<tr>
<td>Trib Width= 24.0 ft</td>
</tr>
<tr>
<td>Depth Limit= 21.5 in. max</td>
</tr>
<tr>
<td>Fy= 36.0 ksi</td>
</tr>
<tr>
<td>Fb=.66*Fy= 24 ksi</td>
</tr>
<tr>
<td>E = 29,000 ksi</td>
</tr>
<tr>
<td>Live l'd Def= L/360 -0.80 in</td>
</tr>
<tr>
<td>Total Def= L/240 -1.20 in</td>
</tr>
</tbody>
</table>

#### Load Combination: D + L

<table>
<thead>
<tr>
<th>Load</th>
<th>Factored Moments (k-ft)</th>
<th>Fact. Shears (k)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td>Left</td>
<td>Mid</td>
</tr>
<tr>
<td>Deed Ld</td>
<td>10.2</td>
<td>1.7</td>
</tr>
<tr>
<td>Sup Deed</td>
<td>79.5</td>
<td>13.3</td>
</tr>
<tr>
<td>Live</td>
<td>121.0</td>
<td>20.2</td>
</tr>
</tbody>
</table>

**Summary**

- Max: Moment = 210.6 k-ft
- Shear = 35.1 kips

#### CASM Beam Selection Table:

<table>
<thead>
<tr>
<th>Beam Width</th>
<th>Depth</th>
<th>Sx</th>
<th>Ix</th>
<th>Defl LL</th>
<th>Defl TL</th>
<th>N</th>
<th>ft</th>
<th>Bm Wgt</th>
</tr>
</thead>
<tbody>
<tr>
<td>W 12 x 79</td>
<td>12.4</td>
<td>12.08</td>
<td>107</td>
<td>662</td>
<td>-0.65</td>
<td>-1.14</td>
<td>6.0</td>
<td>23.6</td>
</tr>
<tr>
<td>W 18 x 60</td>
<td>18.2</td>
<td>7.56</td>
<td>106</td>
<td>964</td>
<td>-0.44</td>
<td>-0.77</td>
<td>4.6</td>
<td>23.4</td>
</tr>
<tr>
<td>W 21 x 57</td>
<td>21.1</td>
<td>6.56</td>
<td>111</td>
<td>1,170</td>
<td>-0.37</td>
<td>-0.64</td>
<td>4.1</td>
<td>22.8</td>
</tr>
<tr>
<td>W 14 x 74</td>
<td>14.2</td>
<td>10.07</td>
<td>112</td>
<td>796</td>
<td>-0.54</td>
<td>-0.95</td>
<td>5.5</td>
<td>22.6</td>
</tr>
<tr>
<td>W 16 x 67</td>
<td>16.3</td>
<td>10.24</td>
<td>117</td>
<td>954</td>
<td>-0.45</td>
<td>-0.79</td>
<td>5.4</td>
<td>21.6</td>
</tr>
<tr>
<td>W 18 x 65</td>
<td>18.4</td>
<td>7.59</td>
<td>117</td>
<td>1,070</td>
<td>-0.40</td>
<td>-0.70</td>
<td>4.3</td>
<td>21.6</td>
</tr>
</tbody>
</table>

**CASM Steel Beam Selection:**

<table>
<thead>
<tr>
<th>Beam Width</th>
<th>Depth</th>
<th>Sx</th>
<th>Ix</th>
<th>Defl LL</th>
<th>Defl TL</th>
<th>N</th>
<th>ft</th>
<th>Bm Wgt</th>
</tr>
</thead>
<tbody>
<tr>
<td>W 21 x 57</td>
<td>24.0 ft</td>
<td>111.0</td>
<td>Sx = 1,170.0</td>
<td>Defl = -0.37</td>
<td>-0.64</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(5) Select **SELECT MEMBER** from the Member pull-down menu to choose a desired beam size. A Member Size Selection dialog window will appear.

(6) Click on the selected beam designation in the list and the selected beam size will be displayed in the lower box within the window.

(7) Select **SAVE SELECTION** to insert the beam designation in the CASM Beam Selection line in the lower part of the spreadsheet.

(8) Select **PRINT SCRATCHPAD** from the File pull-down menu to obtain a hardcopy of the spreadsheet.

(9) Select **RTN TO START** from the File pull-down menu to resume work in the Design Spreadsheet.

### Return to the CASM program.

a. **CLOSE** the SendXL program.

b. Execute CASM and load the building project model by double clicking on the building file name STRUCT1.BLD in the MS-DOS Executive window. The last view of the floor plane will be displayed on the screen.
c. You are now able to continue to the design of another element.

M. Establish element parameters necessary to design a typical spandrel steel girder.
   1. Steel should still be the selected material.
   2. Select ROLLED SECTIONS from the Floor/Roof system category pull-down menu.
   3. Select the spandrel girder on gridline 1 between grids B and C.
   4. Review the data shown and select GUIDELINES to be prompted with additional considerations for the element type selected.
   5. Continue on to preliminary analysis with the present element type selected.

N. Preliminary analysis of a typical spandrel girder.
   1. Use the current dead + live load combination for analysis.

   Note: The exterior wall weight will be included in the superimposed dead load magnitude.

   2. Select PRELIMINARY from the Design pull-down menu.
   3. Select appropriate options within the Analysis dialog window.
      a. Select UNITS of Feet and Kips.
      b. Do not check DL = DECK + SELF WEIGHT, since the girder is a noncomposite element.
      c. Select OK to continue preparation for analysis of the girder element.
   4. Select appropriate connectivity options.
      a. Create a simple girder span by setting the left support as a HINGE and the right support as a ROLLER.
      b. Select OK to continue with the preliminary analysis.
   5. Select appropriate self weight options.
      a. Add an estimated self weight of 57 plf to the smeared structural dead load. This magnitude was estimated based on a summation of the loads shown on the display (approximately 2.4 klf) and the span of 24 feet.
      b. Click on OK to continue.

```
1.00 Dead (klf) 0.10

1.00 Superimposed Dead (klf) 1.58

1.00 Live (klf) 0.84
```

PRELIM
6. Enter the desired **ANALYSIS FILE NAME** and select **YES** if the Loads and Connectivity are correct as displayed.

7. Preliminary analysis of the element begins.
   a. When analysis is complete the shear, moment and relative deflection diagrams for the selected load combination will appear on the display.

   ![Shear (k) vs. Total Combined Load](image)

   ![Moment (kft) vs. Total Combined Load](image)

   ![Deflection vs. Total Combined Load](image)

   b. Select any of the loads listed in the dialog window to have its shear, moment and relative deflection displayed.

   c. Click on **OK** to continue to the preliminary design of the spandrel girder.

   0. Preliminary design of a typical spandrel girder.

   1. Make appropriate selections within the Excel Data dialog window.
      a. Choose one of the following two options:
         (1) Select **EXECUTE EXCEL** to go directly to the Excel steel beam spreadsheet.
         (2) Select **SEND DATA TO FILE** and enter a **FILE NAME** to defer design to a later date.

         **Note:** This is the proper choice if you had difficulty in running Excel from CASM. Follow the procedure described in step L-2 to pass the data on to Excel.

      b. Click on **OK** to continue.

   2. Design the spandrel girder within the Excel design spreadsheet.
      a. The Preliminary Design Spreadsheet will appear.
      b. Use the scroll bar to view the nonvisible portions of the spreadsheet.
      c. Use **CARDFILE** to review factors that may influence your decisions.

         **Note:** Spandrel members supporting brick masonry shall have their total load deflection limited to L/600.

      d. No depth limit is required for the spandrel girder; however, set the **TOTAL DEFL** to 600. The W24x55 is the lightest steel beam size displayed in the selection table.
(1) Select SELECT MEMBER from the Member pull-down menu to choose the desired beam size.
(2) Click on the selected beam in the list.
(3) Select SAVE SELECTION to insert the beam designation in the CASM Beam Selection line in the lower part of the spreadsheet.

e. Select PRINT SPREADSHEET from the File pull-down menu to obtain a hardcopy of the spreadsheet.

f. Select RETURN TO CASM from the File pull-down menu. The Excel program will be closed.

g. If you activated Excel through CASM, reactivate the CASM program by selecting MAXIMIZE from the System menu if you are using a dual-screen workstation. Select RESTORE if you are using the single-screen workstation.

Note: If data were sent to a file, reexecute CASM and load your previous project data file.

3. Proceed to the design of another element or revise the preliminary analysis of the current element as desired.

4. Select CANCEL in the Linear Elements dialog window to end work with the selected widely spaced element and to be able to proceed to the design of the metal form deck.

P. Establish element parameters necessary to design the metal form deck.

1. Steel should still be the selected material.

2. Select FORM DECK from the Surface 1-Way types contained in the Floor/Roof system category pull-down menu. Handles will appear on the one-way surface element symbols.

3. Select the handle within the bay between the grids B to C and 1 to 2.

4. Review the two attribute dialog windows shown and select GUIDELINES to be prompted with additional considerations for the element type selected.

5. Continue on to preliminary analysis.
Q. Preliminary analysis of the metal form deck alone.

1. Change the current load combination for form deck analysis to dead load only.

   Note: The wet concrete and the deck weight are the only loads acting on the form deck.

   a. Change the LIVE load FACTOR to 0.0. The dead load factor is currently 1.0.
   b. Select ADD to add the dead only combination to the list and make it current.
   c. Click on OK to end working with load combinations.

2. Select PRELIMINARY from the Design pull-down menu.

3. Select appropriate options within the Analysis dialog window.
   a. Select UNITS of Feet and Pounds.
   b. Do not check DL = DECK + SELF WEIGHT, since the form deck is a noncomposite element.
   c. Select OK to continue preparation for analysis of the form deck element. The Decking Analysis dialog window will appear instead of the connectivity dialog window. The deck spans will be numbered across the bay, and one edge will be highlighted red on the display.

4. Select appropriate decking analysis options.
   a. Select the appropriate number of spans as three.
   b. Locate the position of the typical 1-foot strip for analysis.
      (1) The distance from the highlighted edge to the centroid of the 1-foot strip is defaulted to the center of the bay and is shown in the dialog window as 12.0 feet. This distance can be changed to re-position the 1-foot strip where desired.
      (2) Select the Starting Span Number of the three spans to be analyzed. This positions the three spans within the bay along the 1-foot strip.
   c. Review GUIDELINES for information on whether to include superimposed dead load.
   d. Turn off INCLUDE SUPERIMPOSED DEAD LOAD.
   e. Select OK to continue with the preliminary analysis.

5. Enter the desired ANALYSIS FILE NAME and select YES if the Loads and Connectivity are correct as displayed.
1.00 Dead (plf)

1.00 Superimposed Dead (plf)

Note: Connectivity is automatically set so the first support is a hinge and all remaining supports are rollers. Thus, the deck is continuous over the three spans.

   a. When analysis is complete the shear, moment and relative deflection diagrams for the selected load combination will appear on the display.

   b. Select any of the loads listed in the dialog window to have its shear, moment and relative deflection displayed.

   Note: For this analysis there is only one individual load type.

   c. Click on OK to continue to the preliminary design of the form deck alone.

   R. Preliminary design of the metal form deck alone.

   Not Yet Implemented
S. Save the scheme 1a project data file as SCHEME1A.BLD.
Solution: Scheme 1b

A. OPEN the scheme 1a datafile name: SCHEME1A.BLD. The steps contained in A through D for scheme 1a are the same.

B. Draw Structure.
   1. Select the DRAW STRUCTURE tool palette.
   2. Delete the narrowly spaced elements within the center bay, which is bounded by grids B and C between grids 2 and 3.
      a. Select DELETE STRUCTURE from the Edit pull-down menu. Handles will appear on each strutral element to delete.

      Note: Only one handle will appear for a series of elements within a bay. It is not possible to delete a single element within a series of elements.

      b. Select the joist handle contained in the center bay and all the joists will be removed from the display.
      c. Double click the right mouse key to exit the delete structure command.

   3. Insert narrowly spaced elements spanning in the east/west direction within the center bay spaced at 24 inches on center.

   4. Insert a one-way surface of metal form deck and concrete fill above the joists.

      Note: Since the joists run parallel to the interior girder, which we intend to design, a surface element needs to be drawn across the rectangle of space in between the girder and the adjacent parallel joist so that the rectangle is not interpreted by CASM to be an opening.

C. The Independent load cases are the same as for scheme 1A.
   1. Select the LOADS AND DESIGN tool palette.

D. Establish element parameters necessary to design a typical interior steel girder.
   1. Steel should still be the selected material.
   2. Select ROLLED SECTIONS from the Floor/Roof system category pull-down menu.
   3. Select the typical interior girder on gridline 2 between grids B and C.
   4. Review the data shown and select GUIDELINES to be prompted with additional considerations for the element type selected.
   5. Continue on to preliminary analysis with the present element type selected.

E. Preliminary analysis of a typical Interior girder.
   1. Use the dead + live load combination for analysis.
   2. Select PRELIMINARY from the Design pull-down menu.
   3. Select appropriate options within the Analysis dialog window.
      a. Select UNITS of Feet and Kips.
      b. Do not check DL = DECK + SELF WEIGHT, since the girder is a noncomposite element.
c. Select OK to continue preparation for analysis of the girder element.

4. Select appropriate connectivity options.
   a. Create a simple girder span by setting the left support as a **HINGE** and the right support as a **ROLLER**.
   b. Select OK to continue with the preliminary analysis.

5. Select appropriate self weight options.
   a. Add an estimated self weight of 36 plf to the smeared structural dead load. This magnitude was estimated based on a summation of the loads shown on the display (approximately 1.56 klf) and the span of 24 feet.

   ![Graph showing load distribution](image)

   b. Click on OK to continue.

6. Enter the desired **ANALYSIS FILE NAME** and select YES if the Loads and Connectivity are correct as displayed.

7. Preliminary analysis of the element begins.
   a. When analysis is complete the shear, moment and relative deflection diagrams for the selected load combination will appear on the display.

   ![Diagram showing shear, moment, and deflection](image)

   b. Select any of the loads listed in the dialog window to have its shear, moment and relative deflection displayed.

   c. Click on OK to continue to the preliminary design of the typical interior girder.
F. Preliminary design of a typical Interior girder.

1. Make appropriate selections within the Excel Data dialog window.
   a. Choose one of the following two options:
      (1) Select EXECUTE EXCEL to go directly to the Excel steel beam spreadsheet.
      (2) Select SEND DATA TO FILE and enter a FILE NAME to defer design to a later date.
   >> Note: This is the proper choice if you had difficulty in running Excel from CASM. Follow the procedure described in step L-2 of scheme 1A to pass the data on to Excel.
   b. Click on OK to continue.

2. Design the interior girder within the Excel design spreadsheet.
   a. The Preliminary Design Spreadsheet will appear.
   b. Use the scroll bar to view the nonvisible portions of the spreadsheet.
   c. Use CARDFILE to review factors that may influence your decisions.
   d. Set the depth limit to 22.5 inches. The W16x40 is the lightest steel beam size displayed in the selection table.
   >> Note: This selection has a self weight greater than estimated by 4 plf.
      (1) Select SELECT MEMBER from the Member pull-down menu to choose the desired beam size.
      (2) Click on the selected beam in the list.
      (3) Select SAVE SELECTION to insert the beam designation in the CASM Beam Selection line in the lower part of the spreadsheet.
   e. Select PRINT SPREADSHEET from the File pull-down menu to obtain a hardcopy of the spreadsheet.
   f. Select RETURN TO CASM from the File pull-down menu. The Excel program will be closed.
   g. If you activated Excel through CASM, reactivate the CASM program by selecting MAXIMIZE from the System menu if you are using a dual-screen workstation. Select RESTORE if you are using the single-screen workstation.
   >> Note: If data were sent to a file, reexecute CASM and load your previous project data file.

3. Proceed to the design of another element or revise the preliminary analysis of the current element as desired.

4. Select CANCEL in the Linear Elements dialog window to end work with the selected widely spaced element and to be able to proceed to the design of other element types.

G. Investigate the influence of a partition load perpendicular to the narrowly spaced elements in the center of the center bay.

1. Prepare a partition load based on the following components:
Type over the previous exterior wall data and select ASSIGN.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>psf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish</td>
<td>Gypboard 5/8&quot;</td>
<td>3.1</td>
</tr>
<tr>
<td>Sheathing</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>Structure</td>
<td>Stl Stud 16ga 4&quot;@16</td>
<td>1.1</td>
</tr>
<tr>
<td>Insulation</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>Finish</td>
<td>Gypboard 5/8&quot;</td>
<td>3.1</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>7.3</td>
</tr>
</tbody>
</table>

2. **ASSIGN** the load to the center of the center bay and perpendicular to the joist span. Set the wall height to 12 feet in the Wall Height dialog window.

3. Select **STOP** to end working with wall dead loads.

4. Establish the parameters upon which analysis can be performed.
   a. Select material: **STEEL**.
   b. Select component from the Floor/Roof pull-down menu: **NARROWLY SPACED**: **OPEN WEB JOISTS - K** and click on one of the handles in the center bay.
   c. Review data in dialog windows and Guidelines.
   d. Continue on to Preliminary Analysis.

5. Preliminary Analysis of the open-web steel joist.
   a. Select load combination: Dead + Live.
   b. Select **PRELIMINARY** from the Design pull-down menu.
   c. Select units: **FEET and POUNDS**.
   d. Turn off **DL = DECK + SELF WEIGHT**.
   e. Select connectivity: simple span: **HINGE and ROLLER**.
   f. Estimate self weight: **0.0 plf**.

   **Note:** Joist weight was smeared into the floor dead load.

   g. Review loads and connectivity displayed.

   **Note:** The partition load is displayed as a concentrated load at midspan.

   h. Enter an appropriate analysis file name.
   i. Review the shear, moment and relative deflection diagrams on the display for any of the load cases shown in the window.

6. Preliminary Design of the open-web steel joist.
   a. Make appropriate selections within the Excel Data dialog window.
   b. Design the open-web steel joist within the Excel Preliminary Design spreadsheet.

   (1) Set depth limit: 24 inches.
   (2) Set deflection limits: Total L/240, Live L/360.
c. Make member selection: 16K2

Note: The joist size is the same as without the concentrated partition load in scheme 1a and is at the deflection and allowable moment limit for this joist size.

d. Select RETURN TO CASM from the File pull-down menu.

7. Return to the CASM program.

H. Save the scheme 1b as filename: SCHEME1B.BLD.
Solution: Scheme 2a

A. OPEN the scheme 1a datafile name: SCHEME1A.BI. D. The steps contained in A through D for scheme 1a are the same.

B. Draw Structure.
1. Select the DRAW STRUCTURE tool palette.
2. Delete all the narrowly spaced elements.
3. Insert widely spaced elements at third points spanning in the east/west direction within the center bay.
4. Insert widely spaced elements at third points spanning in the north/south direction in the bay bounded by grid lines B-C and 1-2.
5. Insert a one-way surface above the beams.

>> Note: A surface must be drawn over widely spaced elements which are contained between grid lines since they are not assumed to have a surface transferring load to them.

C. Develop the independent load cases for this construction type.
1. Select the LOADS AND DESIGN tool palette.
2. Delete the Floor Type 1 Assigned dead load.
   a. Turn on SHOW DEAD loads to view current assigned dead loads.

>> Note: Only displayed loads can be deleted.
   b. Select DELETE LOAD from the Loads pull-down menu. Handles appear at the centroids of all assigned dead loads.
   c. Select the appropriate handle to delete Floor Type 1 dead load. The load type will disappear from the display and handles will appear on any remaining dead loads to delete.

>> Note: The Floor Type 1 dead load has only been removed from the building model. It still exists In the floor dead load list.
   d. Double click the right mouse key to stop deleting loads.
3. Prepare the dead load based on the given load list and floor construction cross section.

4. ASSIGN Floor Type 2 over the entire floor area.

5. Select STOP to end working with floor dead loads.

6. The given live load has not changed from scheme 1 and is still assigned to the entire floor.

D. Establish element parameters necessary to design the typical third point beams within the center bay.

1. Select material: STEEL.

2. Select component from the Floor/Roof pull-down menu: WIDELY SPACED ROLLED SECTIONS and click on one of the handles in the center bay.

3. Review data in dialog windows and Guidelines.

4. Continue on to Preliminary Analysis.

E. Preliminary Analysis of the third point beam.

1. Select load combination: Dead + Live.

2. Select PRELIMINARY from the Design pull-down menu.

3. Select units: FEET and KIPS.

4. Turn off DL = DECK + SELF WEIGHT.

5. Select connectivity: simple span : HINGE and ROLLER.


Note: Beam weight was not smeared into the floor dead load.

7. Turn on UPDATE AREA STRUCTURE LOADS.

Note: This will smear the estimated beam weight into the floor type 2 area load.

8. Review loads and connectivity displayed.
9. Enter an appropriate analysis file name.

10. Review the shear, moment and relative deflection diagrams on the display for any of the load cases shown in the window.

**F. Preliminary Design of the third point beam.**

1. Make appropriate selections within the Excel Data dialog window.

2. Design the third point beam within the Excel Preliminary Design spreadsheet.
   a. Set depth limit: 22.5 inches.
   d. Select RETURN TO CASM from the File pull-down menu.

3. Return to the CASM program.

**G. Establish element parameters necessary to design the typical Interior column line girder along grid 2 between grids B and C.**

1. Select material: STEEL.

2. Select component from the Floor/Roof pull-down menu: WIDELY SPACED ROLLED SECTIONS and click on the handle on grid line 2.

3. Review data in dialog windows and Guidelines.

4. Continue on to Preliminary Analysis.

**H. Preliminary Analysis of the typical Interior girder.**

1. Select load combination: Dead + Live.

2. Select PRELIMINARY from the Design pull-down menu.

3. Select units: FEET and KIPS.

4. Turn off DL = DECK + SELF WEIGHT.

5. Select connectivity: simple span : HINGE and ROLLER.

>>> Note: The calculation of reactions of the perpendicular beams which frame into the girder are performed automatically. The self weight of the perpendicular beams is included in the updated floor type 2 area dead load.

>>> Note: Simple span connectivity assumptions are used when automatic calculation of beam reactions are performed.

>>> Note: The display will highlight the tributary areas concurrent with the calculation of beam reactions.

6. Estimate self weight: 45.0 plf.

>>> Note: The estimated beam weights shown in the help window are based on uniform loads. No help is available for concentrated loads along a span, and an educated guess is required.

7. Review loads and connectivity displayed.

8. Enter an appropriate analysis file name.
9. Review the shear, moment and relative deflection diagrams on the display for any of the load cases shown in the window.

I. Preliminary Design of the typical Interior girder.
1. Make appropriate selections within the Excel Data dialog window.
2. Design the typical interior girder within the Excel Preliminary Design spreadsheet.
   a. Set depth limit: 22.5 inches.
   c. Make member selection: W18x40.
   d. Select RETURN TO CASM from the File pull-down menu.
3. Return to the CASM program.
J. Save the scheme 2a as filename: SCHEME2A.BLD.
Solution: Scheme 2b

A. OPEN the scheme 2a datafile name: SCHEME2A.BLD. The steps contained in A through D for scheme 2a are the same.

B. Draw Structure.
   1. Select the DRAW STRUCTURE tool palette.
   2. Insert widely spaced elements at third points spanning in a checkerboard fashion to the left and to the right of the currently framed bays.
   3. Insert a one-way surface above the beams within the four bays added in step 2.

C. The same assigned independent load cases apply as for scheme 2A.

D. Establish element parameters necessary to design grid line 2 as a continuous girder for three spans.
   1. Select material: STEEL.
   2. Select component from the Floor/Roof pull-down menu: WIDELY SPACED: ROLLED SECTIONS and click on the left bay along grid line 2 between grids A and B.

   Note: The shears, moments and deflections of the Initial span selected will be passed on to the preliminary design spreadsheet.

   Note: The left end span has been selected for analysis since it will produce the maximum negative and positive moments as well as the maximum deflection for a three-span continuous beam.

   3. Review data in dialog windows and Guidelines.
   4. Continue on to Preliminary Analysis.

E. Preliminary Analysis of the three-span continuous girder line.
1. Select load combination: Dead + Live.
2. Select PRELIMINARY from the Design pull-down menu.
3. Select units: FEET and KIPS.
4. Turn off DL = DECK + SELF WEIGHT.
5. Select connectivity for the continuous three spans as follows:

```
    Connectivity
<table>
<thead>
<tr>
<th>Left</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>O</td>
</tr>
</tbody>
</table>
Adjacent Spans | O     | O     |
   | O     | O     |
   | O     | O     |
   | O     | O     |
   | O     | O     |
```

- a. Select a hinge for the left end of the highlighted left span and a roller for a continuous beam at the right end.
- b. Set ADJACENT SPANS = 2 to the right side of the initial span selected.

Note: If the number of drawn adjacent spans is less than the number set, an error message will appear.

Note: If the number of adjacent spans is set to zero, and you have selected a continuous support, CASM will search for a cantilevered support location.

Note: The maximum total number of continuous spans that can be analyzed is four.

- c. Click on OK. A Connectivity dialog window will appear and a red dot will highlight the support location.
- d. Select a CONTINUOUS BEAM ROLLER and click on OK. Another Connectivity dialog window will appear and another red dot will highlight the support location.
- e. Select a ROLLER and click on OK.

6. Estimate girder seat weight: 35.0 plf.

Note: The self weight help window applies to simple span members only. An educated guess is required for continuity situations.

Note: The girder self weight was not smeared into the floor dead load.
F. Preliminary Design of the exterior span of the continuous girder.

1. Make appropriate selections within the Excel Data dialog window.
2. Design the exterior bay girder within the Excel Preliminary Design spreadsheet.
   a. Set depth limit: 22.5 inches.
   c. Make member selection: W18x35.
   d. Select RETURN TO CASM from the File pull-down menu.
3. Return to the CASM program.
G. Save the scheme 2b as filename: SCHEME2B.BLD.
Solution: Scheme 3

A. **OPEN** the scheme 2b datafile name: SCHEME2B.BLD. The steps contained in A through D for scheme 2b are the same.
   a. Select **SAVE AS** from the FILE pull-down menu and rename the file as scheme3.bld.

B. **Draw Structure.**
   1. Select the **DRAW STRUCTURE** tool palette.
   2. Delete the third point beams that span in the north/south direction. This involves three bays.
   3. Delete the surface element within those same three bays.
   4. Insert widely spaced elements at third points spanning in the east/west direction within the three empty bays.
   5. Insert a one-way surface above the beams within the three bays where beams have been added.

C. **Develop the independent load cases for this construction type.**
   1. Select the **LOADS AND DESIGN** tool palette.
   2. Delete the Floor Type 2 Assigned dead load.
      a. Turn on **SHOW DEAD** loads to view current assigned dead loads.
      b. Select **DELETE LOAD** from the Loads pull-down menu.
      c. Select the appropriate handle to delete Floor Type 2 dead load.
      d. Double click the right mouse key to stop deleting loads.
   3. Prepare the dead load based on the given load list and floor construction cross section.
   4. **ASSIGN** Floor Type 3 over the entire floor area.
   5. Select **STOP** to end working with floor dead loads.
   6. The given live load has not changed from scheme 1 and is still assigned to the entire floor.

D. **Establish element parameters necessary to design grid line 2 as a continuous girder for three spans.**
   1. Select material: **CONCRETE**.
   2. Select component from the Floor/Roof pull-down menu: WIDELY SPACED BEAM-C.I.P and click on the left bay along grid line 2 between grids A and B.

   **Note:** The left end span has been selected for analysis since it will produce the maximum negative and positive moments as well as the maximum deflection for a three-span continuous beam.

   3. Review data in dialog windows and Guidelines.
   4. Continue on to Preliminary Analysis.

E. **Preliminary Analysis of the three-span continuous girder line.**
   1. Select load combination: 1.4 Dead + 1.7 Live.
2. Turn on **PATTERN OCCUPANCY LIVE LOAD** in the Load Combinations dialog window and click on **OK**.

![Load Combinations dialog window](image)

- **Dead**: factor 1.40
- **Wind**: factor 0.00
- **Seismic**: factor 0.00
- **Temperature**: factor 0.00
- **Soil**: factor 0.00

3. Incorporate live load reduction option.
   a. Select **OCCUPANCY (LL)** from the Loads pull-down menu.
   b. Select **LLR GUIDELINES** to review the code requirements regarding live load reductions.

   **Note**: The tributary area for each beam span is less than 400 square feet and thus no reduction will actually be applied.

c. Click on **OK** to remove the Guidelines window.
d. Turn on **APPLY LIVE LOAD REDUCTION**.
e. Select **STOP** to end work with the live load list.

4. Select **PRELIMINARY** from the Design pull-down menu.

5. Select units: **FEET** and **KIPS**.

6. Turn off **DL = DECK + SELF WEIGHT**.

7. Select connectivity for the continuous three spans as follows:
   a. Select a **FRAMED CONTINUITY** support for the left and right end of the highlighted left span.
   b. Set **ADJACENT SPANS = 2** to the right side of the initial span selected. Leave the left adjacent spans equal to zero.
c. Click on OK. A Column Connectivity dialog window will appear and a red dot will highlight the left support location.

d. Insert COLUMN HEIGHT = 14.0 feet for the Column Below Beam.

Note: This is necessary since the model does not contain a floor level below the one used for framing.

e. Set the end of the column above and below as FIXED.

f. Click on OK. A Column Connectivity dialog window will appear and a red dot will highlight the right support location.

g. Repeat steps d through f for the right support of the span to be designed. The Connectivity dialog window will appear and a red dot will highlight the support location at the right end of the middle span.

h. Select a FRAMED CONTINUITY support and click on OK. The Column Connectivity dialog window will appear.

i. Repeat steps d through f for the support. The Connectivity dialog window will appear.

j. Select a FRAMED CONTINUITY support and click on OK. The Column Connectivity dialog window will appear.

k. Repeat steps d and e, then click on OK. A Live Load Reduction dialog window will appear.

l. Enter the desired LLR Filename as: LLR.TXT

Note: The live load reduction calculation output file can be viewed and printed similar to that for wind and snow output. A sample of the output is listed below.

```
Project : Corps Office Building
Location : Vicksburg
Design Load: Tri-Services
Time : Tue Mar 13, 1990 11:54 PM

************** Live Load Reduction **************
Office: w/smear corridor (Lo) : 70.0 psf
Tributary area (TA) : 192.0 sf
Area of influence (Ai) = 2*TA for beams;
Ai = 384.0 sf
```
Ai 400.0 sf
No live load reduction taken.
L = Lo
+-----------------------------+
   L = 70.00 psf
+-----------------------------+

   a. Select the Estimated Self Weight current value. A Concrete Beam Estimated Self Weight dialog window will appear.

b. Select CONTINUOUS EXTERIOR SPAN and the \( L/h \) ratio will become 15 in compliance with the minimum ratio required by the ACI Code to avoid deflection calculations.

c. Enter the slab thickness \( t = 4.0 \) inches. The value of \( h-t \) will become 15.0 inches.

d. Revise the beam width \( b = 10.0 \) inches.

e. Select NLWT @ 150 PCF to pass the 156.3 plf self weight to the Self Weight dialog window.
f. Click on **OK** to close the Concrete Beam dialog window.
g. Click on **OK** to display the updated dead load plf diagram. A Draw Patterned Live Loads dialog window will appear.

10. Review the loads and connectivity displayed and select **YES** to draw the patterned live loads.

11. Review the live load patterns displayed.

12. Enter an appropriate analysis file name and click on **OK**.

13. Review the shear, moment and relative deflection diagrams on the display for any of the load cases shown in the window.
F. Preliminary Design of the exterior span of the continuous girder.

Not Yet Implemented

G. Save the scheme 3 as filename: SCHEME3.BLD.
EXAMPLE TWO: Irregular Framed Building

**Given:** A three-story office building. A typical bay will be 20 feet by 20 feet. The floor-to-floor height is 14 feet. The roof slope is 4.8 in 12. Refer to the example drawings shown on the following pages for the overall dimensions of the building.

Refer to the example drawings on the following pages for the dead load and occupancy live loads.

**Required:** Perform a preliminary analysis and design for the framing example shown on the following pages. Perform generation of snow and wind loads.
Choose STACK ON GROUND and then the CUBE shape to add the shape.

Use the mouse to drag the cube to a location on the ground plane. Use the Dimensions dialog box to reference the location of the cube on the ground plane.
Choose the DRAG PLANE icon to manipulate the sides of the cube to the proper dimensions.
Choose STACK ON LAST SHAPE and then select CUBE to add another cube on top of the first floor cube.

Choose DRAG PLANE to manipulate the dimensions of the second floor cube.
Select CUBE to add a third floor cube on top of the second floor cube.

Choose DRAG PLANE to manipulate the dimensions of the third floor cube.
Choose PRISM to add a gable roof shape to the third floor cube.

Select DRAG EDGE to lower the height of the gable roof.
The overhang on the east side of the building is a little more complicated to model. The goal is to model a sloped overhang that is supported by 3 columns. The completed overhang is shown here in several views.
With STACK ON SHAPE option enabled, choose the VERTICAL PLANE shape to add plane that is perpendicular to the wall of first floor cube. (The VERTICAL PLANE attaches by a thin edge so when it is stacked on a wall, it becomes horizontal.)

Hold the right button down on the mouse to lock the movement of the plane in the z-axis (up and down). While holding the right button down on the mouse, drag the mouse to move the plane to a higher position indicated in the Dimensions dialog box.
To adjust the size of the overhang, choose DRAG PLANE and select the thin south plane of the overhang. Drag the mouse until the dimension is 40 ft in the North-South (N-S) direction.

Repeat the same operation of dragging a plane by choosing the outside thin plane of the overhang and dragging the mouse until the overhang is 12 ft wide in the East-West (E-W) direction.
Change the view of the building by lowering the view height in the VIEW tool palette. This is done to add a column to the underside plane of the overhang. The plane that you are adding a shape to must be in your direct line of sight in order to choose it.

With the STACK ON PLANE option chosen, click on the column shape to add it to the underside of the overhang. Drag the mouse to position the column near the corner of the overhang.
The height of the column defaults to 20 ft, so the column extends below the ground plane. To change the height of the column so it rests on the ground plane, select the SLICE icon. You must pick the shape that will be sliced into two shapes (column) and then you must pick the plane that will act as the dividing plane (the bottom plane of the first floor cube). These selections are made by clicking on the handles (circular dots) that appear on the shapes.

With the column broken into two shapes, choose the DELETE SHAPE icon and pick the lower shape of the column to delete it.
This close-up of the column shows that it is not resting on the ground plane after being cut.

To make the shed roof slanted, the edges of the shed can be dragged downward. This is a two-step process: first, dragging the lower edge of the shed, and second, dragging the upper edge of the shed.

To drag the lower edge of the shed, change your view so that the lower edge of the shed is directly in the line of sight.
Select DRAG EDGE and choose the lower outside edge of the shed to drag it lower. Use the Dimensions dialog box to check the slope.

Now change your view and repeat the process for the upper outside edge of the shed.
Select DRAG EDGE again and drag the upper outside edge of the shed lower to match the slope of the lower edge.

The shed is now sloping. The column, however, is now too tall and needs to be cut to fit underneath the shed.
The top of the column is cut by using the SLICE icon. The column is cut with the underside plane of the shed. Once the column is cut, use the DELETE OBJECT icon to delete the upper portion of the column. This close-up shows the top of column matches the slope of the shed.

The last step is to duplicate the columns so there are three columns supporting the shed. Change your view, select the DUPLICATE icon, fill in the Duplicate dialog box and choose the object you want to duplicate, in this case, the column.
Fill in the Duplicate dialog box with 2 objects in the North-South direction with a spacing of 17.25 feet, then click on the OK button. This adds 2 more columns, as shown below.

The model is now complete.
Choose the 3-D icon to change the view to a solid 3-D image.
Select DEFINE GRID icon to add a grid to a plane in the model. You can modify several parameters in the Define Grid dialog box.
Openings can be added by selecting the ADD OPENING icon and drawing an opening on the plane. Continuous openings (openings that exist through all floors) can be specified by clicking the Continuous opening box.
To add walls, select the WALLS icon, choose the orientation, define the dimensions of the wall, and draw the wall. Walls that span all floors can be defined by clicking the All Floors box.
To add a column at a grid intersection, select the COLUMN AT ONE GRID INTERSECTION icon. Define the orientation and height and indicate if the column extends through all floors.

There is another column command called COLUMN AT ALL GRID INTERSECTIONS that will add a column at all grid intersection points.
To add beams, select the WIDELY SPACED icon and choose the orientation, the number of elements, and offsets. The spacing is automatically calculated depending on the size of the bay that is receiving the beams.

There is another command for beams, called BEAMS AT ALL GRID LINES, that will add beams between all grid intersection points.
To add decking, select the SURFACE ELEMENTS icon, define the orientation of the surface, and draw the surface.
Structure can be viewed in 3-D easily by hiding the structure in the SHOW STRUCTURE command under the VIEWPOINT Options menu.
Define the Floor Deadloads with the FLOOR DEADLOAD icon.
Add Occupancy Live Loads with the FLOOR LIVE LOAD icon.
Live Loads (psf)

Loads can be viewed by sections or in 3-D.
To perform a Preliminary Design of a member, select the type of member from the FLOOR/ROOF menu. In this case, we select ROLLED SECTION under WIDELY SPACED member type. Then choose a beam to analyze.

After the beam is chosen, these dialog boxes appear. These dialog boxes give you general information to estimate how well this material meets the member usage.

To continue the Preliminary Design, apply load combinations by selecting the LOAD COMBINATION icon and defining a load combination.
To continue the Preliminary design, select the PRELIM icon and the connectivity dialog box appears. Click on the type of supports for the beam and define whether the beam is continuous through adjacent spans.

If this is what you want for this beam, click on OK and the loads are displayed for the beam. This is shown on the following pages for a cantilever beam and a continuous span beam.
This is the load combination for beam C3-C5.

This is the shear moment diagram for beam C3-C5.
**PROBLEMS COMPLETED**

**********************************************************
* TWO DIMENSIONAL FRAME ANALYSIS PROGRAM *
**********************************************************

2-D FRAME ANALYSIS-V 8/77 RUN-Sun Aug 13, 1989 11:44 AM

********************************************************** INPUT  **********************************************************

Demonstration -- Total Combined Load

NUMBER OF ELEMENTS = 22
NUMBER OF NODAL POINTS = 23
NUMBER OF MATERIALS = 1
NUMBER OF ELEMENT TYPES = 1
NUMBER OF ELASTIC SUPPORT TYPES = 0
NUMBER OF FIXED END FORCE TYPES = 0

MATERIAL TYPES
---------------
UNITS: INCHES, KIPS

<table>
<thead>
<tr>
<th>MATERIAL</th>
<th>YOUNG'S MODULUS</th>
<th>POISSON'S RATIO</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.0000</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

MEMBER PROPERTIES
------------------
UNITS: INCHES

<table>
<thead>
<tr>
<th>ELEMENT TYPE</th>
<th>AXIAL AREA</th>
<th>SHEAR AREA</th>
<th>MOMENT OF INERTIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1000.0000</td>
<td>0.0000</td>
<td>1.0000</td>
</tr>
</tbody>
</table>
JOINT DATA

UNITs: FEET, KIPS

<table>
<thead>
<tr>
<th>NODE CODE</th>
<th>NODAL COORDINATES</th>
<th>NODAL FORCES AND MOMENTS</th>
<th>ELASTIC SUPPORT TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 110</td>
<td>10.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2 0</td>
<td>12.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3 0</td>
<td>14.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>4 0</td>
<td>16.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>5 0</td>
<td>16.67</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>6 0</td>
<td>18.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>7 0</td>
<td>20.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>8 0</td>
<td>22.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>9 0</td>
<td>23.33</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>10 0</td>
<td>24.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>11 0</td>
<td>26.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>12 0</td>
<td>28.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>13 110</td>
<td>30.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>14 0</td>
<td>30.40</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>15 0</td>
<td>30.80</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>16 0</td>
<td>31.20</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>17 0</td>
<td>31.60</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>18 0</td>
<td>32.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>19 0</td>
<td>32.40</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>20 0</td>
<td>32.80</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>21 0</td>
<td>33.20</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>22 0</td>
<td>33.60</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>23 0</td>
<td>34.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

MEMBER DATA

<table>
<thead>
<tr>
<th>ELE</th>
<th>NODE I</th>
<th>NODE J</th>
<th>MAT TYPE</th>
<th>ELE TYPE</th>
<th>ELE CODE</th>
<th>F.E.F. TYPE</th>
<th>REL KIJ</th>
<th>STIFF KJI</th>
<th>CARRY OVER</th>
<th>FACTOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>4</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>5</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>6</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>7</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>8</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>9</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>10</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>11</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>12</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>13</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>14</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>4.00</td>
<td>4.00</td>
<td>0.50</td>
<td></td>
</tr>
</tbody>
</table>
### Applied Joint Loads and Support Reactions

**Units:** Feet, Kips

<table>
<thead>
<tr>
<th>Node</th>
<th>Force X</th>
<th>Force Y</th>
<th>Moment Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.000</td>
<td>2.400</td>
<td>-0.000</td>
</tr>
<tr>
<td>2</td>
<td>0.000</td>
<td>2.400</td>
<td>4.799</td>
</tr>
<tr>
<td>3</td>
<td>0.000</td>
<td>2.400</td>
<td>-9.598</td>
</tr>
<tr>
<td>4</td>
<td>0.000</td>
<td>2.400</td>
<td>-14.398</td>
</tr>
<tr>
<td>5</td>
<td>-0.158</td>
<td>-15.957</td>
<td>0.000</td>
</tr>
<tr>
<td>6</td>
<td>-0.158</td>
<td>-15.786</td>
<td>0.000</td>
</tr>
<tr>
<td>7</td>
<td>0.000</td>
<td>0.000</td>
<td>-0.000</td>
</tr>
<tr>
<td>8</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>9</td>
<td>0.000</td>
<td>-2.447</td>
<td>-14.942</td>
</tr>
<tr>
<td>10</td>
<td>0.000</td>
<td>-2.447</td>
<td>-8.416</td>
</tr>
<tr>
<td>11</td>
<td>0.000</td>
<td>-2.447</td>
<td>-13.310</td>
</tr>
<tr>
<td>12</td>
<td>0.000</td>
<td>-2.447</td>
<td>-3.521</td>
</tr>
<tr>
<td>13</td>
<td>0.000</td>
<td>0.343</td>
<td>1.373</td>
</tr>
<tr>
<td>14</td>
<td>0.000</td>
<td>0.343</td>
<td>1.236</td>
</tr>
<tr>
<td>15</td>
<td>0.000</td>
<td>0.343</td>
<td>1.099</td>
</tr>
<tr>
<td>16</td>
<td>0.000</td>
<td>0.343</td>
<td>0.961</td>
</tr>
<tr>
<td>17</td>
<td>0.000</td>
<td>0.343</td>
<td>0.824</td>
</tr>
<tr>
<td>18</td>
<td>0.000</td>
<td>0.343</td>
<td>0.687</td>
</tr>
<tr>
<td>19</td>
<td>0.000</td>
<td>0.343</td>
<td>0.549</td>
</tr>
<tr>
<td>20</td>
<td>0.000</td>
<td>0.343</td>
<td>0.412</td>
</tr>
<tr>
<td>21</td>
<td>0.000</td>
<td>0.343</td>
<td>0.275</td>
</tr>
<tr>
<td>22</td>
<td>0.000</td>
<td>0.343</td>
<td>0.137</td>
</tr>
<tr>
<td>JOINT</td>
<td>X-DISPLACEMENT</td>
<td>Y-DISPLACEMENT</td>
<td>θ-ROTATION</td>
</tr>
<tr>
<td>-------</td>
<td>----------------</td>
<td>----------------</td>
<td>------------</td>
</tr>
<tr>
<td>1</td>
<td>0.0000</td>
<td>0.0000</td>
<td>-179357.8397</td>
</tr>
<tr>
<td>2</td>
<td>0.0000</td>
<td>-4238243.4489</td>
<td>-171084.7517</td>
</tr>
<tr>
<td>3</td>
<td>0.0000</td>
<td>-8078418.6738</td>
<td>-146185.4877</td>
</tr>
<tr>
<td>4</td>
<td>0.0000</td>
<td>-11122457.4507</td>
<td>-104720.0477</td>
</tr>
<tr>
<td>5</td>
<td>0.0000</td>
<td>-11954415.9170</td>
<td>-87212.4175</td>
</tr>
<tr>
<td>6</td>
<td>0.0000</td>
<td>-12993246.5778</td>
<td>-50597.4984</td>
</tr>
<tr>
<td>7</td>
<td>0.0000</td>
<td>-15557274.9867</td>
<td>3412.6936</td>
</tr>
<tr>
<td>8</td>
<td>0.0000</td>
<td>-12858194.2756</td>
<td>56328.2615</td>
</tr>
<tr>
<td>9</td>
<td>0.0000</td>
<td>-11658942.0563</td>
<td>90997.1825</td>
</tr>
<tr>
<td>10</td>
<td>0.0000</td>
<td>-10864619.2427</td>
<td>107270.2723</td>
</tr>
<tr>
<td>11</td>
<td>0.0000</td>
<td>-7805794.0196</td>
<td>144812.5923</td>
</tr>
<tr>
<td>12</td>
<td>0.0000</td>
<td>-4049382.2044</td>
<td>165349.4883</td>
</tr>
<tr>
<td>13</td>
<td>0.0000</td>
<td>-21.9733</td>
<td>169150.9803</td>
</tr>
<tr>
<td>14</td>
<td>0.0000</td>
<td>809700.3807</td>
<td>168249.1747</td>
</tr>
<tr>
<td>15</td>
<td>0.0000</td>
<td>1615321.9834</td>
<td>167442.3139</td>
</tr>
<tr>
<td>16</td>
<td>0.0000</td>
<td>2417298.4738</td>
<td>168730.3779</td>
</tr>
<tr>
<td>17</td>
<td>0.0000</td>
<td>3216085.4909</td>
<td>166133.3667</td>
</tr>
<tr>
<td>18</td>
<td>0.0000</td>
<td>4012138.6738</td>
<td>165591.2803</td>
</tr>
<tr>
<td>19</td>
<td>0.0000</td>
<td>1805913.6614</td>
<td>165164.1187</td>
</tr>
<tr>
<td>20</td>
<td>0.0000</td>
<td>5597366.0929</td>
<td>164831.8815</td>
</tr>
<tr>
<td>21</td>
<td>0.0000</td>
<td>6388451.6073</td>
<td>164594.5699</td>
</tr>
<tr>
<td>22</td>
<td>0.0000</td>
<td>7178125.8436</td>
<td>164452.1827</td>
</tr>
<tr>
<td>23</td>
<td>0.0000</td>
<td>7967344.4409</td>
<td>164404.7203</td>
</tr>
</tbody>
</table>

**MEMBER END FORCES**

**UNITS: FEET, KIPS**

<table>
<thead>
<tr>
<th>ELE</th>
<th>AXIAL</th>
<th>SHEAR</th>
<th>MOMENT</th>
<th>AXIAL</th>
<th>SHEAR</th>
<th>MOMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
These are the load combinations for the continuous beam A3-AE.

These are the shear, moment and deflection diagrams for beam A3-AE.
Calculate snow loads by selecting the SNOW icon and defining the Ground Snow load and other factors in the Snow Load dialog box.

Generating snow loads allows you to take sections and see the combined snow loads.
Here is another section, this time in the east-west direction.
Snow loads can also be displayed in three dimensions. Here it is displayed in wireframe, but it can also be displayed as solids.
Flat Roof Snow Load (Pf)
Pf = 0.6*Ce*Ct*Pg
Snow Exposure Category: C
Ce = 1.0
Heated structure
Ct = 1.0
Importance Category: I
I = 1.0
Pg = 20.0 psf
Pf = 12.0 psf
Roof slope: 4.80 in 12

Since theta > 15 deg, min. snow load does not apply.
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.

Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 1.00

Ps = 12.00 psf

Unbalanced Snow Load (Punbal)
since 15 deg < theta < 70 deg, unbalanced condition applies.
Punbal = 1.5*Ps/Ce

Punbal = 18.00 psf

Flat Roof Snow Load Design

Flat Roof Snow Load (Pf)
Pf = 0.6*Ce*Ct*Pg
Snow Exposure Category: C
Ce = 1.0
Heated structure
Ct = 1.0
Importance Category: I
I = 1.0
Pg = 20.0 psf
Pf = 12.0 psf
Roof slope: 2.00 in 12

theta = 9 deg
Check minimum Pf where theta <= 15 deg
When Pg <= 20.0 psf, min Pf = Pg*I
min Pf = 20.0 psf
Since theta > 1/2 in/ft, rain-on-snow surcharge does not apply.

Pf = 20.00 psf
Sloped Roof Snow Load (Ps)
P\(_s\) = Cs*Pf
Roof slippery: No
Cs = 1.0

\[
P_s = 20.00 \text{ psf}
\]

Drift Snow Load Design

Pg = 20.0 psf
Snow density = 15.0 pcf
Ps = 20.0 psf
hb = Ps/density
hb = 1.33 ft
Projection height = 15.75 ft
hc = height-hb
hc = 14.42 ft
hc/hb = 10.81 > 0.20 Therefore consider drift load
Importance Category: I
I = 1.0
Snow Exposure Category: C
Ce = 1.0
Separation = 0.00 ft
hd = 2*Pg/Ce*density*(20-s/20) <= hc
hd = 2.67 ft
hd <= hc
Pd = hd*density

\[
P_d = 40.00 \text{ psf}
\]

Width of drift for L = 40.00 <= 50 ft: W = 3*hd >= 10 ft

\[
W = 10.00 \text{ ft}
\]

Flat/Lean-To Roof Snow Load Design

Flat Roof Snow Load (Pf)
Pf = 0.6*Ce*Ct*Pg
Snow Exposure Category: C
Ce = 1.0
Heated structure
Ct = 1.0
Importance Category: I
I = 1.0
Pg = 20.0 psf
Pf = 12.0 psf
Roof slope: 0.00 in 12
theta = 0 deg
Check minimum Pf where theta <= 15 deg
When Pg <= 20.0 psf, min Pf = Pg*I
min Pf = 20.0 psf
Since theta < 1/2 in/ft, 5 psf rain-on-snow surcharge applies.

\[
P_f = 25.00 \text{ psf}
\]
Sloped Roof Snow Load (Ps)
Ps = Cs*Pf
Roof slippery: No
Cs = 1.00

---
Ps = 25.00 psf
---

Drift Snow Load Design

Pg = 20.0 psf
Snow density = 15.0 pcf
Ps = 25.0 psf
hb = Ps/density
hb = 1.67 ft
Projection height = 22.00 ft
hc = height-hb
hc = 20.33 ft
hc/hb = 12.20 >= 0.20 Therefore consider drift load
Importance Category: I
I = 1.0
Snow Exposure Category: C
Ce = 1.0
Separation = 0.00 ft
hd = 2*I*Pg/Ce*density*(20-s/Z0) <= hc
hd = 2.67 ft
hd <= hc
Pd = hd*density

---
Pd = 40.00 psf
---

Width of drift for L = 20.00 ft >= 50.0 ft: W = 3*hd >= 10 ft

---
W = 10.00 ft
---

Drift Snow Load Design

Pg = 20.0 psf
Snow density = 15.0 pcf
Ps = 25.0 psf
hb = Ps/density
hb = 1.67 ft
Projection height = 14.00 ft
hc = height-hb
hc = 12.33 ft
hc/hb = 7.10 >= 0.20 Therefore consider drift load
Importance Category: I
I = 1.0
Snow Exposure Category: C
Ce = 1.0
Separation = 0.00 ft
hd = 2*I*Pg/Ce*density*(20-s/Z0) <= hc
hd = 2.67 ft
hd <= hc
Pd = hd*density

---
Pd = 40.00 psf
---
Width of drift for L = 20.00 < 50 ft: \( W = 3 \times \text{hd} \geq 10 \text{ ft} \)

\[ \text{hd} = \frac{P_g}{(20-s/20) \times \text{density}} \]

Width of drift for L = 60.00 > 50 ft: \( W = 4 \times \text{hd} \geq 10 \text{ ft} \)

Theta = 22 deg > 2 in 12, therefore sliding snow

Increase in drift height: \( h_s = 0.1 \times \text{hd} \)

\( h_s = 1.07 \)

\( \text{hd} + h_s \geq \text{hc} \)

\( h_c = 12.33 \text{ ft} \)

Maximum height = 3.74

\( P_d + P_s = \text{height} \times \text{density} \)

\( P_d + P_s = 58.05 \text{ psf} \)

Notes for sliding snow:
Calculations based on MBMA 1986
Basic Wind Speed: 70.0 mph
Importance Factor: 1.00
Exposure Category: C
% Openings Coefs.: -0.25 0.25
- Main Wind Force Resistance System
- Components and Cladding
- Open Roof
Output File: WINOUT.TXT

Engineering Assumptions:
Plan Ratio: 75%
Height Ratio: 75%

h = eave height for slope (10°)

Calculate wind loads by selecting the WIND icon. Define the wind parameters in the Wind Loads dialog box.

Wind Load: GCpi=0 (psf)

The wind load command lets you take sections to see the actual loads.
Wind Load: GCpi=0 (psf)

Here is a section in the east-west direction.

In 3-D, wind loads appear as blocks added to the surface of the building.
# Wind Load

<table>
<thead>
<tr>
<th>Velocity (mph)</th>
<th>Importance Factor</th>
<th>Exposure</th>
<th>Width (ft)</th>
<th>Length (ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>40.0</td>
<td>60.0</td>
<td></td>
</tr>
</tbody>
</table>

Distance to ocean line \( > 100 \text{ mi.} \), \( h/d = 1.15 < 5 \)

# Main Framing Pressures

## Parallel to Ridge or Length

<table>
<thead>
<tr>
<th>Location</th>
<th>( z ) or ( h ) (ft)</th>
<th>( G_h )</th>
<th>( K_z )</th>
<th>( q_z ) (psf)</th>
<th>( C_p )</th>
<th>External Pressure ( P ) (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>( G_{C_p} = 0 ) -0.25 0.25</td>
</tr>
<tr>
<td>Level 5 - eave</td>
<td>50.0</td>
<td>1.22</td>
<td>1.13</td>
<td>14.2</td>
<td>0.80</td>
<td>13.9</td>
</tr>
<tr>
<td>Level 4 - roof</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>0.80</td>
<td>13.5</td>
</tr>
<tr>
<td>Level 3 - 4</td>
<td>35.0</td>
<td>1.22</td>
<td>1.02</td>
<td>12.8</td>
<td>0.80</td>
<td>12.5</td>
</tr>
<tr>
<td>Level 2 - 3</td>
<td>21.0</td>
<td>1.22</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>10.7</td>
</tr>
<tr>
<td>Level 1 - 2</td>
<td>7.0</td>
<td>1.22</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>9.8</td>
</tr>
<tr>
<td>Level 1 - grade</td>
<td>0.0</td>
<td>1.22</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>9.8</td>
</tr>
<tr>
<td>Leeward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>( G_{C_p} = 0 ) -0.25 0.25</td>
</tr>
<tr>
<td>Level 5 - WW</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.40</td>
<td>-6.7</td>
</tr>
<tr>
<td>Level 4 - WW</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8</td>
</tr>
<tr>
<td>Level 3 - WW</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8</td>
</tr>
<tr>
<td>Level 2 - WW</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8</td>
</tr>
<tr>
<td>Level 1 - WW</td>
<td>46.0</td>
<td>1.10</td>
<td>13.8</td>
<td></td>
<td></td>
<td>( G_{C_p} = 0 ) -0.25 0.25</td>
</tr>
</tbody>
</table>

## Wind Load

<table>
<thead>
<tr>
<th>Velocity (mph)</th>
<th>Importance Factor</th>
<th>Exposure</th>
<th>Width (ft)</th>
<th>Length (ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>60.0</td>
<td>40.0</td>
<td>Gable</td>
</tr>
</tbody>
</table>

Distance to ocean line \( > 100 \text{ mi.} \), \( h/d = 1.15 < 5 \), \( \text{Lee: 1.80 in 12} \)

# Main Framing Pressures

## Perpendicular to Ridge or Length

<table>
<thead>
<tr>
<th>Location</th>
<th>( z ) or ( h ) (ft)</th>
<th>( G_h )</th>
<th>( K_z )</th>
<th>( q_z ) (psf)</th>
<th>( C_p )</th>
<th>External Pressure ( P ) (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>( G_{C_p} = 0 ) -0.25 0.25</td>
</tr>
<tr>
<td>Level 5 - eave</td>
<td>50.0</td>
<td>1.22</td>
<td>1.13</td>
<td>14.2</td>
<td>0.80</td>
<td>13.9</td>
</tr>
<tr>
<td>Level 4 - roof</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>0.80</td>
<td>13.5</td>
</tr>
<tr>
<td>Level 3 - 4</td>
<td>35.0</td>
<td>1.22</td>
<td>1.02</td>
<td>12.8</td>
<td>0.80</td>
<td>12.5</td>
</tr>
<tr>
<td>Level 2 - 3</td>
<td>21.0</td>
<td>1.22</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>10.7</td>
</tr>
<tr>
<td>Level 1 - 2</td>
<td>7.0</td>
<td>1.22</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>9.8</td>
</tr>
<tr>
<td>Level 1 - grade</td>
<td>0.0</td>
<td>1.22</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>9.8</td>
</tr>
</tbody>
</table>

5-100
### Windward Wall

<table>
<thead>
<tr>
<th>Level</th>
<th>Eave</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9.0</td>
<td>10.0</td>
<td>11.0</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
</tr>
<tr>
<td>2</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
</tr>
<tr>
<td>3</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
</tr>
<tr>
<td>4</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
<td>22.0</td>
<td>23.0</td>
<td>24.0</td>
</tr>
</tbody>
</table>

### Leeward Wall

<table>
<thead>
<tr>
<th>Level</th>
<th>Eave</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9.0</td>
<td>10.0</td>
<td>11.0</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
</tr>
<tr>
<td>2</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
</tr>
<tr>
<td>3</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
</tr>
<tr>
<td>4</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
<td>22.0</td>
<td>23.0</td>
<td>24.0</td>
</tr>
</tbody>
</table>

### Side Wall

<table>
<thead>
<tr>
<th>Level</th>
<th>Eave</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9.0</td>
<td>10.0</td>
<td>11.0</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
</tr>
<tr>
<td>2</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
</tr>
<tr>
<td>3</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
</tr>
<tr>
<td>4</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
<td>22.0</td>
<td>23.0</td>
<td>24.0</td>
</tr>
</tbody>
</table>

### Roof

<table>
<thead>
<tr>
<th>Level</th>
<th>Eave</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9.0</td>
<td>10.0</td>
<td>11.0</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
</tr>
<tr>
<td>2</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
</tr>
<tr>
<td>3</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
</tr>
<tr>
<td>4</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
<td>22.0</td>
<td>23.0</td>
<td>24.0</td>
</tr>
</tbody>
</table>

### Internal

<table>
<thead>
<tr>
<th>Level</th>
<th>Eave</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9.0</td>
<td>10.0</td>
<td>11.0</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
</tr>
<tr>
<td>2</td>
<td>12.0</td>
<td>13.0</td>
<td>14.0</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
</tr>
<tr>
<td>3</td>
<td>15.0</td>
<td>16.0</td>
<td>17.0</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
</tr>
<tr>
<td>4</td>
<td>18.0</td>
<td>19.0</td>
<td>20.0</td>
<td>21.0</td>
<td>22.0</td>
<td>23.0</td>
<td>24.0</td>
</tr>
</tbody>
</table>

---

**Wind Load**

| Velocity Importance Exposure Width Length Roof Type |
|---|---|---|---|---|
| MPH | Factor | Exposure | to Wind | to Wind | Roof Type |
|---|---|---|---|---|
| 70.0 | 1.00 | C | 40.0 | 20.0 | |

**Main Framing Pressures**

<table>
<thead>
<tr>
<th>Location</th>
<th>x or h</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td>level 1</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.80</td>
<td>15.1</td>
</tr>
<tr>
<td></td>
<td>level 2</td>
<td>12.0</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>11.1</td>
</tr>
<tr>
<td></td>
<td>level 3</td>
<td>12.0</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
<tr>
<td></td>
<td>level 4</td>
<td>12.0</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
<tr>
<td></td>
<td>Leeward Wall</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.50</td>
<td>7.6</td>
</tr>
<tr>
<td></td>
<td>Side Wall</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.70</td>
<td>7.6</td>
</tr>
<tr>
<td></td>
<td>Internal</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.70</td>
<td>7.6</td>
</tr>
</tbody>
</table>

---

**Wind Load**

| Velocity Importance Exposure Width Length Roof Type |
|---|---|---|---|---|
| MPH | Factor | Exposure | to Wind | to Wind | Roof Type |
|---|---|---|---|---|
| 70.0 | 1.00 | C | 40.0 | 20.0 | |

**Main Framing Pressures**

<table>
<thead>
<tr>
<th>Location</th>
<th>x or h</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td>level 1</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.80</td>
<td>15.1</td>
</tr>
<tr>
<td></td>
<td>level 2</td>
<td>12.0</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>11.1</td>
</tr>
<tr>
<td></td>
<td>level 3</td>
<td>12.0</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
<tr>
<td></td>
<td>level 4</td>
<td>12.0</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
<tr>
<td></td>
<td>Leeward Wall</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.50</td>
<td>7.6</td>
</tr>
<tr>
<td></td>
<td>Side Wall</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.70</td>
<td>7.6</td>
</tr>
<tr>
<td></td>
<td>Internal</td>
<td>12.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.70</td>
<td>7.6</td>
</tr>
</tbody>
</table>
### Windward Wall

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 2 - eave</td>
<td>14.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
<tr>
<td>Level 0 - roof</td>
<td>0.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
</tbody>
</table>

### Leeward Wall

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 2 - eave</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.50</td>
<td>-7.6</td>
</tr>
<tr>
<td>Level 0 - roof</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
</tr>
</tbody>
</table>

### Side Wall

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roof</td>
<td>28.0</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
</tr>
</tbody>
</table>

### Roof

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>28.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.0</td>
<td>-3.0</td>
<td>3.0</td>
</tr>
</tbody>
</table>

### Wind Load

<table>
<thead>
<tr>
<th>Velocity (mph)</th>
<th>Importance Factor</th>
<th>Exposure</th>
<th>Width (ft)</th>
<th>Length (ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>60.0</td>
<td>24.0</td>
<td></td>
</tr>
</tbody>
</table>

Distance to ocean line \( > 100 \text{ mi.} \) \( h/d = 1.17 < 5 \)

### Main Framing Pressures

#### Parallel to Ridge or Length

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 2 - eave</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>0.80</td>
<td>12.1</td>
</tr>
<tr>
<td>Level 2 - roof</td>
<td>14.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
<tr>
<td>Level 1 - grade</td>
<td>0.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
</tr>
</tbody>
</table>

### Leeward Wall

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 2 - eave</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.50</td>
<td>-7.6</td>
</tr>
<tr>
<td>Level 0 - roof</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
</tr>
</tbody>
</table>

### Internal

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>28.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.0</td>
<td>-3.0</td>
<td>3.0</td>
</tr>
</tbody>
</table>

### Wind Load

<table>
<thead>
<tr>
<th>Velocity (mph)</th>
<th>Importance Factor</th>
<th>Exposure</th>
<th>Width (ft)</th>
<th>Length (ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>40.0</td>
<td>60.0</td>
<td></td>
</tr>
</tbody>
</table>

Distance to ocean line \( > 100 \text{ mi.} \) \( h/d = 1.15 < 5 \)
### Windward Wall

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - eave</td>
<td>50.0</td>
<td>1.22</td>
<td>1.13</td>
<td>14.2</td>
<td>0.80</td>
<td>13.9  17.3  10.4</td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>0.80</td>
<td>13.5  16.9  10.0</td>
</tr>
<tr>
<td>level 1 - 2</td>
<td>21.0</td>
<td>1.22</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>10.7  14.2  7.3</td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>0.0</td>
<td>1.22</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>9.8   13.2  6.3</td>
</tr>
<tr>
<td>Leeward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - eave</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8 -8.3 -15.2</td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8 -8.3 -15.2</td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8 -8.3 -15.2</td>
</tr>
<tr>
<td>Roof</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td>46.0</td>
<td>1.10</td>
<td>13.8</td>
<td></td>
<td></td>
<td>0.0   -3.5  3.5</td>
</tr>
</tbody>
</table>

### Wind Load

<table>
<thead>
<tr>
<th>Velocity Importance</th>
<th>Exposure Factor</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>(mph)</td>
<td></td>
<td>(ft)</td>
<td>(ft)</td>
<td>Gable</td>
</tr>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>60.0</td>
<td>40.0</td>
<td></td>
</tr>
</tbody>
</table>

**Distance to ocean line >= 100 mi.**

### Main Framing Pressures

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - eave</td>
<td>42.0</td>
<td>1.22</td>
<td>1.07</td>
<td>13.4</td>
<td>0.80</td>
<td>13.1  16.5  9.6</td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>46.0</td>
<td>1.22</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>10.7  14.2  7.3</td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>46.0</td>
<td>1.22</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>9.8   13.2  6.3</td>
</tr>
<tr>
<td>Leeward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - eave</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8 -8.3 -15.2</td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8 -8.3 -15.2</td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>46.0</td>
<td>1.22</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.70</td>
<td>-11.8 -8.3 -15.2</td>
</tr>
<tr>
<td>Roof</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td>46.0</td>
<td>1.10</td>
<td>13.8</td>
<td></td>
<td></td>
<td>0.0   -3.5  3.5</td>
</tr>
</tbody>
</table>

### Wind Load

<table>
<thead>
<tr>
<th>Velocity Importance</th>
<th>Exposure Factor</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>(mph)</td>
<td></td>
<td>(ft)</td>
<td>(ft)</td>
<td></td>
</tr>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>24.0</td>
<td>80.0</td>
<td></td>
</tr>
</tbody>
</table>

**Distance to ocean line >= 100 mi.**

### Main Framing Pressures
### Parallel to Ridge or Length

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz (psf)</th>
<th>qz (psf)</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
<th>GCp1=0</th>
<th>-0.25</th>
<th>0.25</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windward Wall</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - eave</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>0.80</td>
<td>12.1</td>
<td>15.1</td>
<td>9.1</td>
<td></td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>21.0</td>
<td>1.26</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>11.1</td>
<td>14.1</td>
<td>8.1</td>
<td></td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>7.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
<td></td>
</tr>
<tr>
<td>Leeward Wall</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.23</td>
<td>-3.5</td>
<td>-0.5</td>
<td>-6.5</td>
<td></td>
</tr>
<tr>
<td>Side Wall</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>Roof</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td>28.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.0</td>
<td></td>
<td>0.0</td>
<td>-3.0</td>
<td>3.0</td>
<td></td>
</tr>
</tbody>
</table>

### Wind Load

<table>
<thead>
<tr>
<th>Velocity (mph)</th>
<th>Importance Factor</th>
<th>Exposure</th>
<th>Width Perpend. to Wind (ft)</th>
<th>Length Parallel to Wind (ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>24.0</td>
<td>80.0</td>
<td></td>
</tr>
</tbody>
</table>

Distance to ocean line >= 100 mi.  
\[ h/d = 1.17 \leq 5 \]

### Main Framing Pressures

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz (psf)</th>
<th>qz (psf)</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
<th>GCp1=0</th>
<th>-0.25</th>
<th>0.25</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windward Wall</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 2 - eave</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>0.80</td>
<td>12.1</td>
<td>15.1</td>
<td>9.1</td>
<td></td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>14.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
<td></td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>0.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
<td></td>
</tr>
<tr>
<td>Leeward Wall</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>Side Wall</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>Roof</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td>28.0</td>
<td>0.96</td>
<td>12.0</td>
<td>0.0</td>
<td></td>
<td>0.0</td>
<td>-3.0</td>
<td>3.0</td>
<td></td>
</tr>
</tbody>
</table>

### Wind Load

<table>
<thead>
<tr>
<th>Velocity (mph)</th>
<th>Importance Factor</th>
<th>Exposure</th>
<th>Width Perpend. to Wind (ft)</th>
<th>Length Parallel to Wind (ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>20.0</td>
<td>64.0</td>
<td></td>
</tr>
</tbody>
</table>

Distance to ocean line >= 100 mi.  
\[ h/d = 1.40 \leq 5 \]
### Main Framing Pressures

**Parallel to Ridge or Length**

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
<th>G(\pi=0) -0.25</th>
<th>0.25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - eave</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>0.80</td>
<td>12.1</td>
<td>15.1</td>
<td>9.1</td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>21.0</td>
<td>1.26</td>
<td>0.88</td>
<td>11.0</td>
<td>0.80</td>
<td>11.1</td>
<td>14.1</td>
<td>8.1</td>
</tr>
<tr>
<td>level 1 - 2</td>
<td>7.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>0.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
</tr>
<tr>
<td>Leeward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - grade</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.24</td>
<td>-3.6</td>
<td>-6.6</td>
<td></td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-13.6</td>
<td></td>
</tr>
</tbody>
</table>

### Wind Load

- **Velocity Importance Exposure Width Length Roof Type**
- (mph) (ft) (ft)

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Importance</th>
<th>Exposure</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>20.0</td>
<td>64.0</td>
<td></td>
</tr>
</tbody>
</table>

**Distance to ocean line** >= 100 mi. h/d = 1.40 <= 5

**Main Framing Pressures**

**Parallel to Ridge or Length**

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh</th>
<th>Kz</th>
<th>qz</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
<th>G(\pi=0) -0.25</th>
<th>0.25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - eave</td>
<td>14.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>0.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
</tr>
<tr>
<td>Leeward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 3 - grade</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.24</td>
<td>-3.6</td>
<td>-6.6</td>
<td></td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-13.6</td>
<td></td>
</tr>
</tbody>
</table>

### Wind Load

- **Velocity Importance Exposure Width Length Roof Type**
- (mph) (ft) (ft)

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Importance</th>
<th>Exposure</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>20.0</td>
<td>64.0</td>
<td></td>
</tr>
</tbody>
</table>

**Distance to ocean line** >= 100 mi. h/d = 1.40 <= 5
### Main Framing Pressures

#### Parallel to Ridge or Length

<table>
<thead>
<tr>
<th>Location</th>
<th>z or h (ft)</th>
<th>Gh (psf)</th>
<th>Kz</th>
<th>qz (psf)</th>
<th>Cp</th>
<th>External Pressure P (psf)</th>
<th>GCPi:0</th>
<th>-0.25</th>
<th>0.25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>level 2 - eave</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>0.80</td>
<td>12.1</td>
<td>15.1</td>
<td>9.1</td>
<td></td>
</tr>
<tr>
<td>level 2 - roof</td>
<td>14.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
<td></td>
</tr>
<tr>
<td>level 1 - grade</td>
<td>0.0</td>
<td>1.26</td>
<td>0.80</td>
<td>10.0</td>
<td>0.80</td>
<td>10.1</td>
<td>13.1</td>
<td>7.1</td>
<td></td>
</tr>
<tr>
<td>Leeward Wall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Side wall</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.24</td>
<td>-3.6</td>
<td>-0.6</td>
<td>-6.6</td>
<td></td>
</tr>
<tr>
<td>Roof</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
<td>-13.6</td>
<td></td>
</tr>
<tr>
<td>Internal</td>
<td>28.0</td>
<td>1.26</td>
<td>0.96</td>
<td>12.0</td>
<td>-0.70</td>
<td>-10.6</td>
<td>-7.6</td>
<td>-13.6</td>
<td></td>
</tr>
</tbody>
</table>

Notes for main framing:

Positive pressures act toward surfaces.

Pressure or suction = P = q*Gh*Cp and/or P = qh*Gh*Cp-qh*(GCPi)
Choosing Components and Cladding lets you calculate wind loads on a tributary area on any exterior plane of the building. Here, an area on the roof is calculated and shown in section and 3-D view.
After you calculate the Components and Cladding, you can select Zone Areas under the Show Loads command in the VIEWPOINT Options menu. This 3-D display shows the zones calculated for the components and cladding.
Project Demonstration
Location: Ft. Wainwright
Design Load: Tri-Services
Time: Sun Aug 13, 1989 10:16 AM

Wind Load

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Exposure</th>
<th>Importance</th>
<th>Width</th>
<th>Length</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>(mph)</td>
<td></td>
<td>Factor</td>
<td>Perpend.</td>
<td>Parallel</td>
<td>to Wind</td>
</tr>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>40.0</td>
<td>60.0</td>
<td>Gable</td>
</tr>
</tbody>
</table>

Distance to ocean line > 100 mi.  h/d = 1.15 ≤ 5

<table>
<thead>
<tr>
<th>Height (ft)</th>
<th>kh (psf)</th>
<th>qh (psf)</th>
<th>GCpi (psf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>46.0</td>
<td>1.10</td>
<td>13.8</td>
<td>-0.25</td>
</tr>
</tbody>
</table>

Height ≤ 60 ft

Component/Cladding Pressures (psf)

<table>
<thead>
<tr>
<th>Tributary Zone</th>
<th>Zone 1</th>
<th>Zone 2</th>
<th>Zone 3</th>
<th>Zone 1,2,3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area (sf)</td>
<td>middle</td>
<td>edge/ridge</td>
<td>corners</td>
<td>all</td>
</tr>
<tr>
<td>Internal 32.0</td>
<td>3.5</td>
<td>3.5</td>
<td>3.5</td>
<td>3.5</td>
</tr>
<tr>
<td>86.2</td>
<td>-1.11</td>
<td>-18.8</td>
<td>-2.06</td>
<td>-31.9</td>
</tr>
<tr>
<td>Eave*</td>
<td>-7.6</td>
<td>-7.6</td>
<td>-7.6</td>
<td>-7.6</td>
</tr>
</tbody>
</table>

Notes for components and cladding:

P = qh(GCpi) - qh(GCpi)
P for roof overhangs: algebraically add this pressure to the above values. P = qh(GCpi) ≥ 0.8qh

\[ a = 4.0 \text{ ft} \]
Wind loads on open roof structures can be calculated by choosing the Open Roof option in the Wind Loads Dialog box. Here the wind load on the shed roof is shown in section and in 3-D.
Project : Demonstration
Location : Ft. Wainwright
Design Load: Tri-Services
Time : Sun Aug 13, 1989 10:10 AM

################################################################ Wind Load ################################################################

Velocity Importance Exposure Width Length Roof Type
(mph) Factor Exposure Perpendicular Parallel to Wind to Wind

<table>
<thead>
<tr>
<th>Velocity</th>
<th>Importance</th>
<th>Exposure</th>
<th>Width (ft)</th>
<th>Length (ft)</th>
<th>Roof Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>70.0</td>
<td>1.00</td>
<td>C</td>
<td>40.0</td>
<td>12.0</td>
<td>Flat/Monoslop-</td>
</tr>
</tbody>
</table>

Distance to ocean line >= 100 mi.

******************************************************************************************** Open Roof Pressures (psf) *********************************************************************************************

\[ z = h = 11.25 \text{ ft} \]
\[ Gh = 1.32 \]
\[ k_z = 0.80 \]
\[ q_z = 0.00256 \cdot k_z \cdot (1 + V)^2 \cdot (1 + V) = 10.00 \text{ psf} \]
\[ Af = \frac{L}{\cos(\theta)} \cdot B = 486.7 \text{ sqft} \]
\[ B/L = 3.33 \]
\[ Cf = 0.94 \]
\[ \sqrt{L} = 0.30 \]
\[ \theta + 10 \text{ deg} = 19.5 \text{ deg} \]

Pressure on top of roof Pressure on bottom of roof

<table>
<thead>
<tr>
<th>X</th>
<th>3.60 ft from low eave</th>
<th>3.60 ft from high eave</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ F = q_z \cdot G_h \cdot C_f \cdot A_f ]</td>
<td>6.00 k</td>
<td>-6.00 k</td>
</tr>
</tbody>
</table>

\[ P_1 (\text{leeward edge}) = \frac{2 \cdot F \cdot \cos(\theta)}{(B \cdot L)} \cdot \left[ \frac{3 \cdot X}{L} - 1 \right] = -2.50 \text{ psf} \]
\[ P_1 < 0.0, \text{ therefore set } P_1 = 0.0 \text{ psf} \]
\[ P_2 (\text{windward edge}) = \frac{2 \cdot F \cdot \cos(\theta)}{(B \cdot L)} \cdot \left[ 2 - 3 \cdot X/L \right] = 27.10 \text{ psf} \]

Notes for open roof pressures:
Positive pressures act toward surfaces.
INDEX

A
ADD OPENING, 4-44
ADD OPENINGS, 4-43
Analysis
Preliminary, 5-17, 5-31, 5-34, 5-37, 5-40, 5-43, 5-47

B
BARREL VAULT, 4-16, 4-21, 4-27

C
CASM Program, 1-1
City/Installation database, 2-1
COLUMN, 4-75, 4-83
CONCRETE, 5-50
Connectivity, 5-17
Column
Continuous span, 5-17
Framed Continuity, 5-51
Simple Span, 5-17
Three span continuous, 5-46
Continuous Beam, 5-47
Criteria
City/Installation database, 2-1
Editing, 2-7
Printing, 2-6 - 2-10
Sample Output, 2-8
Saving Data, 2-5
Criteria Menu, 2-1
Project Data, 2-1 - 2-2
Regional Data, 2-3
Site Data, 2-4
CUBE, 4-5

D
Dead Load, 4-93 - 4-106
Assign, 5-12
Ceiling - Wood Truss, 4-101
Ceiling example, 4-101
Floor - Bar Joist assembly, 4-93
Floor - Concrete Pan Joist, 4-96
Floor example, 4-93, 4-96
Roof - Bar Joists, 4-99
Roof - Wood Rafters, 4-98
Roof example, 4-98 - 4-99
Wall - Brick Veneer, 4-103
Wall example, 4-103
DEFINE GRID, 3-7, 4-60, 5-8
DEFINE GROUND PLANE, 3-7, 4-4
DEFINE UNITS, 4-3, 4-6
Snap Increment, 4-3
Deflection Diagram, 5-20
DELETE LOADS, 5-42
DELETE OBJECT, 4-20, 4-74
DELETE STRUCTURE, 5-37
Dimension dialog window, 4-5
DISPLAY INFORMATION, 5-9
DRAG EDGE, 3-6, 4-6, 4-31, 4-43, 4-82
DRAG PLANE, 3-2, 4-15, 4-73
Draw Model menu, 4-15, 4-42
Draw Structure, 5-8
DUPLICATE, 4-52, 4-76 - 4-77, 4-84, 4-89

E
Excel, 5-21, 5-32, 5-39
Preliminary Design, 5-28
Preliminary Selection, 5-40, 5-44
Scratchpad, 5-23, 5-29
SELECT MEMBER, 5-22
SEND XL, 5-24, 5-28

F
FLOOR (DL), 4-94
Floor Framing
Repetitive Schemes, 5-1
Floor Plane, 5-8
Floor Planes, 3-3
Floor/Roof
Narrowly Spaced, 5-40
Rolled Sections, 5-25, 5-31, 5-37
Widely Spaced, 4-61
Widely Spaced Beam CIP, 5-50
Widely Spaced Rolled Sections, 5-46
Floor/Roof Menu
Open Web Joists - K, 5-15
Form Deck, 5-33
Form Deck, 5-33
Framed Continuity, 5-52

G
Girder, 5-25
Spandrel, 5-31
Girt, 4-60
Ground Plane
Define, 4-4
Rotated, 3-7

H
HIDE OBJECT, 3-8, 4-81
Horizontal Girt, 4-61
HORIZONTAL PLANE, 4-72, 4-81, 5-8
INDEX

Self Weight, 5-18, 5-26, 5-52
  Update Area Structural Loads, 5-19
  Update Area Structure Loads, 5-43
SEND XL, 5-24, 5-28
Shape
  Barrel Vault, 4-16, 4-21
  Column, 4-75, 4-83
  CUBE, 4-5
  Open Barrel Vault, 4-88
  Prism, 4-6, 4-38
Shear Diagram, 5-20
SHOW GROUND PLANE, 4-4
SHOW LOADS, 4-9, 4-47, 4-66, 4-90
SHOW OBJECT, 3-8, 4-82
SHOW STRUCTURE, 4-48, 5-12
Site Specific Data, 2-4
SLICE, 3-2, 4-74, 4-76, 4-84
Snap increment, 4-3
SNAP TO UNITS, 4-3
SNOW LOAD, 4-1 - 4-29, 4-32
  Arched roof, 4-14, 4-20, 4-23, 4-25, 4-27
  Arched Roof sample output, 4-18
  Dialog Window, 4-7
  Drifting and sliding, 4-30 - 4-40
  Exposure category, 4-3
  Gable Roof, 4-1
  Gable Roof sample output, 4-12
  Importance Factor, 4-2
  Multiple Gable Roof, 4-37
  Notepad file, 4-11
  Roof Heated, 4-3, 4-32
  Section, 4-8
Snow loads
  Gable roof, 4-1
SOLID OBJECT, 4-9
STACK ON GROUND PLANE, 4-5
STACK ON LAST SHAPE, 3-4, 4-6
STACK ON PLANE, 3-2, 4-16
STEEL, 5-15
Structural Guidelines, 5-25
  Cardfile, 5-22
  Structural Planning, 1-1
  Structure Guidelines, 5-15, 5-29
Surface 1-Way
  Form Deck, 5-33
  Surface Element, 5-12
  One-Way, 5-11

U
Update Area Structure Loads, 5-19

V
VERTICAL PLANE, 4-43, 4-60
View
  Perspective (3D), 4-9
  Section, 4-10

W
Wall Load
  Assign, 5-14
WIDELY SPACED, 4-61, 5-11
WIND LOAD, 4-41 - 4-70, 4-77, 4-85
  "a" Edge Distances, 4-63
  B & L Assumptions, 4-48
  Building Height less than 60 feet, 4-59
  Components and cladding, 4-59, 4-63
  Compute Percentage of Openings, 4-46
  Distance to Oceanline, 4-42
  GCpi, 4-48
  Main Wind Force Resistance System, 4-41, 4-46
  One story arched roof, 4-55
  One story gable roof, 4-41
  Open Roof, 4-77, 4-85, 4-90
  Opening Coefficients, 4-46, 4-53
  Three story flat roof, 4-51
  Tributary Area dialog window, 4-63
  Tributary Areas, 4-65
  Unenclosed building monoslope roof, 4-71
  Unenclosed Buildings, 4-71
  Unenclosed open arched roof, 4-88
  Unenclosed open gable roof, 4-80

Z
Zoom In/Out, 4-9

T
TAPE MEASURE, 3-6, 3-9, 4-31, 4-75, 4-82,
  4-83, 4-89
TRANSPARENT OBJECT, 4-9
The Computer-Aided Structural Modeling (CASM) computer program is designed to aid the structural engineer in the preliminary design and evaluation of structural building systems by the use of three-dimensional (3-D) interactive graphics. CASM allows the structural engineer to quickly evaluate various framing alternatives in order to make more informed decisions in the initial structural evaluation process. The program was developed by the Information Technology Laboratory under the Computer Aided Structural Engineering (CASE) Project in conjunction with the Building Systems Task Group.

This first release of the CASM is designed to aid the user with design criteria, building loads, and structural framing. The various parts of the program are summarized below:

- Basic design criteria. The user can enter information directly or retrieve information from a user-definable database. The design criteria include information about the project, regional design information, and site-specific design information.

(Continued)
10. **SOURCE OF FUNDING NUMBERS (Continued).**

Research, Development, Test, and Evaluation program, Work Unit No. AT40-CA-001.

18. **SUBJECT TERMS (Continued)**

<table>
<thead>
<tr>
<th>Building systems</th>
<th>Preliminary structural design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Aided Structural Engineering (CASE)</td>
<td>Structural modeling</td>
</tr>
<tr>
<td>Computer programs</td>
<td>3-Dimensional interactive graphics</td>
</tr>
<tr>
<td></td>
<td>3-Dimensional loads</td>
</tr>
</tbody>
</table>

19. **ABSTRACT (Continued).**

b. **Building geometry.** The user can assemble the building shape using 3-D primitives (cubes, prisms, spheres, cylinders, etc.) in an easy manner using pull-down menus, icons, and a mouse.

c. **Dead and live loads.** The user can select and construct dead and live loads from several user-definable menus of building materials and load conditions. These loads can then be applied to any desired area of the building volume.

d. **Snow and wind loads.** These loads are automatically calculated in 3-D using information from the basic design criteria database. Wind loads are also calculated for components and cladding and open roof structures.

e. **Structural layout.** The engineer can easily and rapidly experiment with various framing schemes inside the defined building volume. Beams, girders, joists, girts, columns, and walls are some of the structural elements that can be modeled.

f. **Member analysis and preliminary sizing.** The user can apply loads to the building geometry from a list of user-defined load cases. The shear, moment, and deflection of selected members may be calculated for various loading conditions (including pattern loads) and connectivity (including continuous beams). The design of a member is performed using a spreadsheet.

Data from the various investigated framing schemes can be edited and printed by CASM and used as justification in a design document.